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はじめに

Cisco Security Manager（Security Manager）を使用すれば、大規模から小規模までのネットワークに

配置されたシスコ デバイス上でセキュリティ ポリシーを管理できます。また、Security Manager 上で

共有可能なオブジェクトとポリシーを使用して、数台のデバイスから何千台ものデバイスまでを管理で

きます。さらに、Security Manager は、ユースケースに合わせて最適化された複数の設定ビューをサ

ポートしたり、複数のプラットフォーム固有設定のプロビジョニングをサポートしたり、デバイス分類

機能を提供したりします。

（注） Cisco Security Management Suite には、Security Manager の他に、ネットワーク上のセキュリティ脅

威のモニタリング、識別、分離、および無効化を可能にするアプライアンス製品の Cisco Security 
Monitoring, Analysis, and Response System が付属しています。

http://www.cisco.com/en/US/products/ps6241/index.html を参照してください。

このマニュアルの目的は次のとおりです。

• Security Manager と関連アプリケーションのインストールに関するハードウェア要件とソフトウェ

ア要件を列挙します。

• インストール対象のソフトウェア アプリケーションとそれらのインストール環境に関する重要な

概念について説明します。

• Security Manager サーバおよび Auto Update Server のインストール手順と Security Manager の専

用クライアント ソフトウェアのインストール手順を示します。

• インストール後に、新しくインストールされたアプリケーションを正しく使用するために必要な作

業について説明します。

• インストール中またはインストール後に発生する可能性のある問題の理解とトラブルシューティン

グを支援します。

（注） アプリケーションをインストールする前に、Cisco.com 上で、インストールする実際のソフトウェア 
コンポーネントに最適なリリース ノート（最新情報として）を読むことを推奨します。リリース ノート

には、このマニュアルに対する修正や追加、または、計画、準備、インストール、または展開に影響を

与えるその他の情報が含まれている場合があります。「製品マニュアル」（P.xiii）を参照してください。

対象読者
このマニュアルは、セキュリティ インフラストラクチャをインストール、設定、展開、および管理す

るネットワーク担当者およびセキュリティ担当者を対象とします。
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はじめに

    
表記法
このマニュアルでは、次の表記法を使用しています。

（注） 「注釈」です。役立つ情報や、このマニュアル以外の参照資料などを紹介しています。

注意 「要注意」の意味です。機器の損傷またはデータ損失を予防するための注意事項が記述されていま

す。

ヒント 「問題解決に役立つ情報」です。ヒントには、トラブルシューティングや操作方法ではなく、ワンポイ

ントアドバイスと同様に知っておくと役立つ情報が記述される場合もあります。

項目 表記法

コマンドおよびキーワード 太字  

ユーザが値を指定する変数 イタリック体  

表示されるセッションおよびシステムの情

報

screen フォント

ユーザが入力する情報 太字の screen フォント

ユーザが入力する変数 イタリック体の screen フォント

本文中でのメニュー項目を選択する操作の

記述

[Option] > [Network Preferences]

表中でのメニュー項目を選択する操作の記

述

[Option] > [Network Preferences]
xii
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はじめに
製品マニュアル
シスコのマニュアルおよびその他の資料は、Cisco.com 上で入手できます。表 1 に、Cisco Security 
Manager および Auto Update Server に関する入手可能なマニュアルを、読む順番に示します。

マニュアルの入手方法およびテクニカル サポート
マニュアルの入手方法、テクニカル サポート、その他の有用な情報について、次の URL で、毎月更新

される『What's New in Cisco Product Documentation』を参照してください。シスコの新規および改訂

版の技術マニュアルのリストも掲載されています。

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

『What's New in Cisco Product Documentation』は Really Simple Syndication（RSS）フィードとして購

読できます。また、リーダー アプリケーションを使用してコンテンツがデスクトップに直接配信される

ように設定することもできます。RSS フィードは無料のサービスです。シスコは現在、RSS バージョン 
2.0 をサポートしています。

表 1 Security Manager のマニュアル

マニュアル タイトル 利用形式

『Release Notes for Cisco Security Manager』

Auto Update Server に関する情報も記載されて

います。

http://www.cisco.com/en/US/products/ps6498/prod_release_notes_list.h
tml

『Supported Devices and Software Versions for 
Cisco Security Manager』

Auto Update Server に関するサポート情報が記

載されています。

http://www.cisco.com/en/US/products/ps6498/products_device_support
_tables_list.html

『Cisco Security Manager インストレーション ガ
イド』

（このマニュアル）

http://www.cisco.com/en/US/products/ps6498/prod_installation_guides_
list.html

『User Guide for Cisco Security Manager』 http://www.cisco.com/en/US/products/ps6498/products_user_guide_list.
html

『User Guide for Auto Update Server』 http://www.cisco.com/en/US/products/ps6498/products_user_guide_list.
html

文脈依存オンライン ヘルプ GUI でオプションを選択して、[Help] をクリックします。
xiii
Cisco Security Manager 4.4 インストレーション ガイド

OL-28767-01-J

http://www.cisco.com/en/US/products/ps6498/prod_release_notes_list.html
http://www.cisco.com/en/US/products/ps6498/products_device_support_tables_list.html
http://www.cisco.com/en/US/products/ps6498/prod_installation_guides_list.html
http://www.cisco.com/en/US/products/ps6498/products_user_guide_list.html
http://www.cisco.com/en/US/products/ps6498/products_user_guide_list.html
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html


 

はじめに

    
xiv
Cisco Security Manager 4.4 インストレーション ガイド

OL-28767-01-J



 

Cisco S
OL-28767-01-J
C H A P T E R 1

概要

この章は、次の内容で構成されています。

• 「コンポーネント アプリケーションの概要」（P.1-1）

• 「関連アプリケーションの概要」（P.1-3）

コンポーネント アプリケーションの概要
Security Manager インストーラを使用すれば、特定のアプリケーションをインストールできます。そ

の場合は、他のアプリケーションのインストールが要求されます。この項では、次のアプリケーション

とその相互依存性について説明します。

• 「Common Services」（P.1-1）

• 「Security Manager」（P.1-2）

• 「Auto Update Server」（P.1-3）

Common Services

CiscoWorks Common Services 4.0（Common Services）は、Security Manager 4.4 および Auto Update 
Server 4.4 が動作するために必要です。Security Manager は、Common Services がすでにシステムに

インストールされている場合、または、Security Manager と一緒に Common Services のインストール

も選択した場合にのみインストールできます。

Common Services は、データ保存、ログイン、ユーザ ロール定義、アクセス特権、セキュリティ プロ

トコル、およびナビゲーション用のフレームワークを提供します。また、インストール、データ管理、

イベントおよびメッセージ処理、およびジョブおよびプロセス管理用のフレームワークも提供します。

Common Services が Security Manager に供給する必須サーバ側コンポーネントは次のとおりです。

• SSL ライブラリ

• 組み込み型 SQL データベース

• Apache Web サーバ

• Tomcat サーブレット エンジン

• CiscoWorks ホームページ

• バックアップ /復元機能
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第 1 章      概要

    コンポーネント アプリケーションの概要
（注） Common Services 内の Device and Credential Repository（DCR）機能は、Security Manager 4.4 では

サポートされていません。

Security Manager

Cisco Security Manager は、シスコのネットワーク デバイスとセキュリティ デバイス上でファイア

ウォール、VPN、および Intrusion Prevention System（IPS; 侵入防御システム）セキュリティ サービ

スを設定するために設計されたエンタープライズクラスの管理アプリケーションです。また、Cisco 
Security Manager は、ポリシーベースの管理テクニックを使用することによって、すべての規模の

ネットワーク（小規模ネットワークから何千ものデバイスで構成された大規模ネットワークまで）で使

用できます。さらに、Cisco Security Manager は、Cisco Security Monitoring, Analysis, and Response 
System（MARS）と連動します。この 2 つの製品を組み合わせて使用することによって、設定管理、

セキュリティ モニタリング、分析、および移行を処理する包括的なセキュリティ管理ソリューション

が実現します。

（注） Security Manager の詳細については、http://www.cisco.com/go/csmanager にアクセスしてくだ

さい。Cisco Security MARS の詳細については、http://www.cisco.com/go/mars にアクセスし

てください。

Security Manager を使用するには、サーバ ソフトウェアとクライアント ソフトウェアをインストール

する必要があります。

Security Manager が提供する機能は次のとおりです。

• 1 つのデスクトップからの VPN、ファイアウォール、および侵入防御システムのサービスレベル

およびデバイスレベルのプロビジョニング

• デバイス設定のロールバック

• トポロジ マップ形式でのネットワークの可視化

• ワークフロー モード

• 事前定義およびユーザ定義の FlexConfig サービス テンプレート

• 統合インベントリ、資格情報、分類、および共有ポリシー オブジェクト

• 関連アプリケーションに対する便利な相互起動アクセス

– サーバ ソフトウェアをインストールすると、Adaptive Security Device Manager（ASDM）、

PIX Device Manager（PDM）、Security Device Manager（SDM）、および IPS Device 
Manager（IDM）の各デバイス マネージャの読み取り専用バージョンもインストールされま

す。

– ASA デバイスと PIX デバイスを Security Manager から Auto Update Server（AUS）に追加で

きます。

• ASA デバイスと IPS デバイスによって生成されたイベントの統合モニタリング。Event Viewer 機
能を使用することによって、ASA デバイスと IPS デバイスからのイベントを選択的にモニタ、表

示、および検査できます。
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第 1 章      概要

    関連アプリケーションの概要
Auto Update Server

AUS のインストールを選択した場合は、それを Security Manager がインストールされたサーバまたは

別のサーバ（DMZ 内のサーバなど）にインストールできます。AUS と Security Manager は、デバイ

ス インベントリ情報とその他のデータを共有できます。AUS は、ブラウザベースのユーザ インター

フェイスを使用するため、Common Services が必要です。

AUS を使用すれば、自動アップデート機能を使用する PIX Security Appliance（PIX）デバイスと 
Adaptive Security Appliance（ASA）デバイス上のデバイス コンフィギュレーション ファイルとソフ

トウェア イメージをアップグレードできます。AUS は、デバイス設定、設定アップデート、デバイス 
OS アップデート、および定期設定確認に使用可能な設定のプル モデルをサポートします。加えて、自

動アップデート機能と組み合わせて動的 IP アドレスを使用するサポート対象デバイスは、AUS を使用

してコンフィギュレーション ファイルをアップグレードしたり、デバイス情報とステータス情報を渡

したりできます。

AUS は、リモート セキュリティ ネットワークのスケーラビリティを向上させ、リモート セキュリ

ティ ネットワークの維持コストを削減し、アドレス指定されたリモート ファイアウォールを動的に管

理できるようにします。

AUS の詳細については、Security Manager サイトの http://www.cisco.com/go/csmanager にある AUS 
のマニュアルを参照してください。

Performance Monitor

バージョン 4.3 から、Cisco Security Manager には、コンパニオン アプリケーションの Performance 
Monitor は付属していません。

Resource Manager Essentials

バージョン 4.3 から、Cisco Security Manager には、コンパニオン アプリケーションの CiscoWorks 
Resource Manager Essentials（RME）は付属していません。

関連アプリケーションの概要
Security Manager に統合して追加の機能とメリットを提供するその他のアプリケーションがシスコか

ら提供されています。

• Cisco Security Monitoring Analysis and Response System（MARS）：Security Manager は、

MARS を使用してファイアウォールと IPS に関するポリシーとイベント間の相互リンクをサポー

トします。Security Manager クライアントを使用して、特定のファイアウォール ルールまたは IPS 
署名を強調表示し、それらのルールまたは署名に関するイベントの表示を要求します。MARS を
使用すれば、Security Manager で、ファイアウォール イベントまたは IPS イベントを選択して、

一致するルールまたは署名の表示を要求できます。このようなポリシー /イベント相互リンクは、

特に、ネットワーク接続のトラブルシューティング、未使用ルールの特定、および署名調整活動に

役立ちます。ポリシー /イベント相互リンク機能の詳細が、『User Guide for Cisco Security 
Manager』に記載されています。MARS の詳細については、http://www.cisco.com/go/mars にア

クセスしてください。

• Cisco Secure Access Control System（ACS）：オプションで、Security Manager ユーザの認証と

認可に ACS を使用するように Security Manager を設定できます。ACS は、きめ細かなロール 
ベースの認可制御に関するカスタム ユーザ プロファイルの定義と、特定のデバイス セットにユー
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    イベント管理のイネーブル化の影響
ザを制限する機能をサポートします。Security Manager と ACS の統合の設定方法については、

「Security Manager と Cisco Secure ACS の統合」（P.8-12）を参照してください。ACS の詳細につ

いては、http://www.cisco.com/go/acs にアクセスしてください。

• Cisco Configuration Engine：Security Manager は、デバイス設定の展開メカニズムとしての 
Cisco Configuration Engine の使用をサポートします。Security Manager は、差分コンフィギュ

レーション ファイルを Cisco Configuration Engine に渡して、保存を依頼し、デバイスから読み取

れるようにします。Cisco IOS ルータ、PIX ファイアウォール、ASA デバイスなどの Dynamic 
Host Configuration Protocol（DHCP）サーバを使用するデバイスは、Cisco Configuration Engine 
に設定（およびイメージ）のアップデートを依頼します。Security Manager と Configuration 
Engine を使用すれば、静的 IP アドレスを持つデバイスを管理することもできます。静的 IP アド

レスを使用している場合は、ネットワーク上でデバイスを特定して、Configuration Engine 経由で

設定を展開できます。Security Manager と一緒に使用可能な Configuration Engine リリースについ

ては、http://www.cisco.com/en/US/products/ps6498/prod_release_notes_list.html でこの製品バー

ジョンに関するリリース ノートを参照してください。Configuration Engine の詳細については、

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4617/index.html にアクセスしてください。

イベント管理のイネーブル化の影響
Security Manager サーバ上でイベント管理をイネーブルにした場合は、そのサーバを次のサービスに

使用できません。

• CiscoWorks Common Services 上の Syslog 

Security Manager のインストールまたはアップグレード時に、Common Services syslog サービス ポー

トが 514 から 49514 に変更されます。あとで Security Manager がアンインストールされた場合、ポー

トは 514 に戻されません。ポートに関する追加情報は、表 3-1（P.3-2） と表 A-1（P.A-2） で入手できま

す。

オペレーティング システムで使用できる RAM の容量が不足している場合は、Event Viewer がディ

セーブルにされます（表 3-3（P.3-4） で詳細を参照）。ただし、Common Services syslog サービス ポー

トは変更されます。
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ライセンス

この章の情報を使用して、Cisco Security Manager 4.4 をインストールおよび使用するために必要なラ

イセンスを決定できます。さらにこの章では、スタンダード版、プロフェッショナル版、評価版など、

入手可能な各種ライセンスについても説明しています。

いくつかの注釈を除き、この章ではライセンス インストールについて説明しません。第 5 章「サーバ 
アプリケーションのインストールとアップグレード」を参照してください。

この章では、どの Security Manager サーバ ライセンスが必要かを判断する手引きとして、デバイス数

について説明します。

この章の最後には、Cisco Security Manager API を使用するシスコ パートナーの API ライセンスに関

する情報を示します。

Security Manager 4.4 をインストールおよび使用するため
に必要なライセンスの決定

必要なライセンスは、新規にインストールするのか、前のバージョンからアップグレードするのかに

よって異なります。

• 「Security Manager 4.4 の新規インストール」（P.2-1）

• 「Security Manager 4.0、4.0.1、4.1、4.2、または 4.3 からのアップグレード」（P.2-2）

• 「Security Manager 3.3 または 3.3.1 からのアップグレード」（P.2-2）

• 「Security Manager 3.2、3.2.1、または 3.2.2 からのアップグレード」（P.2-2）

Security Manager 4.4 の新規インストール 
Cisco Security Manager 4.4 を新規でインストールするには、該当する Cisco Security Manager 4.4 ラ
イセンスを購入する必要があります。Cisco Security Manager ライセンスの詳細については、

http://www.cisco.com/en/US/products/ps6498/prod_bulletins_list.html にある製品速報を参照してくだ

さい。
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    Security Manager のライセンスの説明
Security Manager 4.0、4.0.1、4.1、4.2、または 4.3 からのアップグレー
ド

Security Manager 4.0、4.0.1、4.1、4.2、または 4.3 からのアップグレードの場合、ライセンスを適用

する必要はありません。既存のライセンスが有効です。

Security Manager 3.3 または 3.3.1 からのアップグレード

Cisco Security Manager 3.3 または 3.3.1 からアップグレードするお客様は、該当する Cisco Security 
Manager 4.4 ライセンスまたはバージョン アップグレード ライセンスを購入する必要があります。

Cisco Security Manager ライセンスの詳細については、

http://www.cisco.com/en/US/products/ps6498/prod_bulletins_list.html にある製品速報を参照してくだ

さい。

Security Manager 3.2、3.2.1、または 3.2.2 からのアップグレード

Cisco Security Manager 3.2、3.2.1、または 3.2.2 からアップグレードするお客様は、該当する Cisco 
Security Manager 4.4 ライセンスまたはバージョン アップグレード ライセンスを購入する必要があり

ます。Cisco Security Manager ライセンスの詳細については、

http://www.cisco.com/en/US/products/ps6498/prod_bulletins_list.html にある製品速報を参照してくだ

さい。

Security Manager のライセンスの説明
基本ライセンスとして Standard と Professional の 2 種類が提供されており、無料の 90 日間評価ライセ

ンスもあります。

Standard および Professional
Cisco Security Manager 4.4 に対して使用可能な基本ライセンスのリストについては、表 2-1 を参照し

てください。

表 2-1 使用可能な基本ライセンスのリスト

ライセンス名 ライセンスの略称

管理可能なデバイスの台数（「デ

バイス数」（P.2-5）を参照）

Standard-5 ST5 5

Standard-10 ST10 10

Standard-25 ST25 25

Professional-50 PRO50 50

Professional-100 PRO100 100

Professional-250 PRO250 250
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    Security Manager のライセンスの説明
Professional 基本バージョンと Standard 基本バージョンの比較については、表 2-2 を参照してくださ

い。

基本ライセンスを取得するには、Cisco.com のユーザ ID を保有（または取得）している必要があり、

Cisco.com 上でソフトウェアのコピーを登録する必要があります。登録時に、購入したソフトウェア 
パッケージ内部の Software License Claim Certificate に貼られている Product Authorization Key

（PAK; 製品認証キー）を入力する必要があります。

• Cisco.com の登録ユーザの場合は、http://www.cisco.com/go/license から始めてください。

• Cisco.com の登録ユーザでない場合は、http://tools.cisco.com/RPF/register/register.do から始めて

ください。

使用開始から 90 日以内のできるだけ早い時期に、製品の連続使用を保証するために必要なデバイスの

台数分の Security Manager を登録する必要があります。アプリケーションを起動するたびに、評価ラ

イセンスの残りの日数が表示され、評価期間中のアップグレードが促されます。評価期間が終了する

と、ライセンスをアップグレードするまでログインできなくなります。

登録後に、基本ソフトウェア ライセンスが、指定した電子メール アドレスに送られてきます。ライセ

ンスは安全な場所に保管してください。

90 日間の評価ライセンス 
インストール時にライセンスを入力しないと、そのインストールは評価版になります。また、インス

トール時に [Evaluation Only] を選択することもできます。「Security Manager サーバ、Common 
Services、および AUS のインストール」（P.5-2）を参照してください。

評価ライセンスでは、使用可能なデバイスが 50 台までに制限されます。

評価ライセンスでは、Professional 版ライセンスと同じ権限が与えられます。ただし、差分ライセンス

を評価版に適用することはできません。

表 2-2 Professional 基本バージョンと Standard 基本バージョンの比較

機能

Professional でサポートされ

るか Standard でサポートされるか

50、100、および 250 台単位で

デバイス数を追加する差分（「追

加」）デバイス ライセンス パッ

ケージのサポート

Yes No

Cisco Catalyst 6500 および 7600 
シリーズ スイッチと関連サービ

ス モジュールの管理に対するサ

ポート

Yes No

ファイアウォール サービス モ
ジュールの管理に対するサポー

ト

Yes No

一時ライセンス（有効期限付き

のライセンス）に対するサポー

ト

Yes No（永久ライセンスのみサポー

ト）
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    Standard から Professional へのアップグレード ライセンス
Standard から Professional へのアップグレード ライセン
ス 

Standard から Professional へのアップグレード ライセンスを使用できます。基本ライセンスが 
Standard-25（「ST25」）ライセンスの場合にのみ適用できます。

バージョン アップグレード ライセンス 
3.3 などの以前のメジャー バージョンから Security Manager 4.4 にアップグレードする必要がある場合

は、バージョン アップグレード ライセンスを購入できます。

バージョン アップグレード ライセンスは複数種類あります。各ライセンスは、以前のバージョンの特

定の基本ライセンスと対応します。特定のアップグレード ライセンス（たとえば PRO50U）は、それ

に対応する基本ライセンス（たとえば PRO50）を以前のバージョンの Security Manager に適用してい

た場合にのみ使用できます。それ以外のアップグレード ライセンスは受け入れられません。

差分（「追加」）ライセンス 
ご使用の基本ライセンスが（Standard 版や評価版ではなく）Professional 版の場合、差分（「追加」）ラ

イセンスを購入して、管理可能なデバイスの台数を増やすことができます。差分ライセンスは、必要な

数だけ購入できます。

以前のバージョンに対する差分（「追加」）ライセンスは、現在のバージョンに対しても有効です。たと

えば、Security Manager 4.4 に対する Professional-50 ライセンスを保有している場合、4.3 の差分デバ

イス ライセンスを使用できます。

差分ライセンスは、50、100、および 250 台単位でデバイス数を追加できます。

アクティブ サーバとスタンバイ サーバ
Cisco Security Manager ライセンスでは、Cisco Security Manager の使用は 1 台のサーバ上でのみ許可

されます。常に 1 台のサーバのみがアクティブになる場合は、スタンバイの Cisco Security Manager 
サーバ（ハイ アベイラビリティ設定やディザスタ リカバリ設定などで使用される）に別個のライセン

スを用意する必要はありません。これは、ハイ アベイラビリティ（HA）が使用されている場合にも当

てはまります。

（注） スタンバイ サーバを使用するユーザは、定期的にアクティブ サーバからデータベースを手動で

復元する必要があります。

コンポーネント アプリケーションに対するライセンス
一部のコンポーネント アプリケーションには、ライセンス ファイルは必要ありません。

• Common Services にはライセンス ファイルが必要ありません。

• Auto Update Server にライセンス ファイルは必要ありません。
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デバイス数
Security Manager では、次のいずれかをデバイス インベントリに追加すると、（ライセンスで許可され

る台数から）デバイス数が 1 つ消費されます。

• 物理デバイス

• セキュリティ コンテキスト

• 仮想センサー

Advanced Inspection and Prevention Security Services Module（AIP-SSM）、IDS Network Module、
IPS Advanced Integration Module（IPS AIM）、およびホスト デバイスにインストールされた AIP-SSC 
5 および Catalyst 6500 または 7600 以外のデバイスに対してサポートされるその他のモジュールは、デ

バイス数を消費しません。ただし、追加の仮想センサー（最初のセンサーの後に追加されたセンサー）

はデバイス数を消費します。

Firewall Services Module（FWSM）または ASA デバイスの場合は、モジュール自体がデバイス数を

消費し、セキュリティ コンテキストが追加されるたびに追加のデバイス数を消費します。たとえば、2 
つのセキュリティ コンテキストを含む FWSM は、モジュール用、管理コンテキスト用、2 つめのセ

キュリティ コンテキスト用の 3 つのデバイス数を消費します。

特殊なケースとして、管理対象外デバイスがあります。Security Manager では、管理対象外デバイス

をデバイス インベントリに追加することができます。管理対象外デバイスとは、デバイス プロパティ

内で [Manage in Cisco Security Manager] を選択解除したデバイスのことです。管理対象外デバイスは

デバイス数を消費しません。

別のクラスの管理対象外デバイスは、トポロジ マップに追加されたオブジェクトです。[Map] > [Add 
Map Object] コマンドを使用して、ネットワーク クラウド、ファイアウォール、ホスト、ネットワー

ク、ルータなどのさまざまなタイプのオブジェクトをマップに追加できます。このようなオブジェクト

は、デバイス インベントリに含まれないため、デバイス数を消費しません。

どの Security Manager サーバ ライセンスを必要とするかを決定するため判断すべき、デバイス数を決

定するには、表 2-3 を参照してください。

ヒント どの Security Manager サーバ ライセンスを必要とするかを決定することを目的として、デバイスは、

Security Manager 4.4 に対して Security Manager 4.3 の場合と同様にカウントされます。

表 2-3 デバイス数の決定

デバイス 
モード（コンテキ

ストとも呼ばれる） 

デバイス数（また

はライセンス数、

単にライセンスと

も呼ばれる） コメント 

除外デバイス 

Advanced Inspection and 
Prevention Security Services 
Module（AIP-SSM） 

0 追加の仮想センサー（最初

のセンサーの後に追加され

た）が 1 ライセンスを個別に

消費します。

IDS ネットワーク モジュー

ル

0（ただし、次の

列のコメントを参

照）

追加の仮想センサー（最初

のセンサーの後に追加され

た）が 1 ライセンスを個別に

消費します。
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IPS Advanced Integration 
Module（IPS AIM）

0 

ホスト デバイスにインス

トールされた AIP-SSC 5 お
よび Catalyst 6500 または 
7600 以外のデバイスに対し

てサポートされるその他のモ

ジュール 

0

スタンドアロン ファイアウォール デバイス

任意のスタンドアロン ファ

イアウォール デバイス 
シングル コンテキ

スト モード 
1

任意のスタンドアロン ファ

イアウォール デバイス 
マルチ コンテキス

ト モード 
c、ここで c はシス

テム コンテキスト

以外のコンテキス

ト数です 

スタンドアロン IPS デバイス

任意のスタンドアロン IPS デ
バイス 

n、ここで n は仮

想センサーの数

で、仮想センサー 
vs0 が含まれます 

追加の仮想センサー（最初

のセンサーの後に追加され

た）が 1 ライセンスを個別に

消費します。

非スタンドアロン IPS デバイス

IPS モジュール、IPS ブレー

ドおよび IPS 仮想マシン 
n、ここで n は仮

想センサーの数

で、仮想センサー 
vs0 が含まれます 

IPS モジュール、IPS ブレー

ドおよび IPS 仮想マシンは 
Security Manager で個別に

検出されます。

IPS 仮想マシンは 5512-X、

5515-X、5525-X、5545-X 
および 5555-X である Cisco 
ASA 5500 シリーズの適応型

セキュリティ アプライアン

スで使用されます。

ファイアウォール ブレード

任意のスタンドアロン ファ

イアウォール ブレード 
シングル コンテキ

スト モード 
1

任意のスタンドアロン ファ

イアウォール ブレード 
マルチ コンテキス

ト モード 
c、ここで c はシス

テム コンテキスト

以外のコンテキス

ト数です 

例： 
この表の後のマルチ コンテ

キスト モードのスタンドア

ロン ファイアウォール ブ
レードの例を参照してくだ

さい。

表 2-3 デバイス数の決定 （続き）

デバイス 
モード（コンテキ

ストとも呼ばれる） 

デバイス数（また

はライセンス数、

単にライセンスと

も呼ばれる） コメント 
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マルチ コンテキスト モードのスタンドアロン ファイアウォール ブレード
の例 

ここでは、デバイス数を理解するうえで役立つコンテキストの例を示します。

次のコマンドが 2 つのセキュリティ コンテキスト（admin および ctx1）とともに、ファイアウォール 
システム上のシステム コンテキストで実行されました。

r41-appinfra-arsenal# sh context
Context Name Class Interfaces Mode URL
*admin default GigabitEthernet3/2, Routed disk0:/admin.cfg
Management0/0 
ctx1 default Routed disk0:/ctx1.cfg

Total active Security Contexts: 2
r41-appinfra-arsenal# sh context count

Total active Security Contexts: 2 

フェールオーバー構成のファイアウォール

フェール オーバー構成の任

意のファイアウォール

シングル コンテキ

スト モード 
1

フェール オーバー構成の任

意のファイアウォール

マルチ コンテキス

ト モード 
c、ここで c はシス

テム コンテキスト

以外のコンテキス

ト数です 

ASA フェールオーバー構成に含まれる IPS モジュールまたは仮想マシン

各 IPS デバイス n、ここで n は仮

想センサーの数

で、仮想センサー 
vs0 が含まれます 

追加の仮想センサー（最初

のセンサーの後に追加され

た）が 1 ライセンスを個別に

消費します。

ASA ロード バランシング クラスタに関連するライセンス

各 ASA ロード バランス クラ

スタ

シングル コンテキ

スト モード 
N、ここで N はシ

ングル コンテキス

ト ASA クラスタ

内のノード数です 

システムと管理コンテキス

トで、1 個のコンテキストを

表します。

各 ASA ロード バランス クラ

スタ

マルチ コンテキス

ト モード 
N * c、ここで N は
マルチ コンテキス

ト ASA クラスタ

内のノード数を、c 
はコンテキストの

数です

システムと管理コンテキス

トで、1 個のコンテキストを

表します。

「ASA ロード バランシング 
クラスタに関連するライセ

ンスの例」も参照してくだ

さい。

表 2-3 デバイス数の決定 （続き）

デバイス 
モード（コンテキ

ストとも呼ばれる） 

デバイス数（また

はライセンス数、

単にライセンスと

も呼ばれる） コメント 
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ASA ロード バランシング クラスタに関連するライセンスの例

ここでは、マルチ コンテキスト モードの ASA ロード バランシング クラスタのデバイス数の例を示し

ています。

3 Nodes with 4 security contexts each: License  Count = 3 * 5 = 15. 

Security Manager またはコンポーネント アプリケーショ
ンに対するライセンスのインストール

Security Manager のインストール中に、ライセンス情報の入力を求められます。「Security Manager 
サーバ、Common Services、および AUS のインストール」（P.5-2）を参照してください。

Common Services および AUS のインストール中に、ライセンス情報の入力を求められることはありま

せん。Common Services にはライセンス ファイルが必要ありません。Auto Update Server にライセン

ス ファイルは必要ありません。

Security Manager またはコンポーネント アプリケーショ
ンに対するライセンスの更新

Security Manager またはコンポーネント アプリケーションに対するライセンス ファイルの更新方法に

ついては、「Security Manager の更新」（P.5-14）を参照してください。

ライセンスに関するその他のマニュアル
使用可能なライセンスの種類やサポートされているアップグレード パスに関する詳細の他、購入可能

な Cisco Software Application Support サービス契約については、

http://www.cisco.com/en/US/products/ps6498/prod_bulletins_list.html で Security Manager の最新メ

ジャー リリースの製品速報を参照してください。

API ライセンス
API を使用するシスコ パートナーは、API ライセンスを保有している必要があります。API ライセン

スには、次の 2 種類があります。

• 開発者ライセンス。これは、開発者がそれぞれの製品を Security Manager と統合するために使用

できる 90 日間のライセンスです。

• 製品ライセンス。これは、特定のサードパーティ製品を使用するエンド カスタマーに必要なライ

センスです。

（注） API の評価ライセンスはありません。開発者ライセンスと製品ライセンスはいずれも、API を使用する

シスコ パートナーが明示的に注文する必要があります。
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ライセンスに関する支援
Security Manager のライセンスに関する問題については、Cisco Technical Assistance Center（TAC）

の Licensing Department にお問い合わせください。

• 電話：+1（800）553-2447 

• 電子メール：licensing@cisco.com 

• http://www.cisco.com/tac 
2-9
Cisco Security Manager 4.4 インストレーション ガイド

OL-28767-01-J

mailto:licensing@cisco.com
http://www.cisco.com/tac


 

第 2 章      ライセンス

    ライセンスに関する支援
2-10
Cisco Security Manager 4.4 インストレーション ガイド

OL-28767-01-J



 

Cisco S
OL-28767-01-J
C H A P T E R 3

要件と依存関係

Security Manager は、スタンドアロン製品として、あるいは、Security Manager インストーラで選択

可能な、または Cisco.com からダウンロード可能なオプション アプリケーションを含む、他のいくつ

かの Cisco Security Management Suite アプリケーションと組み合わせてインストールして使用できま

す。インストールと動作に関する要件は、サーバ上に存在する他のソフトウェアと Security Manager 
の使用方法によって異なります。

ヒント ネットワーク内のすべての管理サーバとすべての管理対象デバイス上の日付と時刻の設定を同期させる

ことを推奨します。NTP サーバを使用する方法があります。同期化は、ネットワーク上のログ ファイ

ル情報を相互に関連付けたり、分析したりする場合に重要になります。

この章の項では、Security Manager、Auto Update Server などのサーバ アプリケーションと Security 
Manager クライアント ソフトウェアのインストールに関する要件と依存関係について説明します。

• 「必要なサービスとポート」（P.3-1）

• 「サーバの要件および推奨事項」（P.3-3）

• 「クライアントの要件」（P.3-8）

必要なサービスとポート
サーバが関連アプリケーションを実行しているクライアントやサーバと通信できるようにするには、必

要なポートがイネーブルで、サーバ上の Security Manager とその関連アプリケーションから使用でき

ることを保証する必要があります。

開く必要のあるポートは、CiscoWorks for AAA と外部サーバ（ACS など）のどちらを使用しているか

と、Security Manager を特定の他のアプリケーションと相互作用するように設定しているかどうかに

よって異なります。

• 必要な基本ポート：表 3-1 に、非デフォルト ポートを使用するための設定がカスタマイズされて

いないという前提で、開く必要のある基本ポートを示します。CiscoWorks for AAA（ユーザ認可）

サービスを使用しているが、オプション アプリケーションは使用していない場合は、これらの

ポートだけを、開く必要のあるポートにする必要があります。
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• オプション アプリケーションに必要なポート：Security Manager を他のアプリケーションと一緒

に使用している場合は、表 3-2 に示すように、他のポートも開く必要があります。実際に使用する

アプリケーションに必要なポートのみを開きます。

表 3-1 Security Manager サーバ上で開く必要のある基本ポート

通信 サービス プロトコル ポート 入力 出力

Security Manager クライアントと Security Manager サー

バ間

HTTP、HTTPS TCP 1741/443 X —

Security Manager クライアントと製品に同梱されたデバ

イス マネージャ（ASDM など）間

HTTPS TCP 443 X —

IPS 署名とエンジンのアップデートをダウンロードする

ための Security Manager と Cisco.com 間
HTTP TCP 80 — X

HTTPS TCP 443 — X

Security Manager サーバとデバイス間

ヒント HTTPS ポートと SSH ポートは必要ですが、1 つ
以上のデバイス用のトランスポート プロトコル
として Telnet を使用する場合にのみ Telnet ポー
トを開きます。Telnet ではパスワードがクリア 
テキストで転送されるため、Telnet の使用は推
奨できません。Telnet ポートは開かないように
してください。

HTTPS TCP 443 — X

SSH TCP 22 — X

Telnet TCP 23 — X

IOS デバイス上での設定ロールバック動作用の Security 
Manager サーバとデバイス間

TFTP UDP 69 X X

Security Manager と電子メール サーバ間

このポートは、電子メール通知を提供可能な機能のいず

れかに関する電子メール通知を設定する場合にのみ必要

です。

SMTP TCP 25 — X

Security Manager Event Viewer で使用される Syslog 
サービス

syslog UDP 514 X —

表 3-2 オプション サーバ アプリケーションに必要なポート

通信 サービス プロトコル ポート 入力 出力

Security Manager Server と 
CS-MARS 間

HTTPS TCP 443 X X

Security Manager サーバと Cisco 
Secure Access Control Server

（ACS）間

HTTP、
HTTPS

TCP • 2002

• ACS サーバ上でポート制限がイネー

ブルになっている場合は、

HTTP/HTTPS 通信の範囲内ですべて

のポートを許可します。

• ポート制限がディセーブルになって

いる場合は、Security Manager サー

バと ACS 間のすべての 
HTTP/HTTPS トラフィックを許可し

ます。

— X
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サーバの要件および推奨事項
特に明記されている場合を除き、この項はすべてのアプリケーション（Security Manager および Auto 
Update Server）に適用されます。

Security Manager をインストールするには、管理者またはローカル管理権限を持つユーザになる必要

があります。このことは、クライアントだけをインストールする場合にも当てはまります。

Security Manager は制御環境下の専用サーバにインストールすることを推奨します。ベスト プラク

ティスと関連ガイダンスについては、第 4 章「サーバのインストール準備」 を参照してください。

推奨サーバ

Security Manager は、表 3-3 に示すコンポーネントを搭載した Cisco UCS C210 M2 サーバ上にインス

トールすることを推奨します。Cisco Unified Computing System（UCS）の詳細については、

http://www.cisco.com/go/ucs を参照してください。

インストール時の回避事項 
• プライマリやバックアップのドメイン コントローラにアプリケーションをインストールしないこ

と。Windows ドメイン コントローラ上での Common Services の使用はサポートされていません。

• 暗号化されたディレクトリにアプリケーションをインストールしないこと。Common Services は
ディレクトリの暗号化をサポートしていません。

• Terminal Services がアプリケーション モードでイネーブルになっている場合、アプリケーション

をインストールしないこと。このような場合は、Terminal Services をディセーブルにしてから、

サーバを再起動して、インストールする必要があります。Common Services は、Terminal 
Services のリモート管理者モードしかサポートしていません。

Security Manager サーバと外部 
AAA サーバ（非 ACS モードで設

定可能）間

RADIUS
LDAP
Kerberos

TCP 1645、1646、1812（新規）、389、636
（SSL）、88

— X

Security Manager サーバと 
Configuration Engine 間

HTTPS TCP 443 — X

Security Manager サーバと AUS 
間

HTTPS TCP 443 — X

デバイスと AUS 間。イメージと

設定の読み取りに使用されます。

HTTP TCP 1751 X —

Security Manager サーバと TMS 
サーバ間

FTP TCP 21 — X

クライアント システム上で動作し

ているインターネットブラウザと 
Security Manager または AUS 
サーバ上のブラウザ インターフェ

イス間

HTTP、
HTTPS

TCP 1741/443 X —

表 3-2 オプション サーバ アプリケーションに必要なポート （続き）

通信 サービス プロトコル ポート 入力 出力
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表 3-3 サーバのハードウェア要件と推奨事項

コンポーネント 説明

オペレーティング システ

ム

強く推奨：Windows 2008 R2 Enterprise Server SP1（64 ビット）。

その他のサポートされるオペレーティング システム： 

• Windows 2008 Enterprise Server（Service Pack 2）（64 ビットのみ）。

サポートされている言語は英語と日本語のみです。詳細については、「地域と言語のオプション

と関連設定について」（P.3-7）を参照してください。

サーバと Sybase データベース ファイルを連動させるためには、Microsoft ODBC Driver 
Manager 3.510 以降も必要です。インストールされた ODBC バージョンを確認するには、

ODBC32.DLL を探して右クリックしてから、ショートカット メニューで [Properties] を選択し

ます。ファイルのバージョンが [Version] タブに一覧表示されます。

システム ハードウェア • プロセッサ：Intel Quadcore Xeon 5500 シリーズ以上 

• 1280 x 1024 以上の解像度を持つカラー モニタと 16 ビット色に対応したビデオ カード 
AUS-only サーバの場合は、1024 x 768 の解像度で十分です。

• DVD-ROM ドライブ 

• 1 Gbps ネットワーク アダプタ 

• キーボード 

• マウス 

メモリ（RAM） Security Manager のすべての機能を使用するには、少なくとも 16 GB が必要です。これよりも

メモリ容量が少ないと、イベント管理やレポート管理などの機能に影響が出ます。

特に、オペレーティング システムで使用可能な RAM の容量が 8 GB 未満の場合は、イベント管

理と Report Manager がインストール時にディセーブルになります。

OS で使用可能なメモリが 8 ～ 12 GB の場合は、イベント管理とレポート管理を使用しないこと

を前提として、それらを無効にすることができます。そのようなシステムでは、コンフィギュ

レーション管理を使用することができます。

ヒント イベント管理をオフにするには、次のパスに従います。[Configuration Manager] > 
[Tools] > [Security Manager Administration] > [Event Management] > [Enable Event 
Management] >（チェックボックスをオフにする）。

ヒント レポート管理をオフにするには、レポート管理アプリケーションを終了します。

推奨はできませんが、インストールの完了後に Security Manager クライアントからロー メモリ 
システムに対してイベント管理とレポート管理をイネーブルにできます（[Tools] > [Security 
Manager Administration] > [Event Management] を選択します）。ロー メモリ システム上でイベ

ント管理とレポート管理をイネーブルにすると、アプリケーション全体のパフォーマンスに深

刻な影響が及ぶ可能性があることに注意してください。

AUS を別のサーバにインストールする場合は、次の最小用件が適用されます。

• AUS-only サーバ：4 GB。4 GB より大きくすることを推奨します。

ファイル システム NTFS 
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ディスク最適化 Diskeeper 2010 サーバ これは推奨事項であり、必要条件ではありません。パフォーマンス低下

の原因がディスクのフラグメンテーションにある場合は、ディスク最適化によりパフォーマン

スが向上します。

ハード ドライブ スペース RAID 構成で適切な組み合わせの HDD を使用して、必要なディスク領域を確保します。必要な

ディスク領域は次のとおりです。

• OS パーティション用に 100 GB を推奨します。

• アプリケーション（Security Manager）パーティション用に 150 GB を推奨します。

Security Manager のインストールのみに必要な最小空きディスク領域は 7 GB です。この要

件を満たしていないと、インストールは中断されます。

（注） OS とアプリケーションは別々のパーティションにインストールすることを強く推奨し

ます。

（注） ハイ アベイラビリティ（HA）モードで Veritas を使用する場合、上記のアプリケーショ

ン パーティション、およびその他のイベント ストア パーティションは関係しない場合

があります。詳細については、該当する Security Manager ハイ アベイラビリティ マ
ニュアル

（http://www.cisco.com/en/US/products/ps6498/prod_installation_guides_list.html）と 
Veritas マニュアルを参照してください。

• 独立したパーティション上に Event Viewer 用のログ ストレージとして 1.0 TB の追加領域：

Event Viewer を使用する場合にのみ必要な条件です。この独立したパーティションは、直

接接続ストレージ デバイス上に作成することを推奨します。

• 1.0 TB 以上の追加領域：イベント記録をイネーブルにする場合にのみ必要な条件です。イ

ベント記録機能では、（長期間の保存などにより）プライマリ ストレージの容量を超えるロ

グ ストレージが必要になると、セカンダリのイベント ストレージが作成されます。このセ

カンダリ イベント ストアには、プライマリ ストレージに設定されたサイズよりも大きいサ

イズが要求されます。そのため、イベント記録を使用するには、1.0 TB 以上の追加のディ

スク領域が必要です。プライマリとセカンダリのイベント ストアは両方とも SAN 上に配置

できますが、最適なパフォーマンスを実現するために、プライマリ ストア パーティション

は直接接続ストレージ（DAS）上に作成することを推奨します。SAN ストレージの詳細に

ついては、「SAN ストレージの使用」（P.3-7）を参照してください。

パフォーマンス向上のために、RAID 10 の使用を推奨します。必要ならば、RAID 5 も使用でき

ます。

ヒント

• 連続 10,000 イベント /秒（EPS）の場合は、1 日に約 86 GB の圧縮ディスク スペースが消

費されます。イベント ストア（プライマリ /セカンダリ）に割り当てられたディスク領域の 
90 % がいっぱいになった段階でログ ロールオーバーが発生します。ディスクのサイズが小

さいほど、ロールオーバーの発生が早くなります。予想 EPS レートとロールオーバー要件

に基づいて、イベント管理の使用時に最小ディスク サイズを増減できます。

（注） Security Manager は、以前のバージョンでは 2 TB を超えるディスク ドライブ領域をサ

ポートしていませんでしたが、現在はサポートされています。

IP アドレス 1 つの静的 IP アドレス。動的アドレスはサポートされません。

ヒント サーバに複数の IP アドレスが設定されている場合は、インストール前に複数のネット
ワーク インターフェイス カードのいずれかをディセーブルにする必要がありません。

表 3-3 サーバのハードウェア要件と推奨事項 （続き）

コンポーネント 説明
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仮想メモリ（ページング 
ファイル）

1.5 x インストールされているメモリ。これは、Windows プラットフォームに関する Microsoft 
の推奨事項です。シスコの要件ではありません。メモリ ページングは、システムに搭載された

メモリが負荷を処理するのに足りない場合にのみ発生します。

注意 Windows Server 2008 では [Automatically manage paging file size for all drives] 
チェックボックスをオフにする必要があります。このチェックボックスは、
[Computer] > [Properties] > [Advanced System Settings] > [Performance] > [Settings] 
> [Advanced] > [Virtual Memory] > [Change] にあります。

ウイルス対策 リアルタイム保護がディセーブルになっていること。これは推奨事項であり、必要条件ではあ

りません。システムにはアンチウイルス アプリケーションをインストールできますが、パ

フォーマンス低下の原因となるため、リアルタイム保護をディセーブルにすることを推奨しま

す。サーバの負荷が小さい時間帯にクイック スキャンを実行するようにスケジューリングする

こともできます。

ブラウザ 次のいずれかが必要です。

• Internet Explorer 7.0（この表の始めに示したオペレーティング システムを使用する場合）。

• Internet Explorer 8.0（この表の始めに示したオペレーティング システムを使用し、互換表

示のみで使用する場合）。

• Internet Explorer 9.0（この表の始めに示したオペレーティング システムを使用し、互換表

示のみで使用する場合）。

ヒント Internet Explorer 8 または 9 で互換表示を使用するには、[Tools] > [Compatibility View 
Settings] に移動し、[website to be displayed in Compatibility View] として Security 
Manager サーバを追加します。

（注） クライアントをダウンロードするために Internet Explorer 9 を使用する場合は、次の設

定が正しいことを確認してください。Internet Explorer 9 の [Tools] > [Internet Options] 
> [Advanced] > [Security] > [Do not save encrypted pages to disk] チェックボックスをオ

フにします。この設定が正しくない（つまり、チェックボックスがオン）場合、クライ

アントをダウンロードしようとすると失敗します。

• Firefox 13.0.x 以降（この表の始めに示したオペレーティング システムを使用する場合）。

Java プラグイン JRE をインストールするための要件はありません。Java スクリプトが Web ブラウザでイネーブ

ルになっている必要があります。

オプションの仮想化ソフ

トウェア

オプションとして、VMware ESX 4.1、VMware ESXi 4.1、VMware ESXi 5.0、または ESXi 
5.1 を実行しているシステム上にアプリケーションをインストールすることもできます。

Security Manager と一緒に使用する仮想マシンには、非仮想化サーバを使用する場合の容量以

上のメモリを割り当てる必要があります。仮想化パフォーマンスを向上させるように設計され

たテクノロジーを使用した新世代 CPU（Intel-VT や AMD-V CPU など）の使用が推奨されてい

ます。

ヒント 複数の CPU を VM イメージに割り当てます。1 つの CPU しか使用していない場合は、
システム バックアップなどの一部のプロセスに異常に長い時間がかかる可能性がありま
す。

表 3-3 サーバのハードウェア要件と推奨事項 （続き）

コンポーネント 説明
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地域と言語のオプションと関連設定について

Security Manager は、米国だけをサポートします。Windows の英語および日本語版。[Start] メニュー

から、Windows のコントロール パネルを開いて、地域と言語を設定するパネルを開き、デフォルト ロ
ケールを設定します （日本語バージョンの Windows では言語として英語がサポートされません）。

加えて、サーバのオペレーティング システム（Windows Server 2008）内の地域と言語のオプションを

正しく設定する必要があります。また、他の言語を使用するキーボードなどの周辺デバイスは、

Security Manager の動作に影響する可能性があります。

次のリストに、Security Manager のインストールを成功させるために従う必要のある地域と言語のオ

プションと関連設定を示します。

• サーバ ロケールは米国である必要があります。英語または日本語。

• 他の言語を使用するキーボードなどの周辺デバイスの使用は避ける必要があります。このようなデ

バイスはサーバにも接続しないでください。

• サーバへの非コンソール RDP セッションを使用している場合はサーバ設定を妨げないように注意

する必要があります。非コンソール RDP を使用してサーバに接続している場合は、RDP クライア

ント マシンのロケールがサーバに適用される可能性があります。

• 地域と言語のオプションをチェックして、非 Unicode プログラム用に選択された言語が英語（米

国）になっていることを確認する必要があります。その選択パスは、[Control Panel] > [Regional 
and Language Options] > [Advanced] > [Language for non-Unicode Programs] です。

• Windows レジストリのシステム ロケールがサポートされている言語であることを確認する必要が

あります。これを変更するには、次の手順に従ってください。

a. コマンド ウィンドウで、regedit.exe または regedt32.exe のいずれかのコマンドを実行します。

b. localname がサポートされていることを確認します。次の例は米国の場合です。English:

\HKEY_USERS\.DEFAULT\Control Panel\International 

LocaleName を en-US に変更します

（注） パスとファイル名に使用可能な文字は、英語のアルファベットに制限されています。パスとファイル名

に対して日本語はサポートされていません。Windows 日本語 OS システムでファイルを選択する場合

は、通常のファイル区切り文字 \ がサポートされますが、これは円記号（U+00A5）として表示される

ことがあることに注意する必要があります。

SAN ストレージの使用

十分な I/O 速度と容量を備えている SAN ストレージであれば、Security Manager で使用することがで

きます。次に、Security Manager 内でストレージを必要とする主な項目とともに、サーバに直接搭載

されたディスク ストレージを使用する以外に選択可能なストレージ オプションを示します。

• Security Manager インストール フォルダ（CSCOpx およびサブフォルダ）：アプリケーションの最

適なインストール先はローカル ドライブです。ただし、インストール フォルダは、直接接続スト

レージ（DAS）にすることも、ブロックベースの SAN ストレージ（FC、FCoE、iSCSI）にする

こともできます。Security Manager のハイ アベイラビリティ設定（『High Availability Installation 
Guide for Cisco Security Manager』を参照）には、共有クラスタ ボリュームが必要です。

• Event Manager サービス用のプライマリ ストレージ：Event Viewer を使用してイベントを監視す

る場合、プライマリ ストレージの場所を指定する必要があります。プライマリ ストレージは、直

接接続ストレージ（DAS）にすることも、ローカル ドライブとしてマップされたブロック スト

レージ（SAN プロトコル：FC、FCoE、iSCSI）にすることもできます。
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• Event Manager サービス用の拡張ストレージ：拡張ストレージの場所は、SAN ストレージ上に存

在すると想定されます。拡張ストレージは、直接接続ストレージ（DAS）にするか、ローカル ド
ライブとしてマップされたブロック ストレージ（SAN プロトコル：FC、FCoE、iSCSI）にする

必要があります。

ヒント

• CIFS と NFS はサポートされていません。

• サポートされているネットワーク ストレージ タイプは、VMware 設定でもサポートされます。

iSCSI ボリュームの要件 

システム リブート後に Security Manager サービスが開始しようとしているときは、ソフトウェア イニ

シエータを使用する iSCSI ボリュームを使用できないことがあります。これらが適切に初期化される

までは少し時間がかかる場合があります。

Security Manager サービスが開始していない場合は、Security Manager サービスの依存関係とサービ

ス スタートアップを設定する必要があります。

依存関係とスタートアップを設定するには、次の手順に従います。

ステップ 1 Windows コマンド プロンプトで次のコマンドを実行して、Cisco Security Manager Daemon Manager、
syslog、および tftp サービスの起動タイプを「Delayed auto start」に変更します。

sc config CRMDmgtd start= delayed-auto

sc config crmlog start= delayed-auto

sc config crmtftp start= delayed-auto

ステップ 2 次のコマンドを実行して、Microsoft iSCSI の依存関係を Cisco Security Manager Daemon Manager 
サービスに設定します。

sc config CRMDmgtd depend= MSiSCSI 

ヒント これらのコマンドでは、オプション名に等号が含まれます。等号と値の間にはスペースが必要です。

ステップ 3 次のコマンドを実行して、Cisco Security Manager Daemon Manager サービスの依存関係の設定を確認

します。iSCSI イニシエータの依存関係の設定は「DEPENDENCIES : MSiSCSI」と表示されます。

sc qc CRMDmgtd 

クライアントの要件
表 3-4 に、Security Manager クライアントの要件と制約事項を示します。

表 3-4 クライアントの要件と制約事項

コンポーネント 要件

システム ハード

ウェア

• 2 GHz 以上の速度の CPU x 1

• 1280 x 1024 以上の解像度を持つカラー モニタと 16 ビット色に対応したビデオ カード

• キーボード

• マウス
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システム ソフト

ウェア

次のいずれかが必要です。

• Windows XP（Service Pack 3）。

• Windows 7 Enterprise Edition（64 ビットおよび 32 ビット）。

• Windows 2008 Enterprise Server（Service Pack 2）（64 ビットのみ）。

• Windows 2008 R2 Enterprise Server SP1（64 ビット）。

（注） Security Manager は、米国だけをサポートします。Windows の英語および日本語版。[Start] 
メニューから、Windows のコントロール パネルを開いて、地域と言語を設定するパネルを開

き、デフォルト ロケールを設定します （日本語バージョンの Windows では言語として英語が

サポートされません）。

メモリ（RAM） 32 ビット システムの場合。

• 最小：2 GB 

• 推奨：2 GB 以上 

64 ビット システムの場合。

• 最小：4 GB 

• 推奨：4 GB 以上 

仮想メモリ（ペー

ジング ファイル）

512 MB 

注意 Windows Server 2008 では [Automatically manage paging file size for all drives] チェック

ボックスをオフにする必要があります。このチェックボックスは、[Computer] > 
[Properties] > [Advanced System Settings] > [Performance] > [Settings] > [Advanced] > 
[Virtual Memory] > [Change] にあります。

ハード ドライブ ス
ペース

10 GB の空きディスク スペース 

ブラウザ 次のいずれかが必要です。

• Internet Explorer 7.0（この表の始めに示したオペレーティング システムを使用する場合）。

• Internet Explorer 8.0（この表の始めに示したオペレーティング システムを使用し、互換表示のみ

で使用する場合）。

• Internet Explorer 9.0（この表の始めに示したオペレーティング システムを使用し、互換表示のみ

で使用する場合）。

ヒント Internet Explorer 8 または 9 で互換表示を使用するには、[Tools] > [Compatibility View 
Settings] に移動し、[website to be displayed in Compatibility View] として Security Manager 
サーバを追加します。

（注） クライアントをダウンロードするために Internet Explorer 9 を使用する場合は、次の設定が正

しいことを確認してください。Internet Explorer 9 の [Tools] > [Internet Options] > [Advanced] 
> [Security] > [Do not save encrypted pages to disk] チェックボックスをオフにします。この設

定が正しくない（つまり、チェックボックスがオン）場合、クライアントをダウンロードしよ

うとすると失敗します。

• Firefox 3.6.x（この表の始めに示したオペレーティング システムを使用する場合）。

• Firefox 13.0.x、14.0.x、または 15.0.x（この表の始めに示したオペレーティング システムを使用

する場合）。

表 3-4 クライアントの要件と制約事項 （続き）

コンポーネント 要件
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Java プラグイン JRE をインストールするための要件はありません。Java スクリプトが Web ブラウザでイネーブルに

なっている必要があります。

Security Manager クライアントには、組み込みバージョンと完全分離バージョンの Java（JRE 
1.6.0_35）が含まれます。この Java バージョンが、ブラウザの設定または他の Java ベースのアプリ

ケーションを妨害することはありません。

Windows ユーザ ア
カウント

Security Manager クライアントを使用するには、管理者特権を持つ Windows ユーザ アカウントで

ワークステーションにログインする必要があります。

より低い特権ではクライアントの一部の機能しか使用できませんが、管理者ユーザはすべての機能を

使用できます。

表 3-4 クライアントの要件と制約事項 （続き）

コンポーネント 要件
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C H A P T E R 4

サーバのインストール準備

ターゲット サーバが第 3 章「要件と依存関係」に記載されている要件を満たしていることを確認した

ら、このチェックリストを使用してサーバをインストール用に準備し、最適化できます。

• 「サーバのパフォーマンスとセキュリティを向上させるためのベスト プラクティス」（P.4-1）

• 「インストール準備状況チェックリスト」（P.4-3）

サーバのパフォーマンスとセキュリティを向上させるための
ベスト プラクティス

ベスト プラクティスのフレームワーク、推奨事項、およびその他の準備タスクを使用すると、

Security Manager サーバの速度と信頼性を高めることができます。

注意 このチェックリスト内のタスクを完了することによって、すべてのサーバのパフォーマンスが向上

するわけではありません。それでも、これらのタスクを完了しなかった場合は、Security Manager 
が設計どおりに動作しないことがあります。

このチェックリストは、推奨タスクの進捗を追跡するために使用できます。

タスク

1. サーバへのインストールが推奨されているすべてのアップデート、パッチ、サービス パック、ホット フィック

ス、およびセキュリティ ソフトウェアを探して、インストーラ アプリケーションを編成します。

2. アップグレードが入手可能な場合は、サーバ BIOS をアップグレードします。

3. 他の目的に使用しているサーバ上に Security Manager をインストールする場合は、すべての重要なサーバ デー

タをバックアップしてから、ブート CD または DVD を使用してサーバからすべてのデータをワイプします。

Security Manager 4.4 と 4.0 以前のリリースの Common Services を 1 台のサーバ上にインストールまたは共存さ

せることはできません。また、このマニュアルまたは http://www.cisco.com/go/csmanager に明記されていない

場合は、サードパーティ ソフトウェアまたはその他のシスコ ソフトウェアと共存させることもできません。

4. サーバ管理用のメーカー カスタマイズが施されていないベースライン サーバ OS のみのクリーン インストール

を実行します。
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5. ターゲット サーバ上に必要なすべての OS サービス パックと OS パッチをインストールします。使用している 
Windows に関してどのサービス パックまたはアップデートが必要なのかをチェックするには、[Start] > [Run] 
を選択してから、wupdmgr と入力します。

6. ドライバとファームウェアに関して推奨されているすべてのアップデートをターゲット サーバにインストール

します。

7. システム上でマルウェアをスキャンします。ターゲット サーバとその OS をセキュリティで保護するには、シス

テム上でウイルス、トロイの木馬、スパイウェア、キーロガー、およびその他のマルウェアをスキャンしてか

ら、見つかったすべての関連問題に対処します。

8. セキュリティ製品の競合を解消します。ポップアップ ブロック、アンチウイルス スキャナ、他社の同等製品な

どのセキュリティ ツールに関する既知の非互換性または制約事項を理解して解決します。このような製品の競

合や相互作用を理解するに当たって、インストール、アンインストール、または一時的にディセーブルにするも

のを決定し、従うべき順序を考慮します。

9. ユーザ アカウントを「強化」します。ターゲット サーバを総当たり攻撃から保護するには、ゲスト ユーザ アカ

ウントをディセーブルにして、管理者ユーザ アカウントの名前を変更し、管理環境内の悪用される可能性のあ

るその他のユーザ アカウントを削除します。

10. 管理者ユーザ アカウントと残りのユーザ アカウントに対して強力なパスワードを使用します。強力なパスワー

ドは、8 文字以上で構成され、数字、文字（大文字と小文字の両方）、および記号が含まれています。

ヒント Local Security Settings ツールを使用して、強力なパスワードを要求します。[Start] > [Administrative Tools] 
> [Local Security Policy] を選択します。

11. 未使用のアプリケーション、不必要なアプリケーション、および互換性のないアプリケーションを削除します。

例：

• Microsoft Internet Information Server（IIS）は Security Manager と互換性がありません。IIS がインストー

ルされている場合は、それをアンインストールしてから Security Manager をインストールする必要があり

ます。

• このマニュアルまたは http://www.cisco.com/go/csmanager に明記されていなければ、Security Manager と
サードパーティ ソフトウェアまたはその他のシスコ ソフトウェア（LAN Management Solution（LMS）な

どの CiscoWorks ブランドの「ソリューション」または「バンドル」を含む）の共存がサポートされませ

ん。Security Manager と AUS の同じサーバ上へのインストールはサポートされますが、非常に低速なネッ

トワークにのみ推奨されている設定です。また、いずれかの製品をインストールする前に、CiscoWorks 
Common Services をインストールする必要があります。

• 1 台のサーバ上で、このバージョンの Security Manager と 4.0 以前のリリースの Common Services をイン

ストールまたは共存させることはできません。

• 1 台のサーバ上で、Security Manager と Security Manager の購入時に受領したものではない CD-ONE コン

ポーネント（CiscoView Device Manager を含む）を共存させることはできません。

• 1 台のサーバ上で、Security Manager と Cisco Secure ACS for Windows を共存させることはできません。

• 1 台のサーバ上で、Security Manager とフル バージョンの Cisco IPS Event Viewer を共存させることはでき

ません。

12. 未使用のサービスと不必要なサービスをディセーブルにします。Windows では、少なくとも、DNS クライアン

ト、イベント ログ、プラグ アンド プレイ、保護された記憶域、およびセキュリティ アカウント マネージャを実

行する必要があります。

ソフトウェアとハードウェアのマニュアルをチェックして、特定のサーバでその他のサービスが必要ないかどう

かを確認します。

13. TCP と UDP を除くすべてのネットワーク プロトコルをディセーブルにします。どのプロトコルもサーバへの

アクセス権の取得に使用される可能性があります。ネットワーク プロトコルを制限することによって、サーバ

へのアクセス ポイントが制限されます。

タスク
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インストール準備状況チェックリスト
Security Manager をインストールする前に、次のタスクを完了する必要があります。

14. IPv6 をディセーブルにします。Cisco Security Manager は IPv6 をサポートしていません。IPv6 は Windows 
Server 2008 で使用されるデフォルトのプロトコルです。

15. ネットワーク共有は作成しないでください。ネットワーク共有を作成しなければならない場合は、共有リソース

を強力なパスワードで保護してください。

（注） ネットワーク共有はあまり推奨できません。NETBIOS を完全にディセーブルにすることを推奨します。

16. サーバ ブート設定を構成します。起動時間を 0 秒に設定して、Windows をデフォルトでロードするように設定

し、システム障害発生時の自動リブートをイネーブルにします。

タスク

準備状況要因

注意 セキュリティ アプリケーションをアンインストールまたはディセーブルにした場合は、サーバが攻撃に対

して脆弱になる可能性があります。

1. 一時的にセキュリティ アプリケーションをディセーブルにします。たとえば、Security Manager をインストー

ルする前に、ターゲット サーバ上のアンチウイルス ソフトウェアを一時的にディセーブルにする必要がありま

す。これらのプログラムがアクティブの間はインストールを実行できません。

ヒント サーバに SSL 証明書の有効期間以外の日付と時刻を設定した場合は、サーバ上の SSL 証明書が無効になりま
す。サーバの SSL 証明書が無効になっている場合は、DCRServer プロセスが起動できません。

2. サーバに適用する日付と時刻の設定は慎重に検討してください。NTP サーバを使用して、サーバの日付と時刻

の設定と管理対象デバイスの日付と時刻の設定を同期させる方法が理想的です。また、Security Manager を 
Cisco Security Monitoring, Analysis, and Response System（Cisco Security MARS）アプライアンスと組み合わ

せて使用する場合は、使用する NTP サーバを Cisco Security MARS アプライアンスが使用するサーバと同じに

する必要があります。ネットワーク上で発生したものを正確に再構成するためにはタイムスタンプ情報が不可欠

なため、特に、Cisco Security MARS で同期化された時間が重要です。

ヒント サーバ上の日付と時刻の設定を変更して SSL 証明書が無効になった場合は、
「java.security.cert.CertificateNotYetValidException」エラーが NMSROOT\log\DCRServer.log ファイルに記
録されます。ここで、NMSROOT は Security Manager インストール ディレクトリへのパスです。デフォル
トは C:\Program Files\CSCOpx です。

3. 必要なサービスとポートがイネーブルになっており、Security Manager から使用可能なことを確認します。「必

要なサービスとポート」（P.3-1）を参照してください。

4. Terminal Services がアプリケーション モードでイネーブルになっている場合は、Terminal Services をディ

セーブルにして、サーバをリブートします。Terminal Services がアプリケーション モードでイネーブルになっ

ているサーバ上に Security Manager をインストールできません。リモート管理モードでイネーブルにされた 
Terminal Services はサポートされます。

Terminal Services がアプリケーション モードでイネーブルになっているターゲット サーバに Security Manager 
をインストールしようとすると、エラーでインストールが終了します。

5. 実行中のドメイン コントローラ サービス（プライマリまたはバックアップ）をディセーブルにします。
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6. インストールのターゲット ディレクトリが暗号化されていないことを確認します。暗号化されたディレクトリに 
Security Manager をインストールしようとすると失敗します。

7. フレッシュ インストールを実行している場合は、インストールの前にライセンス ファイルをターゲット サーバ

に配置する必要があります。インストール中にこのファイルの選択が要求されます。

（注） ライセンス ファイルのパスには、アンパサンド（&）などの特殊文字が含まれていてはなりません。

8. インストールされている IIS をアンインストールします。IIS は Security Manager と互換性がありません。

9. 存在する場合の Cisco Secure ACS for Windows を含めて、サーバ上のすべてのアクティブな Sybase インスタ

ンスをディセーブルにします。Security Manager のインストール後に Sybase を再イネーブルするか、再起動す

るかを選択できますが、同じサーバ上での Security Manager と Cisco Secure ACS for Windows の共存がサポー

トされていないことに注意してください。

10. Cisco Security Manager クライアントがすでにサーバ上にインストールされている場合は、そのクライアント

を停止する必要があります。この状態はインストール中にチェックされます。

11. FIPS 準拠の暗号化をディセーブルにします。Windows Server 2008 のグループ セキュリティ ポリシーで、

Federal Information Processing Standard（FIPS; 連邦情報処理標準）準拠の暗号化アルゴリズムがイネーブルに

なっていることがあります。FIPS 準拠がオンになっている場合は、CiscoWorks サーバ上の SSL 認証が失敗す

る可能性があります。CiscoWorks を正しく機能させるためには、FIPS 準拠をディセーブルにする必要がありま

す。

手順

Windows Server 2008 上で FIPS をイネーブルまたはディセーブルにするには、次の手順を実行します。

a. [Start] > [Administrative Tools] > [Local Security Policy] に移動します。[Local Security Policy] ウィンドウ

が表示されます。

b. [Local Polices] > [Security Options]をクリックします。

c. [System cryptography: Use FIPS compliant algorithms for encryption, hashing, and signing] を選択します。

d. 選択したポリシーを右クリックして、[Properties] をクリックします。

e. [Enabled] または [Disabled] を選択して、FIPS 順序アルゴリズムをイネーブルまたはディセーブルにしま

す。

f. [Apply] をクリックします。

サーバをリブートして変更を有効にする必要があります。

12. Internet Explorer Enhanced Security Configuration（IE ESC）をディセーブルにします。クライアントのダ

ウンロードが IE ESC によって禁止されるため、この作業を行う必要があります。

手順

Security Manager のインストール準備をしているサーバ上で IE ESC をディセーブルにするには、次の手順を実行し

ます。

a. Windows で、Server Manager を開きます。これを行うには、[Computer] を右クリックしてから、[Manage] 
をクリックします。

b. [Security Information] の下で、[Configure IE ESC] をクリックし、IE ESC を無効にします。

準備状況要因
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サーバ アプリケーションのインストールと
アップグレード

次のトピックでは、Security Manager サーバ ソフトウェアとその他のサーバ アプリケーション

（Common Services、AUS など）のインストール方法について説明します。

• 「必要なサーバ ユーザ アカウントについて」（P.5-1）

• 「Remote Desktop Connection または VNC を使用したサーバ アプリケーションのインストール」

（P.5-2）

• 「Security Manager サーバ、Common Services、および AUS のインストール」（P.5-2）

• 「サーバ アプリケーションのアップグレード」（P.5-5）

• 「新しいコンピュータまたはオペレーティング システムへの Security Manager の移行」（P.5-12）

• 「Security Manager の更新」（P.5-14）

• 「サービス パックとポイント パッチの入手」（P.5-15）

• 「サーバ アプリケーションのアンインストール」（P.5-15）

• 「サーバ アプリケーションのダウングレード」（P.5-16）

必要なサーバ ユーザ アカウントについて
CiscoWorks Common Services と Security Manager は、必要な認可を受けているユーザにのみ特定の

機能へのアクセスを許可する多層セキュリティ システムを採用しています。そのため、Common 
Services 上で動作するアプリケーションがインストールされたシステム上では、事前に定義された次の 
3 つのユーザ アカウントが作成されます。

• admin：admin ユーザ アカウントは、Windows 管理者と等価で、Common Services、
Security Manager、およびその他のアプリケーション タスクのすべてにアクセスできるようにしま

す。インストール中にパスワードを入力する必要があります。このアカウントは、初めてサーバに

ログインするときに使用して、アプリケーションを日常的に使用するための他のユーザ アカウン

トを作成できます。

• casuser：casuser ユーザ アカウントは、Windows 管理者と等価で、Common Services タスクと 
Security Manager タスクのすべてにアクセスできるようにします。このアカウントを直接使用する

ことはあまりありません。

製品のインストール中に設定された casuser（デフォルト サービス アカウント）権限またはディレ

クトリ権限を変更しないでください。変更した場合は、次の操作ができなくなる可能性がありま

す。

– Web サーバへのログイン 
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– クライアントへのログイン 

– データベースの正常なバックアップ 

• システム識別：システム識別ユーザ アカウントは、Windows 管理者と等価で、Common Services 
タスクと Security Manager タスクのすべてにアクセスできるようにします。このアカウントには

固定の名前がありません。ニーズに合った名前を使用してアカウントを作成できます。Common 
Services でアカウントを作成した場合は、そのアカウントにシステム管理者特権を付与する必要が

あります。ユーザ認証に Cisco Secure Access Control Server（ACS）を使用している場合は、

ACS にすべての特権を付与する必要があります。

Cisco Security Management Suite アプリケーションを別のサーバにインストールする場合（推奨ア

プローチ）は、マルチサーバ セットアップ内のすべてのサーバ上で同じシステム識別ユーザ アカ

ウントを作成する必要があります。サーバ間の通信は、証明書と共有秘密キーを使用する信頼モデ

ルに依存します。システム識別ユーザは、マルチサーバ セットアップ内の他のサーバから信頼で

きるアカウントと見なされるため、ドメイン内のサーバ間通信が容易になります。

必要な数のユーザ アカウントを追加できます。アカウントはユーザごとに一意にする必要があります。

このような追加のアカウントを作成するには、システム管理者権限（admin アカウントの使用など）を

持っている必要があります。ユーザ アカウントを作成したら、それにロールを割り当てる必要があり

ます。このロールによって、表示も含めて、ユーザがアプリケーション内で可能な操作が定義されま

す。使用可能な権限の種類と ACS を使用してアプリケーションへのアクセスを制御する方法について

は、第 8 章「ユーザ アカウントの管理」を参照してください。

Remote Desktop Connection または VNC を使用した
サーバ アプリケーションのインストール 

サーバ アプリケーションは、サーバに直接ログインしてインストールすることを推奨します。

ただし、リモート インストール（別のワークステーション経由のログイン）を行わなければならない

場合は、次のヒントを考慮してください。

• リモート ディスクからソフトウェアをインストールしようとしないでください。ソフトウェア イ
ンストーラは、サーバ内の DVD ドライブ上で動作している製品 DVD 上に存在するか、直接接続

されたディスク ドライブ上に存在する必要があります。リモート ディスクからのインストールが

成功したように見える場合がありますが、実際には成功していません。

• ソフトウェアのインストールに Virtual Network Computing（VNC）を使用できます。

• ソフトウェアのインストールに Remote Desktop Connection を使用できます。Remote Desktop 
Connection を使用する場合は、Remote Desktop Protocol 非コンソール セッションではなく、コン

ソール セッションを使用することを推奨します。

Security Manager サーバ、Common Services、および 
AUS のインストール

メインの Security Manager インストール プログラムで次のようなアプリケーションをインストールで

きます。

• CiscoWorks Common Services 4.0：サーバ アプリケーションに必要な基盤ソフトウェアです。

Security Manager 4.4 から、[CiscoWorks Common Services 4.0] チェックボックスはコンポーネン

トの選択ページに表示されなくなりました。Common Services のインストールは、デフォルトで

選択されます。
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• Cisco Security Manager 4.4：Security Manager のメイン サーバ ソフトウェアです。

• Auto Update Server 4.4。

• Cisco Security Manager Client 4.4：Security Manager サーバとデータをやり取りするためのクラ

イアント ソフトウェアです。サーバと同じコンピュータ上にインストールできますが、このセッ

トアップを Security Manager を使用する通常の方法として使用しないでください。推奨されてい

るクライアントのインストールとセットアップの詳細については、第 6 章「クライアントのインス

トールと設定」 を参照してください。

ヒント Security Manager 4.4 から、インストール時間を短縮するために、AUS および Security 
Manager クライアントが同時にインストールされます。

次の手順を使用して、これらのアプリケーションをインストールまたは再インストールします。以前の

バージョンのアプリケーションからアップグレードしている場合は、先に進む前に、「サーバ アプリ

ケーションのアップグレード」（P.5-5）を参照してください。

はじめる前に

• このインストレーション ガイドの「ライセンス」の章を参照してください。

• すでにサーバ上にインストールされている既存のバージョンのアプリケーションに対するアップグ

レードとして製品をインストールしている場合は、「リモート アップグレード時のデータベースの

バックアップ」（P.5-8）に記載されているようにバックアップを実行してください。アップグレー

ドをインストールする前に、バックアップが正常に終了し、既存のアプリケーションが正しく機能

していることを確認してください。

• Security Manager の永久ライセンスのインストール時は、Security Manager サーバにとってローカ

ルなディスク上にライセンス ファイルを配置する必要があります。Security Manager を使用して

サーバ上のディレクトリを参照する場合、マップされたドライブは表示されません。そのため、イ

ンストール時にライセンス ファイルを選択するには、そのライセンス ファイルがサーバ上に存在

している必要があります。（Windows ではこの制限が課されますが、これにより Security Manager 
のパフォーマンスとセキュリティが向上します）。このファイルは製品をインストールするフォル

ダに配置しないでください。

（注） ライセンス ファイルのパスには、アンパサンド（&）などの特殊文字が含まれていてはなりま

せん。

• 「インストール準備状況チェックリスト」（P.4-3）を完了したことを確認してください。

• サーバが「サーバの要件および推奨事項」（P.3-3）に記載された要件を満たしていることを確認し

てください。

• Security Manager は制御環境下の専用サーバにインストールすることを推奨します。他のソフト

ウェア アプリケーションをインストールした場合は、Security Manager の通常動作と競合したり、

サポートされていなかったりする可能性があります。

• Common Services のインストール後にシステム時間を変更しないでください。このような変更が

一部の時間依存機能の動作に影響する可能性があります。

• Cisco Secure Access Control Server（ACS）を使用して、Security Manager または AUS へのユー

ザ アクセスに AAA サービスを提供する場合は、アプリケーションをインストールしてから、

ACS を使用するように Common Services を設定します。ACS 制御の設定方法については、

「Security Manager と Cisco Secure ACS の統合」（P.8-12）を参照してください。
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ACS を使用するように Common Services を設定してから Security Manager または AUS をインス

トールした場合は、インストール中に、インストールしたアプリケーションを ACS に登録する必

要があることが通知されます。まだアプリケーション（このサーバ上または別のサーバ上）を 
ACS に登録していない場合は、[Yes] を選択します。すでにアプリケーションを登録している場合

は、[Yes] を選択すると、アプリケーションの ACS 内で設定されたユーザ ロールのカスタマイズ

が失われるため、[No] を選択する必要があります。同じ ACS サーバを使用するすべての Security 
Manager サーバと AUS サーバがユーザ ロールを共有します。

手順

Security Manager サーバ、Common Services、AUS、またはメインの Security Manager インストール 
プログラムを使用する複数のアプリケーションをインストールするには、次の手順を実行します。

ステップ 1 インストール プログラムを入手または検索します。次のいずれかの操作を実行できます。

• サーバの DVD ドライブに Security Manager インストール DVD を挿入します。インストール アプ

リケーションが自動的に起動しなかった場合は、csm<version>_win_server フォルダ内の 
Setup.exe ファイルを実行します。

• Cisco.com アカウントにログインして、http://www.cisco.com/go/csmanager にある Security 
Manager ホームページにアクセスします。[Download Software] をクリックして、圧縮された 
Security Manager のインストール ファイルをダウンロードします。

– WinZip や圧縮フォルダの展開ウィザードなどの Windows Server 2008 に付属しているファイ

ル圧縮ユーティリティのいずれかを使用して、圧縮されたソフトウェア インストール ファイ

ル内のすべてのファイルを一時ディレクトリで解凍します。パス名があまり長くないディレク

トリを使用してください。たとえば、C:\Documents and Settings\Administrator\Desktop より

は C: を選択してください。通常は、圧縮ファイルと同じディレクトリに解凍される、インス

トール プログラムの Setup.exe を開始します。

– ファイルの内容を解凍できないというエラー メッセージが表示された場合は、Temp ディレク

トリを空にして、ウイルスをスキャンし、C:\Program Files\Common Files\InstallShield ディ

レクトリを削除してから、リブートしてもう一度試してみてください。

ステップ 2 インストール ウィザードの指示に従います。インストール中に、次の情報の入力が要求されます。

• Backup location：特定のバージョンの Common Services、Security Manager、または AUS がすで

にインストールされている場合は、インストール プログラムによってインストール中のデータ

ベース バックアップが許可されます。バックアップを実施する場合は、バックアップに使用する

場所を選択します。ただし、バックアップは、インストールを開始する前に実施することを推奨し

ます。

（注） バックアップに使用するために選択する場所は、NMSROOT の外にする必要があります。場所 
NMSROOT は Security Manager インストール ディレクトリへのパスです。デフォルトは 
C:\Program Files\CSCOpx です。特に、NMSROOT\backup をバックアップに使用しないよ

うに注意してください。

• Destination folder：アプリケーションをインストールするフォルダ。他の場所にインストールする

特別な理由がなければ、デフォルトを受け入れます。デフォルト フォルダ以外のフォルダを指定

した場合は、その下にファイルが存在しないことと、パス名が 256 文字未満であることを確認して

ください。また、デフォルト フォルダ以外のフォルダを指定すると、パスに特殊文字を含めるこ

とはできません。

• Applications：インストールするアプリケーション：Security Manager、AUS、または両方。

CiscoWorks Common Services 4.0 が Security Manager または AUS のインストール時に自動的に

インストールされます。
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• License information：次のいずれかを選択します。

– [License File Location]：ライセンス ファイルのフル パス名を入力するか、[Browse] をクリッ

クして検索します。永久ライセンス ファイルを事前にサーバ上に配置してあった場合は、そ

のファイルを指定できます。

（注） ライセンス ファイルのパスには、アンパサンド（&）などの特殊文字が含まれていてはなりま

せん。

– [Evaluation Only]：無料の 90 日の評価期間をイネーブルにします。

• Admin password：5 文字以上の admin ユーザ アカウント用パスワード。このアカウント、システ

ム識別アカウント、および casuser アカウントの詳細については、「必要なサーバ ユーザ アカウン

トについて」（P.5-1）を参照してください。

• System Identity user：システム識別ユーザとして使用するアカウントのユーザ名とパスワード。

Cisco Security Management Suite アプリケーションを複数のサーバ上にインストールする場合は、

すべてのサーバ上で同じシステム識別ユーザ アカウントを使用してください。

• Create casuser：新しいインストールで casuser アカウントを作成するかどうか。このユーザ アカ

ウントは作成する必要があります。

（注） パスワードの複雑度の制限に対するセキュリティ ポリシーがある場合、このアカウント作成は

失敗することがあります。そのような場合は、アカウントを手動で作成して、

resetcasuser.exe コマンドを実行する必要があります。詳細については、表 A-3、
「LiaisonServlet エラーの原因と対処法」 の casuser パスワードを参照してください。

ステップ 3 インストールの完了後に、サーバが自動的に再起動しない場合は、サーバを再起動します。

サーバ アプリケーションのアップグレード
アプリケーションのアップグレードとは、古いバージョンからのデータを維持しながら、新しいバー

ジョンのアプリケーションをインストールするプロセスです。3 種類のアップグレード パスがありま

す。

• ローカル：古いバージョンをアンインストールせずに、古いバージョンを実行中のサーバ上に新し

いバージョンをインストールします。既存のデータが保存され、新しくインストールされたバー

ジョンで使用できます。ローカル アップグレードを実施する場合は次の点に注意してください。

– この方式を使用する前に、アップグレードするすべてのアプリケーションが正しく機能してい

ることを確認してください。また、アップグレード対象のアプリケーションをインストールす

る前に、データベースのバックアップを実施して、正常に終了したことを確認してください。

– サーバ上のオペレーティング システムもアップグレードしている場合、たとえば、Windows 
2003 から Windows 2008 にアップグレードしている場合は、この方式が使用できません。オ

ペレーティング システムのアップグレードも行いながら Security Manager をアップグレード

している場合は、代わりに、リモート バックアップ /復元アップグレード方式を使用します。

同じ Security Manager リリースを維持しながらオペレーティング システムをアップグレード

している場合は、「新しいコンピュータまたはオペレーティング システムへの Security 
Manager の移行」（P.5-12）に記載された手順を実行します。

– データベースの移行エラーが発生した場合はエラー メッセージが表示されます。これが表示

されるのは、停止しなくてもインストールを先に進めることが可能な時点です。
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（注） ローカル アップグレード時に、インストーラによって、Performance Monitor または Resource 
Manager Essentials がインストールされているかどうかがチェックされます。いずれか 1 つ、または両

方が検出された場合、「Performance Monitor or Resource Manager Essentials (or both) needs to be 
uninstalled」というエラー メッセージを表示してインストーラが終了します。

• リモート（バックアップ /復元）：新しいバージョンをクリーン サーバ（古いアプリケーションが

インストールされていないサーバ）にインストールしてから、古いバージョンから作成したバック

アップからデータベースを復元します。新しいサーバ上にインストールする場合、または、インス

トールを実施する前にサーバをクリーンオフする（アプリケーションをアンインストールする前に

バックアップを作成する）場合に、この手順を使用します。

（注） Security Manager サーバ アプリケーションを実行しているサーバのバックアップを作成す

る前に、すべての保留データがコミットされていることを確認する必要があります。

「Security Manager の保留データが送信および承認されることの確認」（P.5-7）を参照して

ください。

• 間接：ローカルまたはリモート アップグレードでサポートされていない古いバージョンのアプリ

ケーションを使用している場合は、2 段階プロセスを実行する必要があります。ローカルまたはリ

モート アップグレードでサポートされているバージョンにアップグレードしてから、ローカルま

たはリモート アップグレードを実施します。中間のバージョンを Cisco.com からダウンロードし

ます。

使用中のバージョンが下の表に間接アップグレード用として掲載されておらず、古いデータを保存

する必要がある場合は、3 つ以上の中間アップグレード手順を実施する必要があります。たとえ

ば、Security Manager 3.0.x からアップグレードする場合は、3.2.2 にアップグレードしてから、

4.1 にアップグレードし、その後で 4.4 にアップグレードする必要があります。

表 5-1 に、アップグレード パスごとにサポートされているソフトウェアのバージョンに関する説明を

示します。

次のアップグレード パスがサポートされています。

• 4.1 > 4.4 

• 4.2 > 4.4

• 4.3 > 4.4

表 5-1 アプリケーション アップグレード パス

アップグ

レード パ
ス アプリケーション　

サポートされている

古いバージョン アップグレード手順

ローカル Security Manager 4.4 

Auto Update Server 4.4 

4.1、4.2、4.3 1. すべての保留データをコミットします。「Security 
Manager の保留データが送信および承認されることの

確認」（P.5-7）を参照してください。

2. その後で、ソフトウェアをインストールします。

「Security Manager サーバ、Common Services、および 
AUS のインストール」（P.5-2）を参照してください。

3. 最後に、アップグレード後の必要な変更を加えます。

「アップグレード後の必要な変更の実施」（P.5-12）を

参照してください。
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Security Manager の保留データが送信および承認されることの確認

Security Manager のアップグレードを成功させるためには、既存の Security Manager データベースに

保留データが含まれていないことを確認する必要があります。保留データとは、データベースに対して

コミットされていないデータのことです。保留データが残っている以前のバージョンの Security 
Manager からのデータベースは復元できません。復元できるのは、バックアップと同じバージョンを

実行しているシステム上に保留データが残っているデータベースだけです。

ユーザごとに変更を送信または破棄する必要があります。Approver でワークフロー モードを使用して

いる場合は、このような送信も承認する必要があります。すべてのデバイス設定と Security Manager 
データベースを同期させるためには、すべてのデータのコミット後に展開を実施する必要もあります。

• Workflow 以外のモードで、次の手順を実行します。

– 変更をコミットするには、[File] > [Submit] を選択します。

– コミットされていない変更を廃棄するには、[File] > [Discard] を選択します。

リモート Security Manager 4.4 

Auto Update Server 4.4 

4.1、4.2、4.3 1. すべての保留データをコミットします。「Security 
Manager の保留データが送信および承認されることの

確認」（P.5-7）を参照してください。

2. データベースをバックアップします。「リモート アップ

グレード時のデータベースのバックアップ」（P.5-8）
を参照してください。

3. アプリケーションをインストールします。次の項を参

照してください。

「Security Manager サーバ、Common Services、および 
AUS のインストール」（P.5-2）

4. 必要に応じて、データベースのバックアップをサーバ

に転送します。

5. データベースを回復します。「サーバ データベースの復

元」（P.5-11）を参照してください。

6. 最後に、アップグレード後の必要な変更を加えます。

「アップグレード後の必要な変更の実施」（P.5-12）を

参照してください。

間接 Security Manager 4.4 3.x 1. すべての保留データをコミットします。「Security 
Manager の保留データが送信および承認されることの

確認」（P.5-7）を参照してください。

2. 次に、4.1 にアップグレードしてから、4.1 のインスト

レーション ガイドのアップグレードに関する章内の

データ移行手順を忠実に実行します。

（注） まず 4.1 にアップグレードしてから、リモート アッ

プグレード パスを使用することもできます。

表 5-1 アプリケーション アップグレード パス （続き）

アップグ

レード パ
ス アプリケーション　

サポートされている

古いバージョン アップグレード手順
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– 別のユーザの変更をコミットまたは廃棄する必要がある場合は、そのユーザのセッションを引

き継ぐことができます。セッションを引き継ぐには、[Tools] > [Security Manager 
Administration] > [Take Over User Session] を選択してから、[Take Over Session] をクリック

します。

• Workflow モードで、次の手順を実行します。

– 変更をコミットして承認するには、[Tools] > [Activity Manager] を選択します。[Activity 
Manager] ウィンドウからアクティビティを選択し、[Approve] をクリックします。Activity 
Approver を使用している場合は、[Submit] をクリックして、Approver にアクティビティを承

認してもらいます。

– コミットされていない変更を破棄するには、[Tools] > [Activity Manager] を選択します。

[Activity Manager] ウィンドウで、アクティビティを選択してから、[Discard] を選択します。

廃棄できるのは、Edit または Edit Open の状態にあるアクティビティだけです。

プロパティ ファイルに対する変更の復元 
すべての Security Manager インストールにいくつかのプロパティ ファイルが含まれています。この

ファイルには、使用中に変更されたデータが保存されます。

• $NMSROOT\MDC\athena\config\csm.properties

• $NMSROOT\MDC\athena\config\DCS.properties

• $NMSROOT\MDC\athena\config\taskmgr.prop 

ヒント $NMSROOT は、Common Services インストール ディレクトリ（デフォルトは C:\Program 
Files\CSCOpx）のフル パス名です。

現在のインストールに対してサービス パックのアップグレードまたはインストールを実施した場合の 
Security Manager の動作は次のとおりです。

• アップグレードまたはサービス パックに関連する新しいファイルをインストールします。

• 新しいファイルと使用中に変更されたファイルを比較します。

• 新しいファイルと使用中に変更されたファイルが異なる場合は警告を発します。その場合は、

Security Manager が次のように処理します。

– 使用中に変更されたファイルを <filename>.org という名前で保存します。

– 参考用として、差分ファイルを <filename>.diff という名前で保存します。

新しいファイルと使用中に変更されたファイルが異なるという内容の警告を受け取った場合は、

<filename>.org と <filename>.diff 内の情報を使用して、アップグレードまたはサービス パックのイン

ストール前に、加えた変更をプロパティ ファイルに復元します。

リモート アップグレード時のデータベースのバックアップ

CiscoWorks Common Services は、データベースのバックアップと復元に使用される Common 
Services バックアップ /復元ユーティリティで、すべてのサーバ アプリケーションのデータベースを管

理します。そのため、バックアップを作成すると、サーバ上にインストールされたすべての 
CiscoWorks アプリケーションのバックアップが作成されます。
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（注） Security Manager 4.4 から、新しい属性の PURGE_DBBACKUP_LOG が backup.properties ファイル

に追加されました。デフォルト値は 20 で、20 日経過した後にバックアップを削除するという意味で

す。この新しい属性が NIL に設定されている場合、バックアップは削除されません。dbbackup.log は 
dbbackup_[YYYY-MM-DD_HH-mm-ss].log のタイムスタンプ形式で作成されます。削除設定に関係

なく、常時、dbbackup.log ファイルは少なくとも 5 個維持されます。

ヒント このバックアップ手順はデータベースのみをバックアップします。イベント データ ストアをバック

アップする必要がある場合は、「新しいコンピュータまたはオペレーティング システムへの Security 
Manager の移行」（P.5-12）に記載されているデータ ストア コピー手順を使用します。

ステップ 1 Security Manager を実行しているサーバをバックアップしている場合は、Security Manager クライア

ントの [Tools] > [Backup] というショートカットを使用してバックアップ ページを表示できます。ま

た、保留データがコミットされていることを確認します（「Security Manager の保留データが送信およ

び承認されることの確認」（P.5-7）を参照）。

Security Manager を実行していないサーバの場合は、次の手順でバックアップ ページを表示します。

a. サーバ上の Cisco Security Management Server デスクトップにログインします（「Web ブラウザを

使用したサーバ アプリケーションへのログイン」（P.6-13）を参照）。

b. [Server Administration] パネルをクリックします。次に、[Server] > [Admin] > [Backup] を選択し

ます。

ステップ 2 [Immediate for Frequency] を選択して、必要に応じて他のフィールドを設定し、[Apply] をクリックし

てデータをバックアップします。

CLI を使用したサーバ データベースのバックアップ

この項の手順では、サーバ上の Windows コマンドラインからスクリプトを実行することによって、

サーバ データベースをバックアップする方法について説明します。

データベースのバックアップ中に、Common Services と Security Manager の両方のプロセスがシャッ

トダウンされ、再起動されます。Security Manager の再起動が完了するまでには数分かかる可能性が

あるため、再起動の完了前にユーザがクライアントを起動してしまうことがあります。この場合、デバ

イス ポリシーのウィンドウに「error loading page」というメッセージが表示されることがあります。

CiscoWorks サーバ上にインストールされたすべてのアプリケーションをバックアップするのに 1 つの

バックアップ スクリプトしか使用されません。個別のアプリケーションをバックアップできません。

ヒント このバックアップ コマンドはデータベースのみをバックアップします。イベント データ ストアをバッ

クアップする必要がある場合は、「新しいコンピュータまたはオペレーティング システムへの Security 
Manager の移行」（P.5-12）に記載されているデータ ストア コピー手順を使用します。

ステップ 1 保留データがコミットされていることを確認します（「Security Manager の保留データが送信および承

認されることの確認」（P.5-7）を参照）。

ステップ 2 コマンド プロンプトで、net stop crmdmgtd と入力してすべてのプロセスを停止します。

ステップ 3 次のコマンドを入力することによって、データベースをバックアップします。
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$NMSROOT\bin\perl $NMSROOT\bin\backup.pl backup_directory [log_filename 
[email=email_address [number_of_generations [compress]]]]

引数の説明 

• $NMSROOT：Common Services インストール ディレクトリのフル パス名（デフォルトは 
C:\Program Files\CSCOpx）。

• backup_directory：バックアップを作成するディレクトリ。C:\Backups などです。

（注） バックアップに使用するために選択する場所は、NMSROOT の外にする必要があります。場所 
NMSROOT は Security Manager インストール ディレクトリへのパスです。デフォルトは 
C:\Program Files\CSCOpx です。特に、NMSROOT\backup をバックアップに使用しないよ

うに注意してください。

• log_filename：（任意）バックアップ中に生成されるメッセージ用のログ ファイル。現在のディレ

クトリ以外の場所にバックアップを作成する場合は、そのパスを追加します。C:\BackupLogs な
どです。名前を指定しなかった場合は、$NMSROOT\log\dbbackup.log になります。

• email=email_address：（任意）通知を送信する電子メール アドレス。電子メール アドレスは指定

しないが、後続のパラメータは指定する必要がある場合は、サイズまたはアドレスが一致しない 
email を入力します。CiscoWorks Common Services で SMTP を設定して、通知をイネーブルにす

る必要があります。

• number_of_generations：（任意）バックアップ ディレクトリに保存しておくバックアップの最大

世代数。最大数に達すると、古いバックアップが削除されます。デフォルトは 0 で、保存される世

代数に制限はありません。

• compress：（任意）バックアップ ファイルを圧縮するかどうか。このキーワードを入力しないと、

backup.properties ファイル内に VMS_FILEBACKUP_COMPRESS=NO が指定されている場合、

バックアップは圧縮されません。指定されていない場合は、このキーワードを入力しなくてもバッ

クアップは圧縮されます。バックアップは圧縮することを推奨します。

たとえば、次に示されているコマンドは、perl コマンドと backup.pl コマンドが存在するディレクトリ

で発行することを想定しています。（ただし、該当ディレクトリの場合でも、DOS 8.1 形式（スペース

なし）の完全修飾された、perl と backup.pl の完全なパスを指定する必要があります）。

次に示されているコマンドでは、バックアップ ディレクトリ内に圧縮されたバックアップおよびログ 
ファイルが作成され、admin@domain.com に通知が送信されます。

backup.pl コマンドを使用する場合、圧縮パラメータを含めるにはバックアップ世代を指定する必要が

あります。

ログ ファイル パラメータの後ろにパラメータを指定する場合は、先行するすべてのパラメータの値を

含める必要があります。

次の例では、$NMSROOT は D:\CSM であり、デフォルト値の C:\Program Files\CSCOpx ではありま

せん。

D:\CSM\bin\perl D:\CSM\bin\backup.pl C:\backups C:\backups\backup.log 
email=admin@domain.com 0 compress 

ステップ 4 ログ ファイルを調査して、データベースがバックアップされていることを確認します。

ステップ 5 コマンド プロンプトで、net start crmdmgtd と入力して、すべてのプロセスを再起動します。
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サーバ データベースの復元

コマンドラインからスクリプトを実行することにより、データベースを復元できます。データの復元中

に、CiscoWorks をシャットダウンしてから再起動する必要があります。ここでは、サーバ上のバック

アップ データベースを復元する方法について説明します。バックアップおよび復元のための機能は 1 
つだけであり、CiscoWorks サーバにインストールされているすべてのアプリケーションをバックアッ

プおよび復元できます。個々のアプリケーションをバックアップまたは復元することはできません。

複数のサーバにアプリケーションをインストールした場合は、インストールされているアプリケーショ

ンに適したデータが含まれるデータベース バックアップを復元する必要があります。

ヒント

• 以前のリリースのアプリケーションから作成したバックアップは、このバージョンのアプリケー

ションへのダイレクト ローカル インライン アップグレードがサポートされているバージョンから

のバックアップであれば、復元できます。アップグレードに対応したバージョンの詳細について

は、「サーバ アプリケーションのアップグレード」（P.5-5）を参照してください。

• restore コマンドは、データベースのみを復元します。イベント データ ストアを復元する必要があ

る場合は、「新しいコンピュータまたはオペレーティング システムへの Security Manager の移行」

（P.5-12）に記載されているデータ ストア コピー手順を使用します。

手順

ステップ 1 コマンドラインで次のように入力して、すべてのプロセスを停止します。

net stop crmdmgtd 

ステップ 2 次のコマンドを入力することによって、データベースを復元します。

$NMSROOT\bin\perl $NMSROOT\bin\restorebackup.pl [-t temporary_directory]
[-gen generationNumber] -d backup_directory [-h]

引数の説明 

• $NMSROOT：Common Services インストール ディレクトリのフル パス名（デフォルトは 
C:\Program Files\CSCOpx）。

• -t temporary_directory：（任意）復元プログラムで一時ファイルを保存するために使用されるディ

レクトリまたはフォルダ。デフォルトでは、このディレクトリは $NMSROOT\tempBackupData で
す。

• -gen generationNumber：（任意）復元するバックアップ世代番号。デフォルトでは、最新の世代で

す。第 1 ～ 5 世代が存在する場合は、第 5 世代が最新です。

• -d backup_directory：復元するバックアップが保存されたバックアップ ディレクトリ。

• -h：（任意）ヘルプを表示します。-d BackupDirectory を使用した場合は、ヘルプに正しい構文と

使用可能なスイートおよび世代が表示されます。

たとえば、c:\var\backup ディレクトリから最新のバージョンを復元する場合は、次のコマンドを入力

します（これは 64 ビット OS の場合です）。

C:\Progra~2\CSCOpx\bin\perl C:\Progra~2\CSCOpx\bin\restorebackup.pl -d C:\var\backup 

ステップ 3 ログ ファイル NMSROOT\log\restorebackup.log を調べて、データベースが復元されたことを確認し

ます。

ステップ 4 次のように入力して、システムを再起動します。

net start crmdmgtd 
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ステップ 5 Security Manager サービス パックのインストール前にバックアップされたデータベースを復元する場

合は、データベースの復元後にサービス パックを再適用する必要があります。

アップグレード後の必要な変更の実施

アプリケーションをアップグレードすると、特定の情報の処理方法が変わって、手動で変更しなければ

ならなくなる場合があります。このバージョンの製品にアップグレードしたら、下の必要な変更リスト

を参照して、状況に合わせて変更を適用する必要があります。

• 3.3.1 より以前のバージョンからアップグレードする場合は、4 ポート Gigabit Ethernet Fiber イン

ターフェイス カード（ハードウェア タイプ：i82571EB 4F）が実装された ASA 5580 デバイス上

でインベントリを再検出する必要があります。インベントリの再検出によって、デバイス上での速

度非ネゴシエート設定を変更できない以前のリリースからのバグが解決されます。インベントリを

再検出するには、Security Manager クライアントのデバイス ビューでデバイスを右クリックして、

[Discover Policies on Device] を選択してから、[Policies to Discover] グループ内の [Live Device 
discovery and only the Inventory] チェックボックスをオンにします。再検出によって、デバイスに

関するインターフェイス ポリシーが置き換えられます。

• 3.3.1 以前のバージョンからアップグレードしており、未サポートの共有ポート アダプタ（SPA）

を使用する Cisco ASR 1000 シリーズ アグリゲーション サービス ルータを管理している場合は、

Security Manager で、サポートされているバージョン 4.0 以降の SPA が検出できるように、デバ

イスに関するポリシーを再検出する必要があります。新しくサポートされる SPA には、すべての

イーサネット（すべての速度）、シリアル、ATM、および Packet over Sonet（POS）SPA が含まれ

ますが、サービス SPA は含まれません。デバイス CLI で ATM、PVC、またはダイヤラ関連ポリ

シーを設定した場合は、再検出が必要です。

新しいコンピュータまたはオペレーティング システムへの 
Security Manager の移行

Security Manager を新しいサーバに移行しなければならない場合があります。この移行を新しい物理

コンピュータに対して行う場合と、サーバ上のオペレーティング システムにメジャー アップグレード

を施す場合（Windows 2003 から Windows 2008 に移行する場合など）があります。

Security Manager のバージョンは変更しないが、物理ハードウェアまたはオペレーティング システム

を変更する場合は、移行プロセスを通過する必要があります。この移行プロセスは、基本的に、「サー

バ アプリケーションのアップグレード」（P.5-5）に記載されているリモート バックアップ /復元アップ

グレード プロセスと同じものですが、Event Manager データ ストアに保存されたデータを移行する場

合は追加のステップが必要です。Security Manager サーバの移行を実施する場合は、この手順を使用

します。

（注） オペレーティング システムに対するマイナー サービス パック アップデートは、それが Security 
Manager サーバ移行要件になるまで、アップグレードとは見なされません。サーバ移行は、オペレー

ティング システムの正式名称が変更される場合のように、異なるメジャー バージョンのオペレーティ

ング システム同士を移行する場合に必要になります。
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はじめる前に

この手順では、ターゲット サーバ（Security Manager を移行するサーバ）にソース コンピュータと同

じデータベースとイベント データ ストアの内容を保存するものとします。ターゲット サーバ上で 
Security Manager の使用を開始している場合は、ソース システムとターゲット システムのデータベー

スまたはイベント データ ストアをマージできません。ターゲット データをソース データで置き換える

必要があります。移行前にターゲット システム上に存在していたすべてのデータが、移行完了後に使

用できなくなります。古いターゲット システム データを新しく移行するフォルダにコピーしないでく

ださい。

また、イベント データ ストアのコピーおよび復元ステップは、そのデータを保存する場合にのみ必要

なことに注意してください。新しい空のイベント データ ストアから始める場合は、このステップを省

略できます。

ステップ 1 ソース Security Manager サーバ（移行元のサーバ）上で次の手順を実行します。

a. イベント データ ストア フォルダの名前を特定します。Security Manager クライアントで、[Tools] 
> [Security Manager Administration] を選択し、コンテンツ テーブルから [Event Management] を
選択します。フォルダは、[Event Data Store Location] フィールドに表示されています。デフォル

トは NMSROOT\MDC\eventing\database で、NMSROOT はインストール ディレクトリ（通常は 
C:\Program Files\CSCOpx）です。

b. コマンドラインで次のように入力して、すべてのプロセスを停止します。

net stop crmdmgtd 

c. NMSROOT\MDC\eventing\config\collector.properties ファイルのコピーとイベント データ スト

ア フォルダを作成します。そのコピーをターゲット コンピュータからアクセス可能なディスクに

配置します。

d. 「CLI を使用したサーバ データベースのバックアップ」（P.5-9）に記載されているコマンドライン

方式を使用して、Security Manager データベースをバックアップします。

ステップ 2 新しいターゲット コンピュータを準備します。例：

• オペレーティング システムをアップグレードするだけで、新しいハードウェアに移行しない場合

は、オペレーティング システム アップグレードを実施して、オペレーティング システムが正しく

機能していることを確認します。その後で、Security Manager をインストールします。

• 新しいコンピュータに移行する場合は、そのコンピュータが正しく機能していることを確認して、

Security Manager をインストールします。

ステップ 3 ターゲット Security Manager サーバ上で次の手順を実行します。

a. コマンドラインで次のように入力して、すべてのプロセスを停止します。

net stop crmdmgtd 

b. 「サーバ データベースの復元」（P.5-11）に記載されている手順を使用して、データベースを復元し

ます。

c. データベース復元の完了後にプロセスを再起動しなかった場合は、ここで再起動します。

net start crmdmgtd 

d. Security Manager クライアントを使用して新しいサーバにログインしてから、[Tools] > [Security 
Manager Administration] を選択して、目次から [Event Management] を選択します。

e. イベント データ ストア フォルダが存在し、それが空であることを確認します（必要に応じてファ

イルを削除します）。このフォルダには、ソース サーバ上のイベント データ ストアと同じ名前と

場所を設定する必要があります。
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f. 正しい [Event Data Store Location]（デフォルトが正しいフォルダでない場合）を選択して、

[Enable Event Management] チェックボックスをオフにし、Event Manager サービスを停止しま

す。[Save] をクリックして変更を保存します。サービスを停止するかどうかの確認が要求されま

す。[Yes] をクリックしてサービスの停止が通知されるまで待ちます。

g. バックアップされたイベント データ ストアをソース コンピュータからターゲット サーバ上の新し

い場所にコピーします。

h. バックアップされた NMSROOT\MDC\eventing\config\collector.properties ファイルをソース コ
ンピュータからターゲット コンピュータにコピーして、ターゲット サーバ上のファイルを上書き

します。

i. Security Manager クライアントで、[Tools] > [Security Manager Administration] を選択し、コンテ

ンツ テーブルから [Event Management] を選択します。[Enable Event Management] チェックボッ

クスをオンにして、[Save] をクリックします。サービスを開始するかどうかの確認が要求されま

す。[Yes] をクリックしてサービスの開始が通知されるまで待ちます。

Security Manager の更新
インストール時に永久ライセンス ファイルを指定できますが、Security Manager のインストール後に

もライセンスを追加できます。AUS にはライセンスは不要です。

はじめる前に

ライセンス ファイルをサーバ マシンまたはクライアント マシンにコピーしてから、ライセンスをアプ

リケーションに追加します。クライアント マシンを使用する場合は、クライアント側のブラウザをイ

ネーブルにする必要があります。

（注） ライセンス ファイルのパスには、アンパサンド（&）などの特殊文字が含まれていてはなりません。

ヒント Security Manager にログインする際にライセンスを適用することもできます。Security Manager から

「Upgrade license」または「Continue Evaluation」というメッセージが表示されます。[Upgrade 
License] をクリックすることで、ライセンスを適用できます。

手順

Security Manager のライセンスをインストールするには、次の手順を実行します。

ステップ 1 Security Manager クライアント アプリケーションを使用してサーバにログインします（「Security 
Manager クライアントを使用した Security Manager へのログイン」（P.6-12）を参照）。

ステップ 2 [Tools] > [Security Manager Administration] を選択し、コンテンツ テーブルから [Licensing] を選択し

ます。

ステップ 3 タブがアクティブになっていない場合は、[CSM] をクリックします。

ステップ 4 [Install a License] をクリックして、[Install a License] ダイアログボックスを開きます。このダイアロ

グボックスを使用して、ライセンス ファイルを選択し、[OK] をクリックします。このプロセスを繰り

返して他のライセンスを追加します。
5-14
Cisco Security Manager 4.4 インストレーション ガイド 

OL-28767-01-J



 

第 5 章      サーバ アプリケーションのインストールとアップグレード

    サービス パックとポイント パッチの入手
（注） パスとファイル名は、英語のアルファベット文字に制限されます。日本語文字はサポートされ

ません。Windows 日本語 OS システムでファイルを選択する場合は、通常のファイル区切り文

字 \ がサポートされますが、これは円記号（U+00A5）として表示されることがあることに注

意する必要があります。

サービス パックとポイント パッチの入手

注意 Security Manager のサービス パックまたはポイント パッチは、シスコから入手してください。そ

れ以外のファイルをダウンロードしたり、開いたりしないでください。サードパーティ製のサービ

ス パックとポイント パッチはサポートされていません。

Security Manager またはその他のアプリケーションをインストールしたら、シスコから入手したサー

ビス パックまたはポイント パッチをインストールして、バグを修復したり、新しいデバイス タイプを

サポートしたり、アプリケーションを強化したりできます。

• 新しいサービス パックの入手可能な時期を知って、必要なサービス パックをダウンロードするに

は、Security Manager を開いて、[Help] > [Security Manager Online] を選択します。または、

http://www.cisco.com/go/csmanager にアクセスします。

• 企業から Cisco TAC サービス リクエストが提出されると、TAC が、その問題の解決に役立つ未公

開のポイント パッチがあるかどうかを通知します。これ以外の方法で Security Manager ポイント 
パッチが配布されることはありません。

サービス パックとポイント パッチは、クライアント ソフトウェア アップデートにサーバ サポートを

提供し、クライアントとサーバ間のバージョン レベルのミスマッチを検出します。

サーバ アプリケーションのアンインストール
サーバ アプリケーションをアンインストールするには、この手順を使用します。アプリケーションを

アンインストールする前に、アプリケーションの再インストールが必要な場合にデータを復元できるよ

うにバックアップの実施を検討してください。バックアップの実施方法については、「リモート アップ

グレード時のデータベースのバックアップ」（P.5-8）を参照してください。

はじめる前に

任意のバージョンの Windows Defender がインストールされている場合は、それをディセーブルにして

からサーバ アプリケーションをアンインストールします。そうしなければ、アンインストール アプリ

ケーションを起動できません。

手順

サーバ アプリケーションをアンインストールするには、次の手順を実行します。

ステップ 1 [Start] > [Programs] > [Cisco Security Manager] > [Uninstall Cisco Security Manager] を選択します。

デフォルトでは、すべてのアプリケーションがアンインストールされます。

ステップ 2 アンインストーラによって、すべてのアプリケーションが削除されます。
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（注） アンインストール中にエラーが発生した場合は、「アンインストール中のサーバ障害」

（P.A-8）、および次の URL にある『Installing and Getting Started With CiscoWorks LAN 
Management Solution 3.1』の「Troubleshooting and FAQs」の章を参照してください。
http://www.cisco.com/en/US/products/sw/cscowork/ps3996/prod_installation_guides_list.
html

ステップ 3 リブートは必須ではありませんが、アンインストール後はサーバをリブートして、サーバ上のレジスト

リ エントリと実行中のプロセスが将来の再インストールに適切な状態になるようにすることを推奨し

ます。

ステップ 4 Common Services を含むすべての Cisco Security Management Suite アプリケーションをアンインス

トールする場合のみ：

a. NMSROOT が残っている場合は、それを削除、移動、または名前を変更します。NMSROOT は 
Security Manager インストール ディレクトリへのパスです。NMSROOT のデフォルト値は 
C:\Program Files\CSCOpx です。E:\Program Files\CSCOpx などのその他の値も使用できます。

b. C:\CMFLOCK.TXT ファイルが存在する場合は、それを削除します。

c. アプリケーションを再インストールする前に、レジストリ エディタを使用して、次のレジストリ 
エントリを削除します。

• My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Cisco\Resource Manager

• My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Cisco\MDC

ステップ 5 アプリケーションをアンインストールする前に Windows Defender をディセーブルにした場合は、ここ

で、もう一度イネーブルにします。

サーバ アプリケーションのダウングレード
Security Manager アプリケーションを以前のリリースにダウングレードして、この製品リリースで作

成した設定を保持することはできません。このリリースの Security Manager を使用しない場合は、こ

れをアンインストールし、必要な古いバージョンの製品を再インストールします （これは、必要なラ

イセンスと古いバージョンのインストール メディアがそろっていることが前提です）。その後で、

「サーバ データベースの復元」（P.5-11）に記載されているように、ダウングレードされたバージョンの

以前のインストールで保存した必要なデータベースのバックアップを復元できます。

Security Manager をダウングレードする場合は、Auto Update Server も、再インストールする Security 
Manager のバージョンでサポートされるバージョンにダウングレードする必要があります。

古いデータベースを復元した場合、管理対象デバイスの現在の状態と同期しなくなったデバイスのプロ

パティやポリシーが含まれる可能性があることに注意してください。たとえば、デバイス上のオペレー

ティング システムを、古いバージョンの Security Manager では直接サポートされないものにアップグ

レードしたり、古いバージョンには存在しないポリシーを設定し、展開したりした可能性があります。

データベースとデバイスを正しく同期させるために、すべての管理対象デバイスのデバイス ポリシー

を再検出することを検討してください。大幅な変更（オペレーティング システムのメジャー リリース

のアップグレードなど）では、デバイスをインベントリから削除し、再度追加しなければならない場合

があることに注意してください。一部の例では、オペレーティング システムのアップグレードを元に

戻す必要がある場合もあります（たとえば、ASA ソフトウェア リリース 8.3 は特別な処理が必要で、

下位互換モードではサポートできないため、使用する Security Manager のバージョンで直接サポート

されている必要があります）。詳細については、『User Guide for Cisco Security Manager』の

「Managing the Device Inventory」の章を参照してください。
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ヒント 古いバージョンの Security Manager では管理できないデバイスとオペレーティング システム リリース

の組み合わせを管理しようとした場合、展開エラーが発生します。
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クライアントのインストールと設定

Security Manager アプリケーションと一緒に使用する重要なクライアント アプリケーションが 2 つあ

ります。

• Security Manager クライアント。これは、ワークステーション上にインストールされ、通常は別の

サーバ上にインストールされている Security Manager サーバ上で動作しているデータベースと相

互作用するクライアント /サーバ アプリケーションです。このクライアントは一部の機能で Web 
ブラウザも使用します。

• Web ブラウザ。AUS を使用したり、Security Manager サーバや Common Services を使用する他の

サーバを設定したりするために Web ブラウザを使用します。

次のトピックで、クライアントを実行するブラウザの設定方法と、Security Manager クライアントの

インストール方法について説明します。

• 「Web ブラウザ クライアントの設定」（P.6-1）

• 「Security Manager クライアントのインストールに関するヒント」（P.6-6）

• 「Security Manager クライアントのインストール」（P.6-6）

• 「アプリケーションへのログイン」（P.6-11）

• 「Security Manager クライアントのアンインストール」（P.6-14）

Web ブラウザ クライアントの設定
Web ブラウザが、特定の種類のコンテンツを許可し、アプリケーションを実行しているサーバからの

ポップアップ ウィンドウをブロックしないように設定されていることを確認する必要があります。

Web ブラウザは、オンライン ヘルプだけでなく、機能的なアプリケーション ウィンドウを表示するた

めに使用されます。次の項で、ブラウザをアプリケーション クライアントとして効率的に使用するた

めに必要な設定方法について説明します。

• 「HTTP/HTTPS プロキシ例外」（P.6-1）

• 「Internet Explorer の設定」（P.6-2）

• 「Firefox の設定」（P.6-3）

• 「サードパーティ製ツールでの例外のイネーブル化と設定」（P.6-5）

HTTP/HTTPS プロキシ例外

HTTP/HTTPS プロキシを使用する場合は、Security Manager サーバ用のプロキシ例外を設定する必要

があります。
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この要件は、Internet Explorer と Firefox に適用されます。それぞれに対する追加設定の詳細を以降に

説明します。

Internet Explorer の設定

Security Manager とそのアプリケーションを正しく機能させるために必要な Internet Explorer の設定が

いくつかあります。Internet Explorer は、オンライン ヘルプ、アクティビティ レポート、CS-MARS 
ルックアップ情報などの表示に使用されます。この手順では、Internet Explorer に必要な設定について

説明します。

手順

ステップ 1 Internet Explorer 8 を使用している場合は、互換表示を使用します。Internet Explorer 8 は、互換表示

の場合にのみサポートされています。互換表示を使用するには、Internet Explorer 8 を開いて、[Tools] 
> [Compatibility View Settings] に移動し、[website to be displayed in Compatibility View] として 
Security Manager サーバを追加します。

ステップ 2 次の手順を実行して、Security Manager のポップアップ ブロックをオフにします。

a. Internet Explorer を開きます。

b. [Tools] > [Pop-up Blocker] > [Pop-up Blocker Settings] に移動します。

c. [Address of website to allow] フィールドに、Security Manager サーバの IP アドレスを入力して、

[Add] をクリックします。
http://windows.microsoft.com/en-US/windows-vista/Internet-Explorer-Pop-up-Blocker-frequently-
asked-questions を参照してください。

注意 ポップアップ ブロックをオフにしなかった場合は、Security Manager でデバイスを検出できない可

能性があります。

ヒント 「ポップアップ ブロックは、ポップアップの大半を制限またはブロックする Internet Explorer の機能で

す。」
http://windows.microsoft.com/en-US/windows-vista/Internet-Explorer-Pop-up-Blocker-frequently-aske
d-questions を参照してください。

ステップ 3 Internet Explorer で、[Tools] > [Internet Options] を選択します。この手順内の以降のステップは、

[Internet Options] ダイアログボックス上で実行します。

ステップ 4 アクティブ コンテンツを許可するには、次の手順を実行します。

a. [Advanced] タブをクリックして、[Security] セクションにスクロールし、[Allow active content to 
run in files on My Computer] を選択します。

b. [Apply] をクリックして変更内容を保存します。

ステップ 5 ブラウザのセキュリティ設定が、暗号化されたページをディスクに保存できるようになっていることを

確認します。暗号化されたページを保存できない場合は、クライアント ソフトウェア インストーラを

ダウンロードできません。

[Advanced] タブの [Security] エリアで、[Do not save encrypted Pages to Disk] を選択解除します。設

定を変更する必要がある場合は、[Apply] をクリックして変更を保存します。
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ステップ 6 一時ファイル用のディスク キャッシュのサイズが、ダウンロードを予定しているクライアント ソフト

ウェア インストーラのサイズを上回っていることを確認します。キャッシュ割り当てが少なすぎる場

合は、インストーラをダウンロードできません。キャッシュ サイズを変更するには、次の手順を実行し

ます。

a. [General] タブをクリックします。

b. [Temporary Internet Files] グループで [Settings] をクリックします。

c. 必要に応じて、インターネット一時ファイルに使用されるディスク スペースの容量を増やして 
[OK] をクリックします。

d. [Apply] をクリックして変更内容を保存します。

ステップ 7 （任意）CS-MARS と Security Manager 間でデータをやり取りするときに、セキュア コンテンツとノン

セキュア コンテンツの両方が含まれたページを開かなければならないことがあります。デフォルトで、

Internet Explorer からノンセキュア項目を表示するかどうかが尋ねられます。このプロンプトで [Yes] 
をクリックすると、ソフトウェアを正常に機能させることができます。

必要な場合は、プロンプトが表示されず、混合コンテンツ、つまり、セキュア コンテンツとノンセ

キュア コンテンツの両方が含まれるページが自動的に表示されるように Internet Explorer の設定を変

更できます。混合コンテンツ ページを表示するように Internet Explorer を設定するには、次の手順を

実行します。

a. [Security] タブをクリックします。

b. ダイアログボックス下部の [Custom Level] をクリックします。

c. [Miscellaneous] 見出しの下で、[Display mixed content] 設定に対応する [Enable] オプション ボタ

ンを選択します。（[Disable] が選択されていないことを確認してください）。

d. [Apply] をクリックして変更内容を保存します。

ステップ 8 [OK] をクリックして [Internet Options] ダイアログボックスを閉じます。

Firefox の設定

Security Manager とそのアプリケーションを正しく機能させるために必要な Firefox の設定がいくつか

あります。Firefox は、オンライン ヘルプ、アクティビティ レポート、CS-MARS ルックアップ情報な

どの機能の表示に使用します。この手順では、Firefox の設定に必要なオプションについて説明します。

• 「プリファレンス ファイルの編集」（P.6-3）

• 「ディスク キャッシュのサイズの編集」（P.6-4）

• 「ポップアップ ブロックのディセーブル化またはホワイト リストの作成」（P.6-4）

• 「JavaScript のイネーブル化」（P.6-5）

• 「最新ウィンドウ内の新しいタブ上でのオンライン ヘルプの表示と以降の要求に対する既存のウィ

ンドウの再利用」（P.6-5）

プリファレンス ファイルの編集

手順

プリファレンス ファイルを編集するには、次の手順を実行します。
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ステップ 1 メモ帳などのテキスト エディタで、\Mozilla Firefox\defaults\pref サブディレクトリにある firefox.js 
を開きます。

ステップ 2 次の式を追加します。
pref("dom.allow_scripts_to_close_windows", true);

ステップ 3 編集したファイルを保存して閉じます。

ディスク キャッシュのサイズの編集

一時ファイル用のディスク キャッシュのサイズが、ダウンロードを予定しているクライアント ソフト

ウェア インストーラのサイズを上回っていることを確認します。キャッシュ割り当てが少なすぎる場

合は、インストーラをダウンロードできません。

手順

キャッシュ サイズを変更するには、次の手順を実行します。

ステップ 1 [Tools] > [Options] を選択してから、[Advanced] をクリックします。

ステップ 2 設定が少なすぎる場合は、より多くのキャッシュ スペースを確保して、[OK] をクリックします。

ポップアップ ブロックのディセーブル化またはホワイト リストの作成

手順

ポップアップ ブロックをディセーブルにするには、次の手順を実行します。

ステップ 1 [Tools] > [Options] を選択してから、[Contents] アイコンをクリックします。

ステップ 2 [Block pop-up windows] チェックボックスをオフにします。

または、ポップアップを受け入れる信頼できるソースのホワイト リストを作成するには、[Block 
pop-up windows] チェックボックスをオンにしてから、[Exceptions] をクリックして [Allowed Sites - 
Popups] ダイアログボックスで次の手順を実行します。

a. [Address of web site] フィールドに http://<SERVER_NAME>（ここで、SERVER_NAME は 
Security Manager サーバの IP アドレスまたは DNS ルーティング可能名）と入力してから、

[Allow] をクリックします。

b. file:///C:/Documents%20and%20Settings/<USER_NAME>/Local%20Settings/Temp/（ここで、

C: は Windows がインストールされているクライアント システムのディスク ドライブで、

USER_NAME はクライアント システム上の Windows ユーザ名）と入力してから、[Allow] をク

リックします。

c. [Close] をクリックします。

ステップ 3 [OK] をクリックします。
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JavaScript のイネーブル化

手順

JavaScript をイネーブルにするには、次の手順を実行します。

ステップ 1 [Tools] > [Options] を選択してから、[Contents] アイコンをクリックします。

ステップ 2 [Enable JavaScript] チェックボックスをオンにします。

ステップ 3 [Advanced] をクリックし、[Advanced JavaScript Settings] ダイアログボックスで、[Allow scripts to] 
エリア内のすべてのチェックボックスをオンにします。

ステップ 4 [OK] をクリックします。

最新ウィンドウ内の新しいタブ上でのオンライン ヘルプの表示と以降の要求に対する既存の
ウィンドウの再利用

初めてオンライン ヘルプにアクセスしたときに、2 つの新しいブラウザ ウィンドウ（空のページとヘ

ルプ コンテンツが含まれるページ）が開くことがあります。その後、オンライン ヘルプにアクセスし

ようとしたときに、既存のブラウザ ウィンドウが再利用されないこともあります。

手順

最近開かれたブラウザ ウィンドウの新しいタブ上にオンライン ヘルプを表示し、それ以降は既存のブ

ラウザ ウィンドウを再利用するように Firefox を設定するには、次の手順を実行します。

ステップ 1 アドレス バーに、about:config と入力して、Enter を押します。ユーザ プリファレンスのリストが表

示されます。

ステップ 2 [browser.link.open_external] をダブルクリックして、表示されたダイアログボックスに 3 と入力しま

す。この値は、外部アプリケーションからのリンクが、最後に開かれたブラウザ ウィンドウ内の新し

いタブで開かれることを意味します。

ステップ 3 [browser.link.open_newwindow] をダブルクリックして、それを 1 に設定します。この値は、リンクが

アクティブなタブまたはウィンドウで開かれることを意味します。

ステップ 4 [browser.link.open_newwindow.restriction] をダブルクリックして、それを 0 に設定します。この値

は、新しいウィンドウのすべてがタブとして開かれることを意味します。

ステップ 5 [about:config] ページを閉じます。

（注） ブラウザのステータス バーに Done というステータスが表示された後でも、状況依存のヘルプ

を開いたときに空白のページが開く場合があります。この問題が発生した場合は、数分待て

ば、コンテンツがダウンロード可能になり、表示されます。

サードパーティ製ツールでの例外のイネーブル化と設定

一部のサードパーティ製ポップアップ ブロックを使用すれば、通常はポップアップを拒否しながら、

特定のサイトまたはサーバからのポップアップだけを許可できます。ポップアップ ブロックでホワイ

ト リストに例外を含めることができない場合、または、そのオプションでは要件が満たせない場合は、
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すべてのポップアップを許可するようにユーティリティを設定する必要があります。信用されたサイト

からのポップアップを許可する方式は、使用されているユーティリティによって異なります。詳細につ

いては、サードパーティ製品のマニュアルを参照してください。

Security Manager クライアントのインストールに関するヒ
ント

Security Manager クライアントを使用してデバイスを設定します。クライアントで変更を保存すると、

それらはワークステーションに保存されます。続いて、変更をデータベースに送信して、サーバ上の

データベースを更新する必要があります。

クライアントを使用している間は、クライアントとサーバ間で継続的に相互通信が行われます。この点

を踏まえて、クライアントをインストールしてそのパフォーマンスを向上させるためのヒントを考慮し

てください。

• サーバと同じコンピュータ上でクライアントを日常業務として実行しないでください。クライアン

トをサーバ上にインストールした場合は、トラブルシューティングの目的にのみ使用してくださ

い。

• ネットワーク遅延の問題を避けるために、クライアントはサーバからあまり離れていないワークス

テーション上にインストールします。たとえば、米国にサーバを設置しながら、インド国内のネッ

トワークからクライアントを実行した場合は、遅延が生じて応答性能が低下する可能性がありま

す。この問題を軽減するには、クライアントがサーバと同じデータセンター内に設置される、リ

モート デスクトップまたはターミナル サーバ配置を採用する必要があります。

• 1 台のコンピュータ上には 1 つのクライアントのコピーしかインストールできません。クライアン

トとサーバのバージョンは完全に一致する必要があります。したがって、2 つの異なるバージョン

の Security Manager 製品を実行する場合は、それぞれのクライアントを実行する 2 台のワークス

テーションを用意する必要があります。

一方で、クライアントを複数回起動して、同じバージョンを実行している複数の Security Manager 
サーバに接続できます。

Security Manager クライアントのインストール
Security Manager クライアントは、ワークステーション上にインストールする個別のプログラムです。

このクライアントを使用して、Security Manager サーバにログインして、デバイスに関するセキュリ

ティ ポリシーを設定します。Security Manager クライアントは、製品と一緒に使用するメイン アプリ

ケーションです。

サーバ ソフトウェアがインストールされていれば、Security Manager サーバ上にクライアントがイン

ストールされている可能性があります。ただし、サーバと同じシステム上でクライアントを使用する場

合は、製品の日常的な使用を避けることを推奨します。代わりに、次の手順を使用して、クライアント

を別のワークステーションにインストールしてください。ワークステーション システムの要件とサ

ポートされているブラウザのバージョンについては、「クライアントの要件」（P.3-8）を参照してくだ

さい。

インストール中に問題が発生した場合は、次のトピックを参照してください。

• 「インストールを阻止するセキュリティ設定の処理」（P.6-9）

• 「以前のバージョンのクライアントからアップグレードできない」（P.6-10）

• 「インストール中のクライアント障害」（P.A-10）
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はじめる前に

• ブラウザが正しく設定されていることを確認します。「Web ブラウザ クライアントの設定」

（P.6-1）を参照してください。

• Windows ファイアウォールが正しく設定されていることを確認します。Security Manager でサ

ポートされるオペレーティング システムでは、Windows ファイアウォールはデフォルトでイネー

ブルになっています。その結果、HTTP、HTTPS、および syslog の着信接続がブロックされます。

たとえば、管理者はサーバの Security Manager クライアントのインストール URL にローカルでア

クセスできますが、リモート ワークステーションからはアクセスできません。また、syslog デー

タは Event Viewer に表示されません。Windows ファイアウォールをディセーブルにするか、問題

になっている管理トラフィックを許可する着信ルールを設定する必要があります。

注意 ワークステーションの Windows ファイアウォールをディセーブルにすると、Windows ファ

イアウォールのイネーブル時に防御されていた悪意のあるアクティビティに対して無防備に

なります。

• クライアント ソフトウェア インストーラをダウンロードする前に、クライアント システム上の 
Temp ファイルを手動で削除することを推奨します。このようなファイルを削除することによっ

て、使用可能な十分なスペースを確保できる可能性があります。

• ワークステーションに Cisco Security Agent がインストールされている場合は、クライアントのイ

ンストール プロセスの前または中に、それをディセーブルにする必要があります。インストール 
プロセス中にクライアント インストーラが Cisco Security Agent をディセーブルできなかった場合

は、プロセスが中断して、クライアントのインストールを再開する前に、Cisco Security Agent を
手動でディセーブルにするように要求されます。

ヒント ワークステーション上の Cisco Security Agent をディセーブルにするには、次の 2 つの方法の

いずれかを使用します：（1）システム トレイ内の Cisco Security Agent アイコンを右クリック

し、[Security Level] > [Off] を選択するか、（2）[Services] を開き（[Control Panel] > 
[Administrative Tools] > [Services]）、[Cisco Security Agent] を右クリックし、[Stop] をクリッ

クします。2 つのどちらの方法の場合でも、Windows のバージョンによっては、次の手順を実

行する必要があります。[Services] を開き、[Cisco Security Agent Monitor] をクリックして 
[Stop] をクリックします。クライアントのインストール終了後、Cisco Security Agent を再起

動します。

注意 ワークステーション上で Cisco Security Agent がディセーブルになっている間は、Cisco Security 
Agent のイネーブル時に防御されていた悪意のあるアクティビティに対して無防備になります。

• すでに Security Manager クライアントがワークステーション上にインストールされている場合は、

インストール プログラムが最新のクライアントをインストールする前に Security Manager クライ

アントをアンインストールする必要があります。ウィザードからこの必要があるかどうかが尋ねら

れます。
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手順

ステップ 1 Windows 管理者特権を持つユーザ アカウントを使用してクライアント ワークステーションにログイン

します。

ステップ 2 Web ブラウザで、次の URL のいずれかを開きます。ここで、SecManServer は、Security Manager が
インストールされているコンピュータの名前です。いずれかのセキュリティ アラート ウィンドウで 
[Yes] をクリックします。

• SSL を使用していない場合は、http://SecManServer:1741 を開きます。

• SSL を使用している場合は、http://SecManServer:443 を開きます。

Cisco Security Management Suite のログイン画面が表示されます。ページ上で、JavaScript と cookie 
がイネーブルになっていることと、サポートされているバージョンの Web ブラウザを実行しているこ

とを確認します。

ステップ 3 ユーザ名とパスワードを使用して、Cisco Security Management Suite サーバにログインします。初め

てサーバをインストールする場合は、ユーザ名の admin と製品のインストール中に定義されたパス

ワードを使用してログインできます。

ステップ 4 Cisco Security Management Suite のホームページで、[Cisco Security Manager Client Installer] をク

リックします。

ファイルを開くまたは実行するのか、ディスクに保存するのかが尋ねられます。いずれかのオプション

を選択できます。ファイルのディスクへの保存を選択した場合は、ファイルのダウンロード後にプログ

ラムを実行します（ファイルをダブルクリックするか、ブラウザから尋ねられたときに [Run] オプショ

ンを選択します）。

ヒント「a problem was detected」や「the publisher cannot be verified」などのアプリケーションに関

するセキュリティ警告、または、未確認のアプリケーションがコンピュータにアクセスしよう

としているという内容のセキュリティ警告が表示された場合は、アクセスが許可されているこ

とを確認します。複数のボタンをクリックしなければならない場合があります。ボタン名はア

プリケーションのプロンプトによって異なります（[Allow]、[Yes]、[Apply] など）。

ステップ 5 インストール ウィザードの [Welcome] 画面が開き、次の文が表示されます。「Install these Cisco 
Security Manager 4.4 client applications:」 

• Configuration Manager 

• Event Viewer 

• Report Manager

• Health and Performance Manager

• Image Manager

Security Manager クライアントは、次の 5 つのアプリケーションがあるアプリケーション スイートと

してインストールされます。Configuration Manager、Event Viewer、Report Manager、Health and 
Performance Manager、および Image Manager。各アプリケーションは、次の 3 つの方法のいずれかで

別々に起動できます（各アプリケーションの起動方法の詳細については、「Security Manager クライア

ントを使用した Security Manager へのログイン」（P.6-12）を参照してください）。

• [Start] > [Programs] > [Cisco Security Manager Client] >（次のいずれかを選択する）

[Configuration Manager]、[Event Viewer]、[Report Manager]、[Health and Performance 
Manager]、または [Image Manager]

• デスクトップ アイコン 
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• （いずれかのアプリケーションを起動した後）[Launch] >（Security Manager クライアント アプリ

ケーション スイート内の他のアプリケーションを選択する） 

（注） Cisco Security Manager のデスクトップ アイコンも作成されます。このアイコンで Cisco 
Security Management Suite のホーム ページを開きます。

ステップ 6 インストール ウィザードの指示に従います。インストール中に、次の情報の入力が要求されます。

• [Server name]：Security Manager サーバ ソフトウェアがインストールされているサーバの DNS 名
または IP アドレス。通常は、クライアント インストーラをダウンロードしたサーバです。

• [Protocol]：HTTPS または HTTP。Security Manager サーバで使用されるプロトコルを選択しま

す。ほとんどのサーバは HTTPS を使用するように設定されます。どれを選択していいかがわから

ない場合は、システム管理者にお問い合わせください。また、サーバが非デフォルト ポートを使

用するように設定されていることがわかっている場合は、「非デフォルト HTTP または HTTPS 
ポートの設定」（P.6-10）内の情報を使用してインストール後にポートを設定します。

• [Shortcuts]：自分専用のショートカットだけを作成するのか、このワークステーションにログイン

しているすべてのユーザ アカウント用のショートカットを作成するのか、またはどのユーザ用の

ショートカットも作成しないのか。これによって、誰の [Start] メニューに Cisco Security Manager 
Client が表示されるかが決定されます。クライアントは、[Start] > [Programs] > [Cisco 
Security Manager Client] > [Cisco Security Manager Client] またはデスクトップ上のアイコンから

起動できます。

• [Installation location]：クライアントをインストールするフォルダ。他の場所にインストールする

特別な理由がなければ、デフォルトを受け入れます。デフォルトの場所は、C:\Program 
Files\Cisco Systems です。

ステップ 7 インストール ウィザードの指示に従って続行します。

ステップ 8 [Done] をクリックしてインストールを完了したら、アンチウイルス アプリケーションを一時的にディ

セーブルにしていた場合はイネーブルに戻します。

クライアント インストーラによってワークステーション上の Cisco Security Agent が停止されていた場

合は、インストールの完了時に再起動されます。ただし、システム上で Cisco Security Agent を手動で

ディセーブルにしていた場合は、クライアントのインストールが完了してからそれをイネーブルにする

必要があります。

インストールを阻止するセキュリティ設定の処理

ワークステーション上のセキュリティ設定を構成可能な複数の方法と、Security Manager クライアン

トのインストールを阻止するためにインストール可能な複数の製品が存在します。インストール中に問

題が発生した場合は、Windows ユーザ アカウントにソフトウェアのインストールに必要な管理特権が

付与されていることを確認してから、次のヒントを考慮してください。

• （Windows XP）Internet Explorer セキュリティ強化のデフォルト設定では、サーバからのインス

トール ユーティリティのダウンロードが阻止される可能性があります。この場合は、次のメッ

セージが表示されます。

Internet Explorer cannot download CSMClientSetup.exe from <server>.Internet Explorer 
was not able to open this Internet site.The requested site is either unavailable or 

cannot be found.Please try again later. 
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この問題を解決するには、[Start] > [Settings] > [Control Panel] > [Add or Remove Programs] を選

択してから、[Add/Remove Windows Components] をクリックします。Windows コンポーネント 
ウィザード ウィンドウで、[Internet Explorer Enhanced Security Configuration] チェックボックス

をオフにして、[Next] をクリックし、[Finish] をクリックします。

• （Windows XP SP2）向上したセキュリティ機能によって、次のメッセージが表示される可能性が

あります。

Security Warning Message.The publisher could not be verified.Are you sure you want to 

run this software? 

このメッセージが表示されたら、[Yes] をクリックして継続します。

非デフォルト HTTP または HTTPS ポートの設定

Security Manager サーバは、443 の HTTPS と 1741 の HTTP のデフォルト ポートを使用します。組織

で別のポートを使用するように Security Manager サーバをインストールしていた場合は、非標準ポー

トを使用するようにクライアントを設定する必要があります。そうしなければ、クライアントとサーバ

を接続できません。

クライアントの別のポートを設定するには、メモ帳などのテキスト エディタを使用して C:\Program 
Files\Cisco Systems\Cisco Security Manager Client\jars\client.info ファイルを編集します。次の設

定を追加して、<port number> の場所にカスタム ポート番号を指定します。

• HTTPS_PORT=<port number> 

• HTTP_PORT=<port number> 

これらの設定は、次のクライアントを起動したときに使用されます。

以前のバージョンのクライアントからアップグレードできない

古いバージョンのクライアントがインストールされている、または、クライアントがインストールされ

ていたことがあるワークステーション上に Security Manager クライアントをインストールしようとし

た場合は、クライアント インストーラによって新しいバージョンがインストールされる前に古いバー

ジョンがアンインストールされます。「Could not find main class.Program will exit」というエラー メッ

セージが表示された場合は、インストーラでクライアントをインストールできません。

手順

この問題は、システム内に古いレジストリ エントリが残っている場合に発生します。この問題を解決

するには、次の手順を実行します。

ステップ 1 [Start] > [Run] を選択して、regedit と入力することによって、レジストリ エディタを起動します。

ステップ 2 次のレジストリ キーを削除します。

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\Uninst
all\f427e21299b0dd254754c0d2778feec4-837992615

ステップ 3 以前のインストール ディレクトリ（通常は、C:\Program Files\Cisco Systems\Cisco Security Manager 
Client）を削除します。

ステップ 4 次のフォルダの名前を変更します。

C:\Program Files\Common Files\InstallShield\Universal\common\Gen1 
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ステップ 5 [Start] > [Control Panel] > [Add or Remove Programs] を選択します。Cisco Security Manager Client が
まだ表示されている場合は、[Remove] をクリックします。「Program already removed; do you want to 
remove it from the list?」というメッセージが表示されたら、[Yes] をクリックします。

まだ Security Manager クライアントを再インストールできない場合は、C:\Program Files\Common 
Files\InstallShield ディレクトリの名前を変更して、もう一度試してみてください。「インストール中の

クライアント障害」（P.A-10）も参照してください。

クライアントのパッチング

サービス パックまたはポイント パッチを Security Manager サーバに適用したら、サーバにログインし

たときに Security Manager クライアントからアップデートを適用するかどうかが尋ねられます。クラ

イアント ソフトウェアのバージョン番号は、サーバ ソフトウェアのバージョン番号と同じにする必要

があります。

必要なソフトウェア アップデートをダウンロードして適用するかどうかが尋ねられた場合は、Web ブ
ラウザがアップデートのダウンロードに使用されます。ファイルを開くまたは実行するのか、ディスク

に保存するのかが尋ねられます。いずれかのオプションを選択できます。ファイルのディスクへの保存

を選択した場合は、ファイルのダウンロード後にプログラムを実行します（ファイルをダブルクリック

するか、ブラウザから尋ねられたときに [Run] オプションを選択します）。

パッチのインストールは、クライアントのインストールに似ているため、Cisco Security Agent または

インストーラの起動を可能にするためにインストールしたその他のセキュリティ ソフトウェアからの

任意のセキュリティ アラートを許可（または [Yes] をクリック）する必要があります。

インストールの場所が尋ねられたら、クライアントがインストールされているフォルダが選択されてい

ることを確認して、ファイルを上書きするかどうかが尋ねられたら [Yes to All] を選択します。

ヒント URL が取得できない、または、接続がタイムアウトしたことを伝えるエラー メッセージが表示された

場合は、Security Manager クライアントをアンインストールしてから、フレッシュ コピー（すでに

パッチが適用されている）をインストールする必要があります。詳細については、「Security Manager 
クライアントのアンインストール」（P.6-14）および「Security Manager クライアントのインストール」

（P.6-6）を参照してください。

アプリケーションへのログイン
サーバ アプリケーションをインストールし、Web ブラウザを設定し、Security Manager クライアント

をインストールしたら、アプリケーションにログインできます。

• 「Security Manager クライアントを使用した Security Manager へのログイン」（P.6-12）

• 「Web ブラウザを使用したサーバ アプリケーションへのログイン」（P.6-13）
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Security Manager クライアントを使用した Security Manager へのログ
イン

Security Manager クライアントは、次の 5 つのアプリケーションがあるアプリケーション スイートと

してインストールされます。Configuration Manager、Event Viewer、および Report Manager。各アプ

リケーションは、後述の手順内で示される 3 つの方法のいずれかで別々に起動できます。

ほとんどの Security Manager タスクは、Configuration Manager アプリケーション（Security Manager 
クライアント アプリケーション スイートの一部）を使用して実行します。

ヒント Security Manager クライアントを十分に活用できる管理者特権が付与された Windows ユーザ アカウン

トを使用してクライアント ワークステーションにログインする必要があります。より低い特権を使用

してクライアントを操作しようとした場合は、一部の機能が正しく機能しない場合があります。

手順

ステップ 1 Configuration Manager、Event Viewer、Report Manager、Health and Performance Monitor、または 
Image Manager のいずれかを起動します。各アプリケーションは、次の 3 つの方法のいずれかで別々

に起動できます。

• [Start] > [Programs] > [Cisco Security Manager Client] >（次のいずれかを選択する）

[Configuration Manager]、[Event Viewer]、[Report Manager]、[Health and Performance 
Manager]、または [Image Manager]。ログイン ダイアログ ウィンドウが表示されます。

• デスクトップ アイコン。ログイン ダイアログ ウィンドウが表示されます。

• （いずれかのアプリケーションを起動した後）[Launch] >（Security Manager クライアント アプリ

ケーション スイート内の他のアプリケーションを選択する）。ログイン ダイアログ ウィンドウは

表示されません。

ステップ 2 Security Manager のログイン ダイアログ ウィンドウで、ログインするサーバの DNS 名を入力または

選択します。

（注） DNS 名ではなく IP アドレスを入力または選択すると、Internet Explorer 7 環境において一部の

機能が意図したとおりに動作しない可能性があります。すべての Security Manager 機能を正し

く動作させるには、ログインするサーバの DNS 名を入力します。

ステップ 3 Security Manager のユーザ名とパスワードを入力します。

ステップ 4 サーバが接続に HTTPS を使用する場合は、[HTTPS] チェックボックスがオンになっていることを確

認します。HTTPS を使用しない場合は、そのチェックボックスをオフにします。[Login] をクリック

します。

ステップ 5 サーバからクライアント ソフトウェア アップデートのダウンロードとインストールが要求された場合

は、「クライアントのパッチング」（P.6-11）を参照してください。

ステップ 6 ご使用のクライアントよりも新しいバージョンを実行している Security Manager サーバにログインす

ると、通知が表示され、一致するクライアント バージョンをダウンロードするオプションが提供され

ます。

ステップ 7 入力したユーザ名とパスワードで実行中のセッションがない場合は、クライアント アプリケーション

（Configuration Manager、Event Viewer、Report Manager、Health and Performance Monitor、または 
Image Manager）がサーバにログインして、クライアント インターフェイスを開きます。
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ステップ 8 入力したユーザ名とパスワードで実行中のセッションがすでに存在する場合は、既存のアプリケーショ

ンから同一セッションで新しいアプリケーションを簡単に起動できる方法があることを知らせる情報

メッセージが表示されます。その方法とは、次のとおりです。

（いずれかのアプリケーションを起動した後）[Launch] >（Security Manager クライアント アプリ

ケーション スイート内の他のアプリケーションを選択する）。

ステップ 9 新しいアプリケーションが既存のセッションから起動されるか、すでに実行中ならばそのアプリケー

ションがフォーカス状態になります。

ヒント クライアントは 120 分間アイドル状態が続くと自動的に閉じます。アイドル タイムアウトを変

更するには、[Tools] > [Security Manager Administration] を選択して、目次から [Customize 
Desktop] を選択し、必要なタイムアウト期間を入力します。この機能をディセーブルにして、

クライアントが自動的に閉じないようにすることもできます。

ステップ 10 Security Manager を終了する場合は、[File] > [Exit] を選択します。

Web ブラウザを使用したサーバ アプリケーションへのログイン

正規の Windows アプリケーションを使用してクライアント アプリケーションをホストするのは、

Security Manager サーバだけです。Security Manager（Common Services アプリケーション経由）、

CiscoWorks、および Auto Update Server のサーバ管理機能を含め、その他すべてのアプリケーション

は Web ブラウザ内でホストされます。

これらのアプリケーションへのログイン方法は同じです。1 台のサーバ上に複数のアプリケーションを

インストールした場合は、インストールしたすべてのアプリケーションに同時にログインします。これ

は、ログインが CiscoWorks によって制御され、これらのアプリケーションはすべて CiscoWorks の制

御下でホストされるためです。

手順

ステップ 1 Web ブラウザで、次のいずれかの URL を開きます。server は、サーバ アプリケーションがインストー

ルされているコンピュータの名前です。いずれかのセキュリティ アラート ウィンドウで [Yes] をク

リックします。

• SSL を使用していない場合は、http://server:1741 を開きます。

• SSL を使用している場合は、http://server:443 を開きます。

Cisco Security Management Suite のログイン画面が表示されます。ページ上で、JavaScript と cookie 
がイネーブルになっていることと、サポートされているバージョンの Web ブラウザを実行しているこ

とを確認します。アプリケーションを実行するようにブラウザを設定する方法については、「Web ブラ

ウザ クライアントの設定」（P.6-1）を参照してください。

ステップ 2 ユーザ名とパスワードを使用して、Cisco Security Management Suite サーバにログインします。初め

てサーバをインストールする場合は、ユーザ名の admin と製品のインストール中に定義されたパス

ワードを使用してログインできます。

ステップ 3 Cisco Security Management Suite のホームページで、サーバ上にインストールされた機能にアクセス

できます。このホームページには、インストールされているものによって異なる項目を含めることがで

きます。

• 実行するアプリケーション（Auto Update Server など）に対応するパネルをクリックします。
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• [Server Administration] パネルをクリックして、CiscoWorks Common Services サーバ メニューを

開きます。このリンクをクリックすれば、Common Services 内の任意の場所に移動できます。

CiscoWorks Common Services は、サーバを管理する基盤ソフトウェアです。このソフトウェアを

使用して、サーバの保守とトラブルシューティングやローカル ユーザ定義などのバックエンド 
サーバ機能を設定して管理します。

• [CiscoWorks] リンク（ページの右上）をクリックして、サーバ上で CiscoWorks ホームページを開

きます。

• [Cisco Security Manager Client Installer] をクリックして、Security Manager クライアントをイン

ストールします。このクライアントは、Security Manager サーバを使用するためのメイン イン

ターフェイスです。

ステップ 4 アプリケーションを終了するには、画面右上にある [Logout] をクリックします。ホームページと 
Security Manager クライアントの両方を同時に開いている場合は、ブラウザ接続を終了しても Security 
Manager クライアントが終了しません。

Security Manager クライアントのアンインストール
Security Manager クライアントをアンインストールする場合は、[Start] > [Programs] > [Cisco 
Security Manager Client] > [Uninstall Cisco Security Manager Client] を選択して、アンインストール 
ウィザードの指示に従います。
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インストール後のサーバ タスク

次のトピックは、Security Manager またはその関連アプリケーションをサーバ上にインストールして

から実行すべきタスクです。

• 「すぐに実行すべきサーバ タスク」（P.7-1）

• 「必要なプロセスが動作しているかどうかの確認」（P.7-2）

• 「MRF を使用した Security Manager プロセスのヒープ サイズの設定」（P.7-2）

• 「現行のサーバ セキュリティに関するベスト プラクティス」（P.7-7）

• 「インストールまたはアップグレードの確認」（P.7-7）

• 「関連情報」（P.7-8）

すぐに実行すべきサーバ タスク
インストール直後に次のタスクを実行してください。

タスク

1. アンチウイルス スキャナと同等の製品を再イネーブルまたは再インストールします。アンチウイルス ツールな

どのサーバ セキュリティ ソフトウェアをアンインストールまたは一時的にディセーブルにした場合は、今すぐ、

そのソフトウェアを再インストールまたは再起動して、必要に応じてサーバを再起動します。

（注） アンチウイルス ソフトウェアが原因で Security Manager サーバの効率性や応答性が損なわれていることが判

明した場合は、アンチウイルス ソフトウェアのマニュアルで推奨設定を確認してください。

2. インストール中にディセーブルにしたサービスとサーバ プロセスを再イネーブルします。IIS は再イネーブルし

ないでください。

3. Sybase テクノロジーやソフトウェア コードを使用しているアプリケーションも含めて、インストール中にディ

セーブルにした基幹業務アプリケーションを再イネーブルします。

4. サーバ上で、自己署名証明書を信頼できる証明書のリストに追加します。手順については、ブラウザのマニュア

ルを参照してください。

5. Cisco.com 上で Security Manager とその関連アプリケーションのアップデートをチェックします。アップデー

トが入手可能なことがわかった場合は、組織やネットワークに関連するアップデートをインストールします。
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必要なプロセスが動作しているかどうかの確認
Windows のコマンド プロンプト ウィンドウから pdshow コマンドを実行して、インストールする 
Cisco サーバ アプリケーションに必要なプロセスのすべてが正しく動作していることを確認できます。

プロセス要件はアプリケーションによって異なります。

ヒント pdshow の詳細については、Common Services のマニュアルを参照してください。

表 7-1 を使用して、どのアプリケーションにどのプロセスが必要かを確認してください。

MRF を使用した Security Manager プロセスのヒープ サイ
ズの設定

Security Manager 4.1 で導入された機能である Memory Reservation Framework（MRF）は、Cisco 
Security Manager 管理者に、主要プロセスのヒープ サイズを変更する機能を提供します。それにより、

サーバのパフォーマンスを向上させることができます。MRF を使用すると、プロセスは、サーバに搭

載された RAM の容量に基づいてヒープ サイズを調整できるようになります。

表 7-1 アプリケーション プロセス要件

アプリケーション 必要な Daemon Manager プロセス

Common Services Apache
CmfDbEngine
CmfDbMonitor
CMFOGSServer
CSRegistryServer
DCRServer
diskWatcher
EDS
EDS-GCF
ESS
EssMonitor
jrm
LicenseServer
Proxy
Tomcat
TomcatMonitor
NameServer
NameServiceMonitor
EventFramework

Cisco Security Manager AthenaOGSServer
ccrWrapper
CsmReportServer
rptDbEngine
rptDbMonitor
VmsBackendServer
vmsDbEngine
vmsDbMonitor
VmsEventServer
CsmHPMServer

Auto Update Server AusDbEngine
AusDbMonitor
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MRF を使用して設定可能な Security Manager プロセスを表 7-2 に示します。

デフォルト コンフィギュレーション

表 7-3 に示されているプロセス（MRF を使用して設定可能な Security Manager プロセス）は、ヒープ 
サイズに対してデフォルト値が事前に設定されています。表 7-3 には、MRF を使用して設定可能な 
Security Manager プロセスごとに、サーバで使用可能なさまざまな RAM 容量に応じたデフォルトの最

小および最大ヒープ サイズが MB 単位で示されています。

レポート サーバ（CsmReportServer）に対する最大ヒープ サイズは、必要に応じて 1408 MB まで増や

すことができます。

一定量の RAM がオペレーティング システム用とその他のプロセス用に予約されていますが、この表

には示されていません。たとえば、表 7-3 の RAM が 16 GB の場合について考えてみます。4 つすべて

のプロセスに対する最大ヒープ サイズの合計は、(4096 + 4096 + 1024 + 4096) = 13312 MB、つまり 13 
GB です。残りの 3 GB の RAM がオペレーティング システム用とその他のプロセス用に使用できま

す。

表 7-2 MRF を使用して設定可能な Security Manager プロセス 1

プロセス pdshow で表示される名前2 説明

バックエンド プロセス VmsBackendServer デバイス検出操作と展開操作を

実行します。

Tomcat Tomcat ポリシーなどの編集および検証

を行うためのアプリケーション

をホストします。

レポート サーバ CsmReportServer レポート データを生成します。

イベント サーバ VmsEventServer デバイスから送信されているイ

ベントを収集します。

1. HPM（Health and Performance Monitor）サーバの MRF 設定はありません。

2. pdshow コマンドの詳細については、前述の必要なプロセスが動作しているかどうかの確認および 
Common Services のマニュアルを参照してください。

表 7-3 Security Manager プロセスに対して事前に設定されるデフォルトのヒープ サイズ

サーバ上の物

理 RAM（GB） 
VmsBackend
Server Tomcat 

CsmReportS
erver 

VmsEventSe
rver 

CsmHPMSer
ver 

< 8 1024、2048 512、1024 512、1024 1024、2048 512、1024

8 1024、3072 1024、2048 1024、1024 1024、3072 512、1024

12 2048、4096 2048、3072 1024、1024 2048、4096 512、1024

16 2048、4096 2048、4096 1024、1024 4096、4096 512、1024

24 4096、8192 4096、4096 1024、1024 4096、8192 512、1024

>= 28 8192、8192 4096、4096 1024、1024 4096、8192 512、1024
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コンフィギュレーション コマンド

MRF では、1 つのコマンドと一連のサブコマンドが提供され、Security Manager サーバ プロセスの

ヒープ サイズの読み取りや変更に使用されます。各プロセスの最小および最大ヒープ サイズは、mrf 
コマンドを使用して設定できます。次のようにこのコマンドを実行すると、このコマンドの使用方法に

関する情報が表示されます。

> mrf
mrf help
           Prints this message.
mrf backup
           Backup existing configuration
mrf revert
           Restores backed up configuration
mrf set_heap_params process X-Y [min],[max]
           Sets minimum and maximum heap sizes
           process -> process name
           X-Y -> Memory Range in MB to which heap sizes apply
           [min],[max] -> minimum and maximum heap sizes in MB. These are optional but 
atleast one should be specified.
mrf get_heap_params process [memory]
           Prints minimum and maximum heap sizes in MB
           process -> process name
           [memory] -> memory size in MB for which heap sizes are to be printed. If not 
specified heap sizes are to be printed for current system memory.

mrf コマンドを実行する際は、有効なプロセス名のみを使用してください。無効なプロセス名を指定し

ても、エラーは発生しません。有効なプロセス名は、表 7-2 に示されています。プロセス名は大文字と

小文字が区別されます。

プロセスに対するヒープ サイズの設定

Security Manager プロセスに対するヒープ サイズの設定は、次の主要な 3 つの手順で構成されます。

1.既存の設定の保存 

2.既存の設定の読み取り 

3.設定の変更 

1.既存の設定の保存 

プロセスのヒープ サイズの設定は、Security Manager のパフォーマンスに影響する可能性のある重要

な手順であるため、アプリケーションの専門家の指示の下でのみ実施することを推奨します。

また、予防措置として、プロセスの既存のメモリ設定を変更する前に、それらを保存しておくことも推

奨します。MRF では、2 種類の保存方法が用意されています。

1. 1 つ目の方法は、設定変更をテストする場合に使用できます。この場合、次に示す 2 つのコマンド

を使用して、それぞれ、古い設定を保存すること、および新しい変更を古い設定に戻すことができ

ます。

mrf backup
mrf revert

2. 2 つ目の方法は、新しい設定をしばらく使用した後に、古い値に戻す場合に役立ちます。これには 
2 つの方法があり、次のうちのいずれか一方を使用できます。
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a. 設定変更を行った後に mrf backup を実行していなければ、mrf revert を実行できます。

b. Cisco Security Manager サーバのバックアップを取ってから、設定変更を行います。変更を元

に戻すときは、バックアップを復元します。この場合、バックアップ後に行われたデータの変

更は失われます。

2.既存の設定の読み取り 

データの保存が完了しましたので、次のコマンドを使用して、プロセスの既存の値を問い合わせること

ができます。

mrf get_heap_params [process name] [memory] 

このコマンドで memory 値を指定しなければ、現在の RAM サイズが使用されます。一般に関心がある

のは、現在の RAM サイズに対する情報です。パラメータ [process name] は、表 7-2 に示されている

値のいずれかになります。プロセス名は大文字と小文字が区別されます。

このコマンドの出力は、次のように表示されます。値の単位は MB です。

Minimum Heap Size = 1024 
Maximum Heap Size = 2048 

3.設定の変更 

現在の設定を確認した後、この項に記載された説明に従って設定を変更することができます。

ヒープ サイズを設定するには、次のコマンドを使用します。

mrf set_heap_params [process name] [X-Y] [min],[max]

パラメータ [process name] は、表 7-2 に示されているプロセスのいずれかにすることができます。プ

ロセス名は大文字と小文字が区別されます。

このコマンドを実行した後、Security Manager サーバを再起動して変更を反映させる必要があります。

（注） mrf set_heap_params を使用して行われた変更は、ヒープ パラメータの変更前に取られたバックアッ

プが復元されると、失われる可能性があります。この場合、新しい値を保持する必要があるときは、次

の手順を実行できます。

1. mrf backup を実行します。

2. アプリケーションの復元を行います。

3. mrf revert を実行します。

このコマンドでは、次の構文が使用されます。

mrf set_heap_params [process name] [X-Y] [min],[max] 

最小および最大ヒープ サイズを設定します。

[X-Y]：ヒープ サイズを適用するメモリ範囲（単位は MB） 

[min],[max]：最小および最大ヒープ サイズ（単位は MB）。これらはオプションですが、少なくとも 1 
つは指定する必要があります。

パラメータ [process name] は、表 7-2 に示されている値のいずれかになります。プロセス名は大文字

と小文字が区別されます。
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設定変更の例 

次に、ヒープ サイズの設定変更の例を示します。

• mrf set_heap_params Tomcat 7372-8192 2048,4096 

RAM サイズが 7372 ～ 8192 MB の範囲内のときの Tomcat プロセスに対して最小および最大ヒー

プ サイズをそれぞれ 2048 MB と 4096 MB に設定します。

• mrf set_heap_params Tomcat 7372-8192 2048 

RAM サイズが 7372 ～ 8192 MB の範囲内のときの Tomcat プロセスに対して最小ヒープ サイズを 
2048 MB に設定します。

• mrf set_heap_params Tomcat 7372-8192,4096 

RAM サイズが 7372 ～ 8192 MB の範囲内のときの Tomcat プロセスに対して最大ヒープ サイズを 
4096 MB に設定します。

• mrf set_heap_params Tomcat 8080-8080 2048,4096 

RAM サイズが 8080 MB ときの Tomcat プロセスに対して最小および最大ヒープ サイズをそれぞ

れ 2048 MB と 4096 MB に設定します。getramsize コマンドを実行すると、既存の RAM サイズ

を MB 単位で取得できます。

設定変更の確認

ヒープ パラメータを設定した後、mrf get_heap_params コマンドを実行して変更を確認できます。

プロセスに対するヒープ サイズの設定の要約

ここで説明した、Security Manager プロセスに対するヒープ サイズの設定のための 3 つの主要手順は、

次のように要約されます。これらのコマンドは、実行順で示されています。

mrf backup 
mrf get_heap_params process 
mrf set_heap_params Tomcat 7372-8192 2048,4096 
mrf revert #if required to revert changes 

ユーザがヒープ サイズの再設定を必要とする一般的なシナリオ

シナリオ 1 

ある Security Manager 4.0 ユーザが、バックエンド プロセス（VmsBackendServer）に対して 4 GB の
最大ヒープ サイズを使用しています。これは、8 GB RAM に対して Security Manager 4.1 で割り当て

られるデフォルトの最大ヒープ サイズである 3 GB を超えています。このシナリオのユーザは、バック

エンド プロセスのヒープ サイズを 4 GB に再設定する必要があります。イベント管理（Event Server プ
ロセス（VmsEventServer）を使用）がイネーブルになっていなければ、そうすることができます。

シナリオ 2 

Security Manager が設定専用モードで使用されています（イベント管理とレポートがディセーブルに

なっている）。このシナリオでは、バックエンド プロセスと Tomcat のヒープ サイズを増やすことがで

きます。
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シナリオ 3 

Security Manager が設定専用モードで使用されており（イベント管理とレポートがディセーブルに

なっている）、イベント管理をイネーブルにする必要があります。このシナリオでは、すべての 
Security Manager プロセスのヒープ サイズの合計がサーバで使用可能な RAM サイズを超えないよう

に、バックエンド プロセスと Tomcat のヒープ サイズを減らしてから、イベント管理をイネーブルに

する必要があります。

シナリオ 4 

イベント管理とバックエンド プロセスは、メモリを大量に消費するため、より多くの RAM 割り当て

を必要とします。（イベント管理が使用されない場合は、その分の RAM がバックエンド プロセスに割

り当てられるように、バックエンド プロセスの最大ヒープ サイズを増やすことができます）。

現行のサーバ セキュリティに関するベスト プラクティス
システムの最小限のセキュア コンポーネントによってシステムの安全性が定義されます。下のチェッ

クリスト内のステップは、Security Manager のインストール後のサーバとその OS のセキュリティ保護

に役立ちます。

インストールまたはアップグレードの確認
Common Services を使用して、Security Manager のインストールまたはアップグレードが成功したか

どうかを確認できます。Security Manager インターフェイスが表示されない、または、正しく表示さ

れないことが原因でインストールを確認する場合は、「インストール後のサーバ障害」（P.A-5）を参照

してください。

タスク

1. サーバ セキュリティを定期的にモニタします。システム アクティビティを記録して確認します。Microsoft 
Security Configuration Tool Set（MSCTS）や Fport などのセキュリティ ツールを使用して、サーバのセキュリ

ティ設定を定期的に確認します。Security Manager サーバ上にインストールされたスタンドアロン バージョン

の Cisco Security Agent に関するログ ファイルを確認します。

ヒント MSCTS は Microsoft の Web サイトから、Fport は Foundstone/McAfee の Web サイトから入手できます。

2. サーバへの物理アクセスを制限します。サーバに取り外し可能なメディア ドライブが接続されている場合は、

ハード ドライブから起動するようにサーバを設定します。誰かが取り外し可能なメディア ドライブからサーバ

を起動した場合に、データが侵害されるおそれがあります。通常は、システム BIOS 内で起動順序を設定できま

す。BIOS が強力なパスワードで保護されていることを確認します。

3. リモート アクセス ツールやリモート管理ツールをサーバ上にインストールしないでください。このようなツー

ルは、サーバへのエントリ ポイントを提供するセキュリティ リスクになります。

4. サーバ上で自動的かつ継続的に動作するようにウイルス スキャン アプリケーションを設定します。ウイルス ス
キャン アプリケーションは、トロイの木馬アプリケーションのサーバへの侵入を阻止できます。ウイルス署名

を定期的に更新します。

5. サーバ データベースを頻繁にバックアップします。すべてのバックアップをアクセスが制限されたセキュアな

場所に保管します。
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ステップ 1 クライアント システム上のブラウザを使用して、次のいずれかを使用している Security Manager サー

バにログインします。

• HTTP サービスの場合：http://<server_name>:1741

• SSL サービスの場合：https://<server_name>:443

サポートされているブラウザとブラウザのバージョンを確認するには、「クライアントの要件」（P.3-8）
を参照してください。

ステップ 2 [Cisco Security Management Suite] ページで、[Server Administration] パネルをクリックして、

Common Services の [Server] > [Admin] ページを開きます。

ステップ 3 [Process Management] ページを表示するには、[Processes] をクリックします。

結果のリストには、すべてのサーバ プロセスの名前とプロセスごとの動作ステータスの説明が表示さ

れます。次のプロセスが正常に動作している必要があります。

• vmsDbEngine

• vmsDbMonitor

• EDS

関連情報

項目 対応

基本の理解 Security Manager を起動すると表示される対話形式の JumpStart ガイドを参照してくだ

さい。

製品の迅速な稼働 オンライン ヘルプの「Getting Started with Security Manager」トピックを参照するか、

『User Guide for Cisco Security Manager』の第 1 章を参照してください。

製品設定の実施 オンライン ヘルプの「Completing the Initial Security Manager Configuration」トピック

を参照するか、『User Guide for Cisco Security Manager』の第 1 章を参照してください。

ユーザの認証と認可の管理 次の項を参照してください。

• 「ユーザの権限」（P.8-3）

• 「Security Manager と Cisco Secure ACS の統合」（P.8-12） 

デバイスのブート オンライン ヘルプの「Preparing Devices for Management」トピックを参照するか、

http://www.cisco.com/en/US/products/ps6498/products_user_guide_list.html から入手可

能な『User Guide for Cisco Security Manager 4.4』の第 2 章を参照してください。
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ユーザ アカウントの管理 

ユーザ アカウントの管理には、アカウントの作成とユーザの権限が含まれます。

• 「アカウントの作成」（P.8-1） アカウントには、Security Manager Server のローカル アカウント、

CiscoWorks Common Services サーバの ACS アカウント、または Common Services サーバの非 
ACS アカウントがあります。

• 「ユーザの権限」（P.8-3） 権限（または特権）は、実行を許可されるタスクです。権限は、Security 
Manager 内のユーザ ロールによって定義されます。Security Manager 内のロールは、ユーザ名と

パスワードの認証後に設定されます。認証は、ログイン中に Security Manager によって行われま

す。

アカウントの作成 
Cisco Security Manager を使用するには、インストール中に作成した admin アカウントを使用してロ

グインして、各ユーザのアカウントを作成する必要があります。次のタイプのアカウントを作成できま

す。

• 「ローカル アカウント」（P.8-1） 

• 「ACS アカウント」（P.8-2） 

• 「非 ACS アカウント」（P.8-2） 

ローカル アカウント 
ローカル アカウントは、CiscoWorks Common Services サーバではなく、Security Manager サーバで

定義されます。これは Security Manager サーバに固有です。次のパスに従います。

Security Manager がインストールされているサーバ > 

Configuration Manager アプリケーションのデスクトップ アイコン > 

admin アカウント ログイン > 

[Tools] > 

[Security Manager Administration] > 

[Server Security] > 

[Local User Setup] > 

[Add]
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ヒント ローカル アカウントは、CiscoWorks ローカル ログイン モジュールを使用します。ただし、

CiscoWorks インターフェイスではなく、Security Manager ユーザ インターフェイスを使用して操作し

ます。

ACS アカウント 
ACS アカウントは、Security Manager サーバではなく、CiscoWorks Common Services サーバで定義

されます。（最初は明らかではないこともありますが、Security Manager には、Common Services 内の 
Server Security Tools を相互起動するためのボタンがあります）。次のパスに従います。

Security Manager がインストールされているサーバ > 

Configuration Manager アプリケーションのデスクトップ アイコン > 

ユーザ アカウント ログイン > 

[Tools] > 

[Security Manager Administration] > 

[Server Security] > 

[AAA Setup]（このボタンは Common Services 内の Server Security Tools を相互起動します）> 

[ACS]

ヒント ACS アカウントは、（1）ACS タイプの AAA Mode Setup（これは [Authentication Mode Setup] ペー

ジにあります）、および（2）CiscoWorks Common Services の ACS ログイン モジュールを使用しま

す。ただし、ACS ログイン モジュールを選択する必要はありません。これは、ACS タイプの [AAA 
Mode Setup] を選択すると自動的に選択されます。

非 ACS アカウント 
非 ACS アカウントは、Security Manager サーバではなく、CiscoWorks Common Services サーバで定

義されます。次のパスに従います。

Security Manager がインストールされているサーバ > 

Configuration Manager アプリケーションのデスクトップ アイコン > 

ユーザ アカウント ログイン > 

[Tools] > 

[Security Manager Administration] > 

[Server Security] > 

[AAA Setup] > 

[Local RBAC] > 
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ヒント 非 ACS アカウントは、（1）Local RBAC タイプの AAA Mode Setup（これは [Authentication Mode 
Setup] ページにあります）、および（2）CiscoWorks Common Services の次のログイン モジュールの

いずれかを使用します。CiscoWorks Local（デフォルトのログイン モジュール）、IBM SecureWay 
Directory、KerberosLogin、Local NT System、MS Active Directory、Netscape Directory、RADIUS、
または TACACS+。

ユーザの権限 
Cisco Security Manager が、ログイン前にユーザ名とパスワードを認証します。これらが認証される

と、Security Manager がアプリケーション内のユーザ ロールを設定します。このロールによって、実

行が認可されるタスクまたは操作のセットである権限（特権とも呼ばれる）が定義されます。特定のタ

スクまたはデバイスに対して認可されなかった場合は、関連するメニュー項目、目次内の項目、および

ボタンが非表示またはディセーブルになります。加えて、選択した情報を表示したり、選択した操作を

実行したりするための権限がないことを伝えるメッセージが表示されます。

Security Manager の認証と認可は、CiscoWorks サーバと Cisco Secure Access Control Server（ACS）
のどちらかによって管理されます。デフォルトで、CiscoWorks は、認証と認可を管理しますが、

CiscoWorks Common Services の [AAA Mode Setup] ページを使用して Cisco Secure ACS を変更でき

ます。ACS 統合の詳細については、この章の次の項を参照してください。

• 「Security Manager と Cisco Secure ACS の統合」（P.8-12） 

• 「Security Manager と ACS の相互作用のトラブルシューティング」（P.8-29） 

Security Manager 4.3 および 4.4 よりも前の、Cisco Secure ACS を使用する重要なメリットは、（1）特

殊な権限セット（特定のポリシー タイプの設定だけをユーザに許可する場合など）を使用して非常に

粒度の高いユーザ ロールを作成できることと、（2）ネットワーク デバイス グループ（NDG）を設定

することによって特定のデバイスにユーザを制限できることでした。このような粒度の高い特権（効率

的な「ロールベース アクセス コントロール」（RBAC））は、Cisco Secure ACS を使用していない限

り、Security Manager 4.2 以前のバージョンでは利用できませんでした。Security Manager 4.3 および 
4.4 では、ACS を使用せずにローカル RBAC を利用できる Common Services 4.0 を使用するため、こ

のような粒度の高い特権（RBAC）を利用できます。

Security Manager 4.3 と 4.4 は ACS 4.2 との互換性を維持します。「Security Manager と Cisco Secure 
ACS の統合」（P.8-12）を参照してください。

（注） RBAC 機能を ACS から Common Services に移行したいユーザは、手動で行う必要があります。移行

スクリプトも、他の移行サポートもありません。

ヒント Security Manager 権限ツリーの全体を表示するには、Cisco Secure ACS にログインしてから、ナビ

ゲーション バーの [Shared Profile Components] をクリックします。詳細については、「Cisco Secure 
ACS ロールのカスタマイズ」（P.8-11）を参照してください。

次のトピックで、ユーザ権限について説明します。

• 「Security Manager ACS 権限」（P.8-4）

• 「CiscoWorks ロールについて」（P.8-6）

• 「Cisco Secure ACS ロールについて」（P.8-9）

• 「Security Manager 内の権限とロールのデフォルトの関連付け」（P.8-11）
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Security Manager ACS 権限

Cisco Security Manager はデフォルトの ACS ロールと権限を提供します。デフォルト ロールをカスタ

マイズすることも、ニーズに合わせて追加のロールを作成することもできます。ただし、新しいロール

を定義する場合、または、デフォルト ロールをカスタマイズする場合は、選択した権限が Security 
Manager アプリケーションの観点から適切であることを確認してください。たとえば、表示権限を伴

わない変更権限を付与した場合、そのユーザはアプリケーションを使用できなくなります。

Security Manager 権限は次のカテゴリに分類されます。個々の権限に関する説明については、Cisco 
Secure ACS に統合されているオンライン ヘルプを参照してください（権限の表示方法については、

「Cisco Secure ACS ロールのカスタマイズ」（P.8-11）を参照してください）。

• [View]：現在の設定の表示を可能にします。  主な表示権限を次に示します。

– [View] > [Policies]： さまざまなタイプのポリシーの表示を可能にします。このフォルダには、

ファイアウォールや NAT などのさまざまなポリシー クラスの権限が含まれています。

– [View] > [Objects]： さまざまなタイプのポリシー オブジェクトの表示を可能にします。この

フォルダには、ポリシー オブジェクト タイプごとの権限が含まれています。

– [View] > [Admin]： Security Manager 管理設定の表示を可能にします。

– [View] > [CLI]： デバイス上で設定された CLI コマンドの表示と、展開しようとしているコマ

ンドのプレビューを可能にします。

– [View] > [Config Archive]： 設定アーカイブに保存されている設定の一覧表示を可能にします。

デバイス設定や CLI コマンドは表示できません。

– [View] > [Devices]： [Device] ビュー内のデバイスと関連情報（デバイス設定、プロパティ、

割り当てなど）の表示を可能にします。NDG を設定することによって、デバイス権限を特定

のデバイスのセットに制限できます。

– [View] > [Device Managers]： Cisco IOS ルータ用の Cisco Router and Security Device 
Manager（SDM）など、あるデバイス専用のデバイス マネージャ（読み取り専用バージョン）

の起動を可能にします。

– [View] > [Topology]： [Map] ビューで設定されたマップの表示を可能にします。

– [View] > [Event Viewer]： Real Time Viewer と Historical Viewer の両方で Event Viewer のイ

ベントの表示を可能にします。

– [View] > [Report Manager]： Report Manager のレポートの表示を可能にします。

– [View] > [Schedule Reports]： Report Manager のレポートのスケジューリングを可能にしま

す。

• [Modify]：現在の設定の変更を可能にします。 

– [Modify] > [Policies]： さまざまなタイプのポリシーの変更を可能にします。このフォルダに

は、さまざまなポリシー クラスの権限が含まれています。

– [Modify] > [Objects]： さまざまなタイプのポリシー オブジェクトの変更を可能にします。こ

のフォルダには、ポリシー オブジェクト タイプごとの権限が含まれています。

– [Modify] > [Admin]： Security Manager 管理設定の変更を可能にします。

– [Modify] > [Config Archive]： 設定アーカイブ内のデバイス設定の変更を可能にします。加え

て、アーカイブへの設定の追加と設定アーカイブ ツールのカスタマイズを可能にします。

– [Modify] > [Devices]： デバイスの追加と削除だけでなく、デバイスのプロパティと属性の変

更を可能にします。追加するデバイスに関するポリシーを検出するには、[Import] 権限もイ

ネーブルにする必要があります。加えて、[Modify] > [Devices] 権限をイネーブルにした場合

は、[Assign] > [Policies] > [Interfaces] 権限もイネーブルになっていることを確認してくださ

い。NDG を設定することによって、デバイス権限を特定のデバイスのセットに制限できます。
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– [Modify] > [Hierarchy]： デバイス グループの変更を可能にします。

– [Modify] > [Topology]： [Map] ビュー内のマップの変更を可能にします。

– [Modify] > [Manage Event Monitoring]： 任意のデバイスに対して Security Manager のモニタ

リングをイネーブルおよびディセーブルにすることを可能にします。それにより、Security 
Manager は、デバイスからのイベントの受信および処理を開始または停止します。

• [Assign]：デバイスと VPN へのさまざまなポリシー タイプの割り当てを可能にします。このフォ

ルダには、さまざまなポリシー クラスの権限が含まれています。

• [Approve]：ポリシー変更と展開ジョブの承認を可能にします。 

• [Control]：ping などのデバイスに対するコマンドの発行を可能にします。この権限は、接続診断

に使用されます。

• [Deploy]：ネットワーク内のデバイスに対する設定変更の展開と、以前の展開設定に戻すための

ロールバックの実施を可能にします。 

• [Import]：すでにデバイス上に展開された設定の Security Manager へのインポートを可能にしま

す。デバイスの表示特権とデバイスの変更特権も持っている必要があります。

• [Submit]：設定変更の送信と承認を可能にします。 

ヒント

• 変更、割り当て、承認、インポート、制御、または展開権限を選択した場合は、対応する表示権限

も選択する必要があります。そうしなかった場合は、Security Manager が正しく機能しません。

• ポリシーの変更権限を選択した場合は、対応するポリシーの割り当て権限と表示権限も選択する必

要があります。

• その定義の一部としてポリシー オブジェクトを使用するポリシーを許可した場合は、これらのオ

ブジェクト タイプに表示権限も付与する必要があります。たとえば、ルーティング ポリシーを変

更するための権限を選択した場合は、ルーティング ポリシーに必要なオブジェクト タイプのネッ

トワーク オブジェクトとインターフェイス ロールを表示するための権限も選択する必要がありま

す。

• その定義の一部として他のオブジェクトを使用するオブジェクトを許可する場合も同様です。たと

えば、ユーザ グループを変更するための権限を選択した場合は、ネットワーク オブジェクト、

ACL オブジェクト、および AAA サーバ グループを表示するための権限も選択する必要がありま

す。

• NDG を設定することによって、デバイス権限を特定のデバイスのセットに制限できます。NDG 
はポリシー権限に対して次のような影響を与えます。

– ポリシーを表示するには、そのポリシーが割り当てられた少なくとも 1 つのデバイスに対する

権限を持っている必要があります。

– ポリシーを変更するには、そのポリシーが割り当てられたすべてのデバイスに対する権限を

持っている必要があります。

– VPN ポリシーを表示、変更、または割り当てるには、VPN トポロジ内のすべてのデバイスに

対する権限を持っている必要があります。

– デバイスにポリシーを割り当てるには、ポリシーが割り当てられた他のデバイスに対する権限

を持っているかどうかに関係なく、そのデバイスの権限のみが必要です （上述したように、

VPN ポリシーは例外です）。ただし、権限を持っていないデバイスに割り当てられているポリ

シーを変更することはできません。
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CiscoWorks ロールについて

CiscoWorks Common Services 内で作成されたユーザには、1 つ以上のロールが割り当てられます。各

ロールに割り当てられた権限によって、各ユーザが Security Manager 内で実行を認可される操作が決

定されます。

次のトピックで、CiscoWorks ロールについて説明します。

• 「CiscoWorks Common Services デフォルト ロール」（P.8-6）

• 「認可タイプの選択および Common Services 内のユーザへのロールの割り当て」（P.8-7）

CiscoWorks Common Services デフォルト ロール

CiscoWorks Common Services には、Security Manager 用の次のデフォルト ロールが用意されていま

す。

• Help Desk：Help Desk ユーザは、デバイス、ポリシー、オブジェクト、およびトポロジ マップを

表示できます（ただし、変更はできません）。

• Approver：変更および CLI 変更の修正を承認できます。

• Network Operator：表示権限に加えて、Network Operator は、CLI コマンドと Security Manager 
管理設定を表示できます。Network Operator は、設定アーカイブを変更したり、デバイスにコマ

ンド（ping など）を発行したりすることもできます。

• Network Administrator：変更のみ展開できます。

（注） Cisco Secure ACS は、さまざまな権限セットを含む Network Administrator という名前の

デフォルト ロールを特徴とします。詳細については、「Cisco Secure ACS ロールについて」

（P.8-9）を参照してください。

• System Administrator：System Administrator は、変更、ポリシー割り当て、アクティビティと

ジョブの承認、検出、展開、およびデバイスに対するコマンドの発行を含む、すべての Security 
Manager 権限にアクセスできます。

ヒント Security Manager では、System Administrator ロールは最高レベルの権限を持っています。

• Super Admin：管理および承認タスクを含む、CiscoWorks のすべての操作を実行できます。デ

フォルトでは、このロールは完全な特権を持っています。  

ヒント Security Manager では、Super Admin ロールは最高レベルの権限を持っていません。また、

Super Admin ロールは ACS ではなく、Common Services に固有のものです。

• Security Administrator：変更の修正、割り当て、および送信のみできます。

• Security Approver：変更の修正のみ承認できます。

Image Manager

各デフォルト ロールの追加タスクは、Security Manager 4.3 に最初に表示される機能である Image 
Manager 用に定義されています。Security Manager 4.4 でもこれを引き続き使用できます。

• Image Manager の起動 
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• Security Manager のリポジトリへのイメージの追加 

• イメージ アップグレード ジョブの作成 

ローカル アカウント（Security Manager サーバに定義されている Security Manager に固有）を使用す

る場合、これらの追加タスクが表 8-1 に示されているさまざまなロールに割り当てられます。

Security Manager 権限と CiscoWorks ロールの関連付けについては、「Security Manager 内の権限と

ロールのデフォルトの関連付け」（P.8-11）を参照してください。

Image Manager の RBAC 権限マトリクスを示す一連の表の詳細については、付録 C「Image Manager 
の権限マトリクス」を参照してください。

ヒント

• 追加のアプリケーションがサーバ上にインストールされた場合に、追加のロール（データのエクス

ポートなど）が Common Services に表示される場合があります。データのエクスポート ロール

は、サードパーティ開発者用であり、Security Manager では使用されません。

• CiscoWorks ロールの定義は変更できませんが、各ユーザに割り当てるロールを定義できます。詳

細については、「認可タイプの選択および Common Services 内のユーザへのロールの割り当て」

（P.8-7）を参照してください。

• CiscoWorks で権限テーブルを生成するには、[Server] > [Reports] > [Permission] を選択して、

[Generate Report] をクリックします。

認可タイプの選択および Common Services 内のユーザへのロールの割り当て 

CiscoWorks Common Services 4.0 では、[Local User Setup] > [Add] ページを使用して、（1）ローカル 
ユーザに選択可能な 3 つの認可タイプのいずれかを選択し、（2）ロールをユーザに割り当てます。3 つ
の認可タイプは次のとおりです。

• Full Authorization 

• Enable Task Authorization 

• Enable Device Authorization 

Common Services にローカル ユーザを追加する場合、この 3 つの認可タイプ（Full Authorization、
Enable Task Authorization、または Enable Device Authorization）のいずれかを選択する必要がありま

す。

表 8-1 デフォルト ロールの Image Manager タスク

ロール

タスク

起動と表示

リポジトリへのイメー

ジの追加

イメージ アップグレー

ド ジョブの作成

Help Desk Yes No No

Approver Yes No No

Network Operator Yes No No

Network Administrator Yes Yes Yes

System Administrator Yes Yes Yes

Security Administrator Yes No No
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3 つの認可タイプのいずれかを選択することで、ローカル ユーザに必要なロールを選択できます。ロー

カル ユーザに必要なロールを選択することは、ユーザが実行を許可される操作を定義することになる

ので重要です。

たとえば、Help Desk ロールを選択した場合、ユーザは表示操作に制限され、データを変更できませ

ん。また、Network Operator ロールを割り当てた場合、ユーザは設定アーカイブを変更することもで

きます。特定のユーザに複数のロールを割り当てることができます。

デフォルトでは、Help Desk ロールがイネーブルになっています。デフォルト ロールをクリアして、

任意のロールをデフォルト ロールに設定することもできます。

ヒント ユーザ権限を変更したら、Security Manager クライアントを再起動する必要があります。

関連トピック

• 「Security Manager ACS 権限」（P.8-4）

• 「Security Manager 内の権限とロールのデフォルトの関連付け」（P.8-11）

• 「CiscoWorks ロールについて」（P.8-6）

ステップ 1 次のパスに従い、Common Services の [Local User Setup] ページに移動します。

Security Manager がインストールされているサーバ > 

Cisco Security Manager アプリケーションのデスクトップ アイコン > 

admin アカウント ログイン（または十分な権限があるユーザ アカウント）> 

[Server Administration] > 

[Server] >（メニュー セレクタ記号）>

[Security] > 

[Single-Server Management] > 

[Local User Setup]

ステップ 2 次のいずれかを実行します。

• ユーザを作成するには、[Add] をクリックして、[Username]、[Password]、[Verify Password]、お

よび [Email] の各フィールドに適切な情報を入力します。

• 既存のユーザの認可を変更するには、ユーザ名の横にあるチェックボックスをオンにして、[Edit] 
をクリックします。

ステップ 3 ユーザに Security Manager で利用可能なすべてのロール（Help Desk、Approver、Network Operator、
Network Administrator、System Administrator、Super Admin、Security Administrator、および 
Security Approver）を持たせる場合は、[Full Authorization] を選択します。

ヒント [Full Authorization] を選択する場合、[Enable Task Authorization] は選択できません（オプ

ション ボタン形式のため）。

ヒント [Full Authorization] を選択する場合、[Enable Device Authorization] は選択できません（オプ

ション ボタン形式のため）。

a. この手順のステップ 6 に進みます。
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ステップ 4 新しいユーザに、選択したロールのみ（たとえば、Network Operator のみ）を持たせる場合は、

[Enable Task Authorization] を選択します。

ヒント [Enable Task Authorization] を選択する場合、[Full Authorization] は選択できません（オプ

ション ボタン形式のため）。

ヒント [Enable Task Authorization] を選択する場合、[Enable Device Authorization] は選択できません

（オプション ボタン形式のため）。

a. 次のロールを 1 つ以上選択します。Help Desk、Approver、Network Operator、Network 
Administrator、System Administrator、Super Admin、Security Administrator、および Security 
Approver。各ロールの詳細については、「CiscoWorks Common Services デフォルト ロール」

（P.8-6）を参照してください。

b. この手順のステップ 8 に進みます。

ステップ 5 新しいユーザを、Security Manager インストールに存在するすべてのデバイス グループではなく、選

択するデバイス グループに対してのみ認可させる場合は、[Enable Device Authorization] を選択しま

す。（デバイス グループは [Device Groups] ページ（[Security Manager] > [Tools] > [Security Manager 
Administration] > [Device Groups]）で定義できます）。

ヒント [Enable Device Authorization] を選択する場合、[Full Authorization] は選択できません（オプ

ション ボタン形式のため）。

ヒント [Enable Device Authorization] を選択する場合、[Enable Task Authorization] は選択できません

（オプション ボタン形式のため）。ただし、特定のデバイス グループに対して個別のロールを選

択できます。

a. 新しいユーザが認可されるデバイス グループを選択します。

b. 次のロールを 1 つ以上選択します。Help Desk、Approver、Network Operator、Network 
Administrator、System Administrator、Super Admin、Security Administrator、および Security 
Approver。各ロールの詳細については、「CiscoWorks Common Services デフォルト ロール」

（P.8-6）を参照してください。

ステップ 6 [OK] をクリックして変更を保存します。

ステップ 7 Security Manager クライアントを再起動します。

Cisco Secure ACS ロールについて

Common Services 4.0 よりも前、Cisco Secure ACS ではアプリケーション固有のロール（効率的な

「ロールベース アクセス コントロール」（RBAC））をサポートしていたため、Common Services より

も柔軟性の高い Security Manager 権限の管理が可能でした。
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このような粒度の高い特権（RBAC）は、ACS を使用せずにローカル RBAC を利用できる Common 
Services 4.0 で利用できます。各ロールは、Security Manager タスクに対する認可レベルを決定する権

限セットで構成されます。Cisco Secure ACS で、各ユーザ グループに（およびオプションで個別の

ユーザにも）ロールを割り当てます。これによって、グループ内の各ユーザは、そのロールに対して定

義された権限によって認可される操作を実行できます。

加えて、これらのロールを Cisco Secure ACS デバイス グループに割り当てて、デバイスのセットごと

に権限を区別できるようにできます。

（注） Cisco Secure ACS デバイス グループは、Security Manager デバイス グループとは無関係です。

次のトピックで、Cisco Secure ACS ロールについて説明します。

• 「Cisco Secure ACS デフォルト ロール」（P.8-10）

• 「Cisco Secure ACS ロールのカスタマイズ」（P.8-11）

Cisco Secure ACS デフォルト ロール

Cisco Secure ACS には、CiscoWorks と同じロール（「CiscoWorks ロールについて」（P.8-6）を参照）

に加えて、次のロールが含まれています。

• Security Approver：Security Approver は、デバイス、ポリシー、オブジェクト、マップ、CLI コ
マンド、および管理設定を表示できます（ただし、変更はできません）。加えて、Security 
Approver は、アクティビティに含まれる設定変更を承認または拒否できます。

• Security Administrator：表示権限が付与されていることに加えて、Security Administrator は、

デバイス、デバイス グループ、ポリシー、オブジェクト、およびトポロジ マップを変更できます。

彼らは、デバイスと VPN トポロジにポリシーを割り当てたり、システムに新しいデバイスをイン

ポートするための検出を実行したりすることもできます。

• Network Administrator：表示権限に加えて、Network Administrator は、設定アーカイブを変更

したり、展開を実行したり、デバイスにコマンドを発行したりできます。

（注） Cisco Secure ACS Network Administrator ロール内に含まれる権限は、CiscoWorks 
Network Administrator ロール内に含まれる権限と同じではありません。詳細については、

「CiscoWorks ロールについて」（P.8-6）を参照してください。

CiscoWorks と違って、Cisco Secure ACS を使用すれば、各 Security Manager ロールに関連付けられ

た権限をカスタマイズできます。デフォルト ロールの変更方法については、「Cisco Secure ACS ロール

のカスタマイズ」（P.8-11）を参照してください。

Security Manager 権限と Cisco Secure ACS ロールの関連付けについては、「Security Manager 内の権

限とロールのデフォルトの関連付け」（P.8-11）を参照してください。

関連トピック

• 「Security Manager と Cisco Secure ACS の統合」（P.8-12）

• 「ユーザの権限」（P.8-3）
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Cisco Secure ACS ロールのカスタマイズ 

Cisco Secure ACS を使用すれば、各 Security Manager ロールに関連付けられた権限を変更できます。

特定の Security Manager タスクを対象とする権限が付与された特殊なユーザ ロールを作成することに

よって、Cisco Secure ACS をカスタマイズすることもできます。

（注） ユーザ権限を変更したら、Security Manager を再起動する必要があります。

関連トピック

• 「Security Manager ACS 権限」（P.8-4）

• 「Security Manager 内の権限とロールのデフォルトの関連付け」（P.8-11）

ステップ 1 Cisco Secure ACS のナビゲーション バーで、[Shared Profile Components] をクリックします。

ステップ 2 [Shared Components] ページで [Cisco Security Manager] をクリックします。Security Manager 用に設

定されたロールが表示されます。

ステップ 3 次のいずれかを実行します。

• ロールを作成するには、[Add] をクリックします。ロールの名前を入力して、オプションで、説明

を入力します。

• 既存のロールを変更するには、そのロールをクリックします。

ステップ 4 権限ツリー内のチェックボックスをオン /オフして、そのロールに対する権限を定義します。

ツリーのブランチに対応するチェックボックスをオンにすると、そのブランチ内のすべての権限が選択

されます。たとえば、[Assign] チェックボックスをオンにすると、すべての割り当て権限が選択されま

す。

個々の権限に関する説明がウィンドウに表示されます。詳細については、「Security Manager ACS 権
限」（P.8-4）を参照してください。

ヒント 変更、承認、割り当て、インポート、制御、または展開権限を選択した場合は、対応する表示

権限も選択する必要があります。そうしなかった場合は、Security Manager が正しく機能しま

せん。

ステップ 5 [Submit] をクリックして、変更を保存します。

ステップ 6 Security Manager を再起動します。

Security Manager 内の権限とロールのデフォルトの関連付け

表 8-2 に、Security Manager 権限、CiscoWorks Common Services ロール、および Cisco Secure ACS 
内のデフォルト ロールの関連付けを示します。一部のロール（Super Admin、Security Administrator、
および Security Approver）は、Cisco Secure ACS のデフォルト ロールと特に関連付けられていないの

で含まれていません。特定の権限に関する詳細については、「Security Manager ACS 権限」（P.8-4）を

参照してください。
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Security Manager と Cisco Secure ACS の統合
この項では、Cisco Secure ACS と Cisco Security Manager の統合方法について説明します。

Cisco Secure ACS は、Security Manager などの管理アプリケーションを使用しているユーザに管理対

象ネットワーク デバイスを設定するためのコマンド認可を提供します。コマンド認可に対するサポー

トは、一連の権限が含まれる一意のコマンド認可セット タイプ（Security Manager ではロールと呼ば

れている）によって提供されます。これらの権限（特権とも呼ばれる）によって、特定のロールを持つ

ユーザが Security Manager 内で実行できるアクションが決定されます。

表 8-2 Security Manager と CiscoWorks Common Services のロール関連付けに対するデフォルトの権限

権限

ロール

System 
Admin.

Security 
Admin.

Security 
Approve
r 

Network 
Admin.

Approve
r

Network 
Operato
r

Help 
Desk

表示権限

デバイスの表示 Yes Yes Yes Yes Yes Yes Yes

ポリシーの表示 Yes Yes Yes Yes Yes Yes Yes

オブジェクトの表示 Yes Yes Yes Yes Yes Yes Yes

トポロジの表示 Yes Yes Yes Yes Yes Yes Yes

CLI の表示 Yes Yes Yes Yes Yes Yes No

管理設定の表示 Yes Yes Yes Yes Yes Yes No

設定アーカイブの表示 Yes Yes Yes Yes Yes Yes Yes

デバイス マネージャの表示 Yes Yes Yes Yes Yes Yes No

変更権限

デバイスの変更 Yes Yes No No No No No

階層の変更 Yes Yes No No No No No

ポリシーの変更 Yes Yes No No No No No

イメージの変更 Yes Yes No No No No No

オブジェクトの変更 Yes Yes No No No No No

トポロジの変更 Yes Yes No No No No No

管理設定の変更 Yes No No No No No No

設定アーカイブの変更 Yes Yes No Yes No Yes No

その他の権限

ポリシーの割り当て Yes Yes No No No No No

ポリシーの承認 Yes No Yes No No No No

CLI の承認 Yes No No No Yes No No

検出（インポート） Yes Yes No No No No No

展開 Yes No No Yes No No No

制御 Yes No No Yes No Yes No

送信 Yes Yes No No No No No
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Cisco Secure ACS は、TACACS+ を使用して管理アプリケーションと通信します。Security Manager 
と Cisco Secure ACS が通信するためには、Cisco Secure ACS 内の CiscoWorks サーバを TACACS+ を
使用する AAA クライアントとして設定する必要があります。加えて、CiscoWorks サーバに Cisco 
Secure ACS へのログインに使用する管理者名とパスワードを提供する必要があります。これらの要件

を満たすことによって、Security Manager と Cisco Secure ACS 間の通信の有効性が保証されます。

（注） TACACS+ のセキュリティ メリットを理解するには、『User Guide for Cisco Secure Access Control 
Server』を参照してください。

Security Manager が初めて Cisco Secure ACS と通信するときに、デフォルト ロールの作成を Cisco 
ACS に指示します。このロールは、Cisco Secure ACS HTML インターフェイスの [Shared Profile 
Components] セクションに表示されます。また、TACACS+ による認可をカスタム サービスに指示し

ます。このカスタム サービスは、HTML インターフェイスの [Interface Configuration] セクション内

の [TACACS+ (Cisco IOS)] ページに表示されます。その後で、各 Security Manager ロールに含まれる

権限を変更したり、これらのロールをユーザとユーザ グループに適用したりできます。

次のトピックで、Cisco Secure ACS と Security Manager の使用方法について説明します。

• 「ACS 統合要件」（P.8-13）

• 「初期 Cisco Secure ACS セットアップ手順の概要」（P.8-14）

• 「Cisco Secure ACS で実行する統合手順」（P.8-15）

• 「CiscoWorks で実行する統合手順」（P.8-21）

• 「Daemon Manager の再起動」（P.8-25）

• 「Cisco Secure ACS でのユーザ グループへのロール割り当て」（P.8-26）

ACS 統合要件

Cisco Secure ACS を使用するには、次の手順を完了する必要があります。

• Security Manager 内で必要な機能を実行するために必要な権限を含むロールを定義しました。

• Network Access Restriction（NAR）には、NAR をプロファイルに適用する場合に管理するデバイ

ス グループ（またはデバイス）が含まれています。

• 管理対象デバイス名は、Cisco Secure ACS と Security Manager で綴りと大文字 /小文字を合わせ

る必要があります。この制限は、表示名に適用され、デバイス上で定義されるホスト名には適用さ

れません。ACS の命名制限は Security Manager の命名制限よりも厳密なため、先に、ACS 内でデ

バイスを定義する必要があります。

• PIX/ASA セキュリティ コンテキスト、FWSM、および IPS デバイスに関して満たさなければなら

ないその他のデバイス表示名要件があります。これらについては、「NDG を使用しないデバイスの 
AAA クライアントとしての追加」（P.8-17）に記載されています。

ヒント

• ACS 統合の前にデバイスが Security Manager にすでにインポートされている場合は、それらのデ

バイスを AAA クライアントとして ACS に追加してから統合することを推奨します。AAA クライ

アントの名前は、CSM 内でのデバイスの表示名と一致する必要があります。一致していないと、

それらのデバイスは、ACS 統合後に Security Manager のデバイス リストに表示されなくなりま

す。
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• 複数の Cisco Secure ACS サーバを使用するフォールトトレラントなインフラストラクチャの構築

を強く推奨します。複数のサーバを使用することによって、いずれかの ACS サーバの通信機能が

失われても、Security Manager 内の作業を継続できます。

• Cisco Secure ACS と統合できるのは 1 つのバージョンの Security Manager だけです。そのため、

組織で 2 つの異なるバージョンの Security Manager が同時に使用されている場合は、2 つの異なる 
Cisco Secure ACS サーバとの統合を実施する必要があります。ただし、別の ACS を使用しなくて

も、新しいバージョンの Security Manager にアップグレードできます。

• Cisco Secure ACS 認証が使用されている場合でも、CiscoWorks Common Services ソフトウェアは 
Compact Database や Database Checkpoint などの CiscoWorks Common Services 固有のユーティ

リティのローカル認可を使用します。これらのユーティリティを使用するには、ユーザをローカル

に定義して、適切な権限を付与する必要があります。

関連トピック

• 「初期 Cisco Secure ACS セットアップ手順の概要」（P.8-14）

• 「Security Manager と Cisco Secure ACS の統合」（P.8-12）

初期 Cisco Secure ACS セットアップ手順の概要

次の手順では、Cisco Secure ACS と Security Manager を使用して実行する必要のあるすべてのタスク

の概要を示します。この手順には、各ステップの実行に使用されるより詳しい手順への参照が含まれて

います。

関連トピック

• 「ACS 統合要件」（P.8-13）

• 「Security Manager と Cisco Secure ACS の統合」（P.8-12）

ステップ 1 管理認証および認可モデルを計画します。

Security Manager を使用する前に、管理モデルを決定する必要があります。これには、使用する予定

の管理ロールとアカウントの定義も含まれます。

ヒント 潜在的管理者のロールと権限を定義するときに、イネーブルにするワークフローも考慮する必

要があります。この選択は、アクセスの制限方法に影響します。

詳細については、次を参照してください。

• 「Cisco Secure ACS ロールについて」（P.8-9）

• 『User Guide for Cisco Security Manager』

• 『User Guide for Cisco Secure Access Control Server』

ステップ 2 Cisco Secure ACS、Cisco Security Manager、および CiscoWorks Common Services をインストー

ルします。

Cisco Secure ACS をインストールします。別のサーバ上に CiscoWorks Common Services と Cisco 
Security Manager をインストールします。Cisco Secure ACS と Security Manager を同じサーバ上で実

行しないでください。

詳細については、次を参照してください。

• 『Release Notes for Cisco Security Manager』（サポートされている Cisco Secure ACS のバージョ

ンの詳細）
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• 「Security Manager サーバ、Common Services、および AUS のインストール」（P.5-2）

• 『Installation Guide for Cisco Secure ACS for Windows Server』 

ステップ 3 Cisco Secure ACS で統合手順を実行します。

Security Manager ユーザを ACS ユーザとして定義し、それらを計画されたロールに基づいてユーザ グ
ループに割り当て、すべての管理対象デバイス（および CiscoWorks/Security Manager サーバ）を 
AAA クライアントとして追加し、管理制御ユーザを作成します。

詳細については、「Cisco Secure ACS で実行する統合手順」（P.8-15）を参照してください。

ステップ 4 CiscoWorks Common Services で統合手順を実行します。

Cisco Secure ACS で定義されたシステム識別ユーザと一致するローカル ユーザを設定し、同じユーザ

をシステム識別セットアップ用に定義し、ACS を AAA セットアップ モードとして設定し、SMTP 
サーバとシステム管理者の電子メール アドレスを設定します。

詳細については、「CiscoWorks で実行する統合手順」（P.8-21）を参照してください。

ステップ 5 Daemon Manager を再起動します。

Security Manager サーバの Daemon Manager を再起動して、構成した AAA 設定を有効にします。

詳細については、「Daemon Manager の再起動」（P.8-25）を参照してください。

ステップ 6 Cisco Secure ACS でユーザ グループにロールを割り当てます。

Cisco Secure ACS で設定されたユーザ グループごとにロールを割り当てます。使用すべき手順は、

Network Device Group（NDG; ネットワーク デバイス グループ）を設定したかどうかによって異なり

ます。

詳細については、「Cisco Secure ACS でのユーザ グループへのロール割り当て」（P.8-26）を参照して

ください。

Cisco Secure ACS で実行する統合手順

次のトピックで、Cisco Security Manager と統合する場合に Cisco Secure ACS で実行すべき手順につ

いて説明します。列挙された順にタスクを実行します。これらの項で説明する手順の詳細については、

『User Guide for Cisco Secure Access Control Server』を参照してください。

1. 「Cisco Secure ACS でのユーザとユーザ グループの定義」（P.8-15）

2. 「Cisco Secure ACS での管理対象デバイスの AAA クライアントとしての追加」（P.8-17）

3. 「Cisco Secure ACS での管理制御ユーザの作成」（P.8-21）

Cisco Secure ACS でのユーザとユーザ グループの定義

Security Manager のすべてのユーザを Cisco Secure ACS で定義し、彼らの職務権限に応じたロールを

割り当てる必要があります。この最も簡単な方法は、ACS で使用可能なデフォルト ロールに従って

ユーザを複数のグループに分ける方法です。たとえば、すべてのシステム管理者をあるグループに割り

当て、すべてのネットワーク オペレータを別のグループに割り当てるといった具合です。ACS 内のデ

フォルト ロールの詳細については、「Cisco Secure ACS デフォルト ロール」（P.8-10）を参照してくだ

さい。

デバイスに対するフル権限を持つ System Administrator ロールを割り当てる新しいユーザを作成する

必要があります。このユーザに対して設定された資格情報が、後で、CiscoWorks の [System Identity 
Setup] ページで使用されます。「システム識別ユーザの定義」（P.8-22）を参照してください。
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この段階で、ユーザを複数のグループに割り当てることはまれであることに注意してください。これら

のグループに対する実際のロールの割り当ては、CiscoWorks、Security Manager、およびその他のア

プリケーションが Cisco Secure ACS に登録された後で実行されます。

ヒント この手順では、初期 Cisco Secure ACS 統合中のユーザ アカウントの作成方法について説明します。統

合を完了したら、ユーザ アカウントを作成して、適切なグループに割り当てることができます。

関連トピック

• 「ACS 統合要件」（P.8-13）

• 「初期 Cisco Secure ACS セットアップ手順の概要」（P.8-14）

• 「Cisco Secure ACS でのユーザ グループへのロール割り当て」（P.8-26）

ステップ 1 Cisco Secure ACS にログインします。

ステップ 2 次の手順を使用して、フル権限を持つユーザを設定します。ユーザとユーザ グループの設定時に使用

可能なオプションの詳細については、『User Guide for Cisco Secure Access Control Server』を参照して

ください。

a. ナビゲーション バーの [User Setup] をクリックします。

b. [User Setup] ページで、新しいユーザの名前を入力して [Add/Edit] をクリックします。

ヒント admin という名前のユーザは作成しないでください。admin ユーザは Security Manager の
フォールバック ユーザです。ACS システムが何らかの理由で停止した場合は、admin アカウ

ントを使用して Security Manager サーバ上の CiscoWorks Common Services にログインし、

AAA モードを CiscoWorks ローカル認証に変更して、製品の使用を続けることができます。

c. [User Setup] の下の [Password Authentication] リストから認証方式を選択します。

d. 新しいユーザのパスワードを入力して確認します。

e. ユーザに割り当てるべきグループとして [Group 1] を選択します。

f. [Submit] をクリックしてユーザ アカウントを作成します。

ステップ 3 Security Manager ユーザごとにこのプロセスを繰り返します。ユーザは割り当てられたロールに基づ

いてグループに分けることを推奨します。

• グループ 1：System Administrator

• グループ 2：Security Administrator

• グループ 3：Security Approver

• グループ 4：Network Administrator

• グループ 5：Approver

• グループ 6：Network Operator

• グループ 7：Help Desk

各ロールに関連付けられたデフォルト権限の詳細については、「Security Manager 内の権限とロールの

デフォルトの関連付け」（P.8-11）を参照してください。ユーザ ロールのカスタマイズ方法については、

「Cisco Secure ACS ロールのカスタマイズ」（P.8-11）を参照してください。
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（注） この段階で、グループはどのロールも定義されていないユーザの集合でしかありません。統合

プロセスが完了してから、各ユーザにロールを割り当てます。「Cisco Secure ACS でのユーザ 
グループへのロール割り当て」（P.8-26）を参照してください。

ステップ 4 CiscoWorks Common Services でシステム識別ユーザとして使用する新しいユーザを作成します。この

ユーザをシステム管理者グループに割り当て、デバイスに対するすべての特権を付与します。このユー

ザに対して設定された資格情報が、後で、CiscoWorks の [System Identity Setup] ページで使用されま

す。「システム識別ユーザの定義」（P.8-22）を参照してください。

ステップ 5 「Cisco Secure ACS での管理対象デバイスの AAA クライアントとしての追加」（P.8-17）に進みます。

Cisco Secure ACS での管理対象デバイスの AAA クライアントとしての追加 

Security Manager にデバイスをインポートするには、Cisco Secure ACS で各デバイスを AAA クライ

アントとして設定する必要があります。加えて、CiscoWorks/Security Manager サーバを AAA クライ

アントとして設定する必要があります。

Security Manager が、Catalyst 6500/7600 デバイス用の FWSM を含むファイアウォール デバイス上で

設定されたセキュリティ コンテキストを管理している場合は、それぞれのコンテキストを個別に Cisco 
Secure ACS に追加する必要があります。同様に、IPS デバイス上で定義されたすべての仮想センサー

を追加する必要もあります。

管理対象デバイスを追加する方式は、NDG を作成して特定のデバイス セットの管理にユーザを制限す

るかどうかによって異なります。次のように進めます。

• すべてのデバイスへのアクセスをユーザに許可する場合は、「NDG を使用しないデバイスの AAA 
クライアントとしての追加」（P.8-17）に記載されているようにデバイスを追加します。

• 特定の NDG へのアクセスだけをユーザに許可する場合は、「Security Manager で使用するネット

ワーク デバイス グループの設定」（P.8-18）に記載されているようにデバイスを追加します。

NDG を使用しないデバイスの AAA クライアントとしての追加 

この手順では、デバイスを Cisco Secure ACS の AAA クライアントとして追加する方法について説明

します。使用可能なオプションの詳細については、『User Guide for Cisco Secure Access Control 
Server』を参照してください。

ヒント CiscoWorks/Security Manager サーバを AAA クライアントとして追加することを忘れないでください。

関連トピック

• 「ACS 統合要件」（P.8-13）

• 「初期 Cisco Secure ACS セットアップ手順の概要」（P.8-14）

ステップ 1 Cisco Secure ACS のナビゲーション バーで、[Network Configuration] をクリックします。

ステップ 2 [AAA Clients] テーブルの下で [Add Entry] をクリックします。

ステップ 3 [Add AAA Client] ページで AAA クライアントのホスト名（32 文字以下）を入力します。AAA クライ

アントのホスト名は、Security Manager 内でデバイスとして使用する予定の表示名と一致させる必要
があります。
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たとえば、Security Manager でドメイン名をデバイス名に付加する場合は、ACS 内の AAA クライア

ントのホスト名を <device_name>.<domain_name> にする必要があります。

CiscoWorks サーバに名前を付ける場合は、完全修飾ホスト名を使用することを推奨します。ホスト名

の綴りが正しいことを確認してください （ホスト名は大文字と小文字が区別されません）。

その他の命名規則を次に示します。

• PIX または ASA セキュリティ コンテキスト、あるいは、FWSM 経由で検出された FWSM セキュ

リティ コンテキスト：<parent_display_name>_<context_name>

• FWSM ブレード：<chassis_name>_FW_<slot_number>

• シャーシ経由で検出された FWSM セキュリティ コンテキスト：
<chassis_name>_FW_<slot_number>_<context_name>

• IPS センサー：<IPSParentName>_<virtualSensorName>

ステップ 4 [AAA Client IP Address] フィールドにネットワーク デバイスの IP アドレスを入力します。デバイスに 
IP アドレスが設定されていない場合（仮想センサーや仮想コンテキストなど）は、アドレスの代わり

に単語の dynamic を入力します。

（注） マルチホーム デバイス（複数の NIC が実装されたデバイス）を追加している場合は、各 NIC 
の IP アドレスを入力します。各アドレスの間で Enter を押します。加えて、Security Manager 
サーバ上の gatekeeper.cfg ファイルを変更する必要があります。

ステップ 5 [Key] フィールドに共有秘密キーを入力します。

ステップ 6 [Authenticate Using] リストから [TACACS+ (Cisco IOS)] を選択します。

ステップ 7 [Submit] をクリックして、変更を保存します。追加したデバイスが [AAA Clients] テーブル内に表示

されます。

ステップ 8 このプロセスを繰り返して、新しいデバイスを追加します。

ステップ 9 追加したデバイスを保存するには、[Submit + Restart] をクリックします。

ステップ 10 「Cisco Secure ACS での管理制御ユーザの作成」（P.8-21）に進みます。

Security Manager で使用するネットワーク デバイス グループの設定 

Cisco Secure ACS を使用すれば、特定の管理対象デバイスを含む NDG を設定できます。たとえば、

地理的地域別の NDG や組織構造と一致する NDG を作成できます。NDG を Security Manager と一緒

に使用すれば、管理対象デバイスに応じて、さまざまなレベルの権限をユーザに付与できます。たとえ

ば、NDG を使用することによって、ユーザ A に、ヨーロッパに設置されたデバイスに対するシステム

管理者権限とアジアに設置されたデバイスに対するヘルプ デスク権限を割り当てることができます。

その後で、正反対の権限をユーザ B に割り当てることができます。

NDG は直接はユーザに割り当てません。その代わりに、ユーザ グループごとに定義したロールに 
NDG を割り当てます。各 NDG は 1 つのロールにしか割り当てることができませんが、各ロールに複

数の NDG を含めることができます。これらの定義は、選択されたユーザ グループの定義の一部として

保存されます。

ヒント

• 各デバイスは 1 つの NDG のメンバーにしかなれません。

• NDG は、Security Manager で設定可能なデバイス グループに関連付けられません。
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• NDG の管理方法については、『User Guide for Cisco Secure Access Control Server』を参照してく

ださい。

次のトピックで、NDG の設定に関する基本的な情報とステップについて説明します。

• 「NDG とユーザ権限」（P.8-19）

• 「NDG 機能のアクティブ化」（P.8-19）

• 「NDG の作成」（P.8-20）

• 「NDG とロールのユーザ グループへの関連付け」（P.8-27）

NDG とユーザ権限

NDG はユーザを特定のデバイス セットに制限するため、次のように、ポリシー権限に影響します。

• ポリシーを表示するには、そのポリシーが割り当てられた少なくとも 1 つのデバイスに対する権限

を持っている必要があります。

• ポリシーを変更するには、そのポリシーが割り当てられたすべてのデバイスに対する権限を持って

いる必要があります。

• VPN ポリシーを表示、変更、または割り当てるには、VPN トポロジ内のすべてのデバイスに対す

る権限を持っている必要があります。

• デバイスにポリシーを割り当てるには、ポリシーが割り当てられた他のデバイスに対する権限を

持っているかどうかに関係なく、そのデバイスの権限のみが必要です （上述したように、VPN ポ
リシーは例外です）。ただし、権限を持っていないデバイスに割り当てられているポリシーを変更

することはできません。

（注） オブジェクトを変更するには、そのオブジェクトを使用しているすべてのデバイスに対する変更権限を

持っている必要はありません。ただし、そのデバイス上で定義されたデバイスレベルのオブジェクトの

上書きを変更するには、特定のデバイスに対する変更権限を持っている必要があります。

関連トピック

• 「Security Manager で使用するネットワーク デバイス グループの設定」（P.8-18）

• 「ユーザの権限」（P.8-3）

NDG 機能のアクティブ化

NDG を作成して、デバイスを追加するには、NDG 機能をアクティブにする必要があります。

関連トピック

• 「NDG の作成」（P.8-20）

• 「NDG とロールのユーザ グループへの関連付け」（P.8-27）

• 「NDG とユーザ権限」（P.8-19）

• 「Security Manager で使用するネットワーク デバイス グループの設定」（P.8-18）

ステップ 1 Cisco Secure ACS のナビゲーション バーで、[Interface Configuration] をクリックします。

ステップ 2 [Advanced Options] をクリックします。

ステップ 3 スクロール ダウンしてから、[Network Device Groups] チェックボックスをオンにします。

ステップ 4 [Submit] をクリックします。
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ステップ 5 「NDG の作成」（P.8-20）に進みます。

NDG の作成

この手順では、NDG を作成して、デバイスを追加する方法について説明します。各デバイスは 1 つの 
NDG にしか属することができません。

ヒント CiscoWorks/Security Manager サーバを含む特別な NDG を作成することを強く推奨します。

はじめる前に

「NDG 機能のアクティブ化」（P.8-19）に記載されているように、NDG 機能をアクティブにします。

関連トピック

• 「NDG とロールのユーザ グループへの関連付け」（P.8-27）

• 「NDG とユーザ権限」（P.8-19）

• 「Security Manager で使用するネットワーク デバイス グループの設定」（P.8-18）

ステップ 1 ナビゲーション バーで、[Network Configuration] をクリックします。

最初は、すべてのデバイスが Not Assigned に配置されます。この場所には、NDG 内に存在しなかった

すべてのデバイスが保存されます。Not Assigned は NDG でないことに注意してください。

ステップ 2 NDG を作成します。

a. [Add Entry] をクリックします。

b. [New Network Device Group] ページで、NDG の名前を入力します。最大長は 24 文字です。ス

ペースを使用できます。

c. （任意）NDG 内のすべてのデバイスで使用されるキーを入力します。NDG 用のキーを定義する

と、NDG 内の個別のデバイスに対して定義されたすべてのキーが上書きされます。

d. [Submit] をクリックして NDG を保存します。

e. このプロセスを繰り返して、新しい NDG を作成します。

ステップ 3 NDG にデバイスを追加します。各デバイスは 1 つの NDG のメンバーにしかなれないことに注意して

ください。

a. [Network Device Groups] エリアで、NDG の名前をクリックします。

b. [AAA Clients] エリアで、[Add Entry] をクリックします。

c. NDG に追加するデバイスの詳細を定義してから、[Submit] をクリックします。詳細については、

「NDG を使用しないデバイスの AAA クライアントとしての追加」（P.8-17）を参照してください。

d. このプロセスを繰り返して、残りのデバイスを NDG に追加します。Not Assigned カテゴリに残す

ことを検討すべき唯一のデバイスが、デフォルト AAA サーバです。

e. 最後のデバイスを設定したら、[Submit + Restart] をクリックします。

ステップ 4 「Cisco Secure ACS での管理制御ユーザの作成」（P.8-21）に進みます。
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ヒント Cisco Secure ACS と CiscoWorks Common Services の統合プロセスが完了しなければ、ロール

を各 NDG に関連付けることができません。「NDG とロールのユーザ グループへの関連付け」

（P.8-27）を参照してください。

Cisco Secure ACS での管理制御ユーザの作成

Cisco Secure ACS の [Administration Control] ページを使用して、CiscoWorks Common Services の 
AAA セットアップ モードの定義に使用される管理者アカウントを定義します。Security Manager は、

このアカウントを使用して、ACS サーバにアクセスしてアプリケーションを登録したり、デバイス グ
ループ メンバーシップとグループ セットアップを問い合わせたり、その他の基本的な ACS とのデータ

のやり取りを行ったりします。詳細については、「CiscoWorks での AAA セットアップ モードの設定」

（P.8-23）を参照してください。

関連トピック

• 「ACS 統合要件」（P.8-13）

• 「初期 Cisco Secure ACS セットアップ手順の概要」（P.8-14）

ステップ 1 Cisco Secure ACS のナビゲーション バーで、[Administration Control] をクリックします。

ステップ 2 [Add Administrator] をクリックします。

ステップ 3 [Add Administrator] ページで、管理者の名前とパスワードを入力します。

ステップ 4 次の管理者特権を選択します。

• Under Users and Group Setup

– グループ内のユーザに対する読み取りアクセス

– これらのグループの読み取りアクセス

• Under Shared Profile Components

– デバイス コマンド セット タイプの作成

• ネットワーク設定

ステップ 5 [Submit] をクリックして管理者を作成します。管理者の設定時に使用可能なオプションの詳細につい

ては、『User Guide for Cisco Secure Access Control Server』を参照してください。

CiscoWorks で実行する統合手順 
Cisco Secure ACS での統合タスク（「Cisco Secure ACS で実行する統合手順」（P.8-15）を参照）が完

了したら、CiscoWorks Common Services でいくつかのタスクを完了する必要があります。Common 
Services は、Cisco Security Manager や Auto Update Server などのインストール対象アプリケーション

の Cisco Secure ACS への登録を実行します。

次のトピックで、Cisco Security Manager と統合する場合に CiscoWorks Common Services で実行する

手順について説明します。

• 「CiscoWorks でのローカル ユーザの作成」（P.8-22）
8-21
Cisco Security Manager 4.4 インストレーション ガイド

OL-28767-01-J

http://www.cisco.com/en/US/products/sw/secursw/ps2086/products_user_guide_list.html


 

第 8 章      ユーザ アカウントの管理

    Security Manager と Cisco Secure ACS の統合
• 「システム識別ユーザの定義」（P.8-22）

• 「CiscoWorks での AAA セットアップ モードの設定」（P.8-23）

• 「ACS ステータス通知用の SMTP サーバとシステム管理者の電子メール アドレスの設定」

（P.8-25）

CiscoWorks でのローカル ユーザの作成

CiscoWorks Common Services の [Local User Setup] ページを使用して、Cisco Secure ACS で作成さ

れたシステム識別ユーザ（「Cisco Secure ACS でのユーザとユーザ グループの定義」（P.8-15）を参照）

とまったく同じローカル ユーザ アカウントを作成します。このローカル ユーザ アカウントは、後で、

システム識別セットアップに使用されます。詳細については、「システム識別ユーザの定義」（P.8-22）
を参照してください。

関連トピック

• 「ACS 統合要件」（P.8-13）

• 「初期 Cisco Secure ACS セットアップ手順の概要」（P.8-14）

ステップ 1 次のパスに従い、Common Services の [Local User Setup] ページに移動します。

Security Manager がインストールされているサーバ > 

Cisco Security Manager アプリケーションのデスクトップ アイコン > 

admin アカウント ログイン > 

[Server Administration] > 

[Server] >（メニュー セレクタ記号）>

[Security] > 

[Single-Server Management] > 

[Local User Setup]

ステップ 2 [Add] をクリックします。

ステップ 3 Cisco Secure ACS でシステム識別ユーザを作成したときに入力したものと同じ名前とパスワードを入

力します。「Cisco Secure ACS でのユーザとユーザ グループの定義」（P.8-15）を参照してください。

ステップ 4 [Roles] の下のチェックボックスをすべてオンにします。

ステップ 5 [OK] をクリックしてユーザを作成します。

システム識別ユーザの定義 

CiscoWorks Common Services の [System Identity Setup] ページを使用して、同じサーバ上に配置され

た同じドメインおよびアプリケーション プロセスに属しているサーバ間通信をイネーブルにする信頼

ユーザ（システム識別ユーザと呼ばれる）を作成します。アプリケーションは、システム識別ユーザを

使用して、リモート CiscoWorks サーバ上のプロセスを認証します。これは、特に、ユーザのログイン

前に、アプリケーションの同期化が必要な場合に役立ちます。

加えて、システム識別ユーザは、プライマリ タスクがすでにログイン ユーザに対して認可されている

場合にサブタスクを実行するためによく使用されます。
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ここで設定したシステム識別ユーザは、CiscoWorks ではローカル ユーザとして（すべてのロールが割

り当てられる）、ACS ではデバイスに対するすべての特権を持つユーザとして定義する必要もありま

す。必要な特権を持つユーザを選択しなかった場合は、Security Manager で設定されたすべてのデバ

イスとポリシーを表示できない可能性があります。先に進む前に次の手順を実行したことを確認してく

ださい。

• 「Cisco Secure ACS でのユーザとユーザ グループの定義」（P.8-15）

• 「CiscoWorks でのローカル ユーザの作成」（P.8-22）

関連トピック

• 「ACS 統合要件」（P.8-13）

• 「初期 Cisco Secure ACS セットアップ手順の概要」（P.8-14）

ステップ 1 次のパスに従い、Common Services の [System Identify Setup] ページに移動します。

Security Manager がインストールされているサーバ > 

Cisco Security Manager アプリケーションのデスクトップ アイコン > 

admin アカウント ログイン > 

[Server Administration] > 

[Server] >（メニュー セレクタ記号）>

[Security] > 

[Multi-Server Trust Management] > 

[System Identity Setup]

ステップ 2 Cisco Secure ACS で作成したシステム識別ユーザの名前を入力します。「Cisco Secure ACS でのユー

ザとユーザ グループの定義」（P.8-15）を参照してください。

ステップ 3 このユーザのパスワードを入力して確認します。

ステップ 4 [Apply] をクリックします。

CiscoWorks での AAA セットアップ モードの設定 

CiscoWorks Common Services の [AAA Setup Mode] ページを使用して、Cisco Secure ACS を必要な

ポートと共有秘密キーを含む AAA サーバとして定義します。加えて、最大 2 台のバックアップ サーバ

を定義できます。

この手順は、CiscoWorks と Security Manager（およびオプションの Auto Update Server）の Cisco 
Secure ACS への登録を実行します。

ヒント CiscoWorks Common Services または Cisco Security Manager をアンインストールした場合は、ここで

設定した AAA セットアップが保存されません。加えて、この設定はバックアップして再インストール

後に復元できません。そのため、いずれかのアプリケーションの新しいバージョンにアップグレードす

る場合は、AAA セットアップ モードを再設定して、Security Manager を ACS に再登録する必要があ

ります。差分アップデートの場合は、このプロセスが必要ありません。AUS などの新しいアプリケー

ションを CiscoWorks 上にインストールする場合は、そのアプリケーションと Cisco Security Manager 
を再登録する必要があります。ACS への Security Manager の再登録以外に、既存のシステム識別ユー

ザを設定し、新しく導入された権限を付与する必要があります。そうしないと、RBAC が正常に機能

しません。「システム識別ユーザの定義」（P.8-22）を参照してください。
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関連トピック

• 「ACS 統合要件」（P.8-13）

• 「初期 Cisco Secure ACS セットアップ手順の概要」（P.8-14）

ステップ 1 次のパスに従い、Common Services の [AAA Mode Setup] ページに移動します。

Security Manager がインストールされているサーバ > 

Cisco Security Manager アプリケーションのデスクトップ アイコン > 

admin アカウント ログイン > 

[Server Administration] > 

[Server] >（メニュー セレクタ記号）>

[Security] > 

[AAA Mode Setup] 

ステップ 2 [Available Login Modules] の下で [TACACS+] を選択します。

ステップ 3 AAA タイプとして [ACS] を選択します。

ステップ 4 最大 3 つの Cisco Secure ACS サーバの IP アドレスを [Server Details] エリアに入力します。セカンダ

リ サーバとターシャリ サーバは、プライマリ サーバで障害が発生した場合のバックアップとして機能

します。すべてのサーバで同じバージョンの Cisco Secure ACS が実行している必要があります。

（注） 設定されたすべての TACACS+ サーバが応答しなかった場合は、admin CiscoWorks ローカル 
アカウントを使用してログインしてから、AAA モードを Non-ACS/CiscoWorks Local に変更

する必要があります。TACACS+ サーバのサービスが回復されたら、AAA モードを ACS に変

更する必要があります。

ステップ 5 [Login] エリアで、Cisco Secure ACS の [Administration Control] ページで定義した管理者の名前を入

力します。詳細については、「Cisco Secure ACS での管理制御ユーザの作成」（P.8-21）を参照してく

ださい。

ステップ 6 この管理者のパスワードを入力して確認します。

ステップ 7 Security Manager サーバを Cisco Secure ACS の AAA クライアントとして追加したときに入力した共

有秘密キーを入力して確認します。「NDG を使用しないデバイスの AAA クライアントとしての追加」

（P.8-17）を参照してください。

ステップ 8 [Register all installed applications with ACS] チェックボックスをオンにして、Security Manager とそ

の他のインストール済みアプリケーションを Cisco Secure ACS に登録します。

ステップ 9 [Apply] をクリックして設定値を保存します。経過表示バーに登録の進捗が表示されます。登録が完了

するとメッセージが表示されます。

ステップ 10 Cisco Security Manager の Daemon Manager サービスを再起動します。「Daemon Manager の再起動」

（P.8-25）を参照してください。

ステップ 11 Cisco Secure ACS に再ログインしてロールを各ユーザ グループに割り当てます。「Cisco Secure ACS 
でのユーザ グループへのロール割り当て」（P.8-26）を参照してください。
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ACS ステータス通知用の SMTP サーバとシステム管理者の電子メール アドレスの設定

すべての ACS サーバが使用不能になった場合は、Security Manager でタスクを実行できません。ログ

イン ユーザは、ACS 認可が必要なタスクを実行しようとすると、強制的に（変更を保存する機会を与

えられずに）アプリケーションからログアウトされます。

SMTP サーバとシステム管理者を識別するように Common Services を設定した場合は、すべての ACS 
サーバが使用不能になったときに、Security Manager から管理者に電子メール メッセージが送信され

ます。このメッセージにより、早急な対応を必要とする問題に対して警告を出すことができます。管理

者は、Common Services から非 ACS 関連イベントに関する電子メール メッセージを受け取ることもあ

ります。

ヒント Security Manager は、展開ジョブの完了、アクティビティの承認、ACL ルールの期限切れなどのイベ

ント タイプに関する電子メール通知を送信できます。ここで設定する SMTP サーバはこれらの通知に

も使用されますが、送信者の電子メール アドレスは Security Manager で設定されます。このような電

子メール アドレスの設定方法については、このバージョンの製品の『User Guide for Cisco Security 
Manager』か、クライアントのオンライン ヘルプを参照してください。

ステップ 1 次のパスに従い、Common Services の [System Preferences] ページに移動します。

Security Manager がインストールされているサーバ > 

Cisco Security Manager アプリケーションのデスクトップ アイコン > 

admin アカウント ログイン > 

[Server Administration] > 

[Server] >（メニュー セレクタ記号）>

[Admin] > 

[System Preferences] 

ステップ 2 [System Preferences] ページで、Security Manager が使用可能な SMTP サーバのホスト名または IP ア
ドレスを入力します。SMTP サーバは、電子メール メッセージの送信に対してユーザ認証を要求でき

ません。

ステップ 3 CiscoWorks が電子メールの送信に使用可能な電子メール アドレスを入力します。これは、Security 
Manager の通知の送信に使用される電子メール アドレスと同じにする必要はありません。

ACS サーバが使用不能になると、このアカウントに（およびこのアカウントから）メッセージが送信

されます。

ステップ 4 [Apply] をクリックして変更内容を保存します。

Daemon Manager の再起動

この手順では、Security Manager サーバの Daemon Manager の再起動方法について説明します。この

操作は、構成した AAA 設定値を有効にするために行う必要があります。そうすれば、Cisco Secure 
ACS で定義された資格情報を使用して CiscoWorks に再ログインできます。

関連トピック

• 「初期 Cisco Secure ACS セットアップ手順の概要」（P.8-14）

• 「ACS 統合要件」（P.8-13）
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ステップ 1 Security Manager サーバがインストールされたマシンにログインします。

ステップ 2 [Start] > [Programs] > [Administrative Tools] > [Services] を選択して [Services] ウィンドウを開きま

す。

ステップ 3 右ペインに表示されたサービスのリストから、[Cisco Security Manager Daemon Manager] を選択しま

す。

ステップ 4 ツールバーで [Restart Service] ボタンをクリックします。

ステップ 5 「Cisco Secure ACS でのユーザ グループへのロール割り当て」（P.8-26）に進みます。

Cisco Secure ACS でのユーザ グループへのロール割り当て 
CiscoWorks、Security Manager、およびその他のインストール済みアプリケーションを Cisco Secure 
ACS に登録したら、Cisco Secure ACS で設定したユーザ グループのそれぞれにロールを割り当てるこ

とができます。これらのロールによって、各グループ内のユーザが Security Manager で実行を許可さ

れるアクションが決定されます。

ユーザ グループにロールを割り当てる手順は、NDG が使用されるかどうかによって異なります。

• 「NDG を使用しないユーザ グループへのロールの割り当て」（P.8-26）

• 「NDG とロールのユーザ グループへの関連付け」（P.8-27）

NDG を使用しないユーザ グループへのロールの割り当て 

この手順では、NDG が定義されていない場合のユーザ グループへのデフォルト ロールの割り当て方法

について説明します。詳細については、「Cisco Secure ACS デフォルト ロール」（P.8-10）を参照して

ください。

はじめる前に

• デフォルト ロールごとにユーザ グループを作成します。「Cisco Secure ACS でのユーザとユーザ 
グループの定義」（P.8-15）を参照してください。

• 次のトピックに記載された手順を実行します。

– 「Cisco Secure ACS で実行する統合手順」（P.8-15）

– 「CiscoWorks で実行する統合手順」（P.8-21）

関連トピック

• 「CiscoWorks ロールについて」（P.8-6）

• 「Cisco Secure ACS ロールについて」（P.8-9）

ステップ 1 Cisco Secure ACS にログインします。

ステップ 2 ナビゲーション バーの [Group Setup] をクリックします。

ステップ 3 リストからシステム管理者用のユーザ グループを選択（「Cisco Secure ACS でのユーザとユーザ グ
ループの定義」（P.8-15）を参照）してから、[Edit Settings] をクリックします。
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ヒント グループ名を意味のある名前に変更して、正しいグループを特定しやすいようにすることがで

きます。グループを選択して、[Rename Group] をクリックし、名前を変更します。

ステップ 4 このグループに System Administrator ロールを割り当てます。

a. [TACACS+ Settings] の下の [CiscoWorks] エリアまでスクロール ダウンします。

b. 最初の [Assign] オプションを選択して、CiscoWorks ロールのリストから [System Administrator] 
を選択します。

c. [Cisco Security Manager Shared Services] エリアまでスクロール ダウンします。

d. 最初の [Assign] オプションを選択して、Cisco Secure ACS ロールのリストから [System 
Administrator] を選択します。

e. [Submit] をクリックして、グループ設定を保存します。

ステップ 5 残りのロールに対してこのプロセスを繰り返して、各ロールを適切なユーザ グループに割り当てます。

Cisco Secure ACS で [Security Approver] ロールまたは [Security Administrator] ロールを選択すると

きは、最も近い CiscoWorks ロールとして [Network Administrator] を選択することを推奨します。

ACS 内のデフォルト ロールのカスタマイズ方法については、「Cisco Secure ACS ロールのカスタマイ

ズ」（P.8-11）を参照してください。

NDG とロールのユーザ グループへの関連付け 

NDG とロールを関連付けて Security Manager で使用する場合は、[Group Setup] ページの次の 2 か所

で定義を作成する必要があります。

• [CiscoWorks] エリア

• [Cisco Security Manager] エリア

各エリア内の定義は、できるだけ細部まで一致する必要があります。CiscoWorks Common Services 内
に存在しないカスタム ロールまたは ACS ロールを関連付ける場合は、そのロールに割り当てられた権

限に基づいて、できるだけ近い定義を作成するようにします。

Security Manager で使用されるユーザ グループごとの関連付けを作成する必要があります。たとえば、

西部地域のサポート担当者を含むユーザ グループがある場合は、そのユーザ グループを選択して、西

部地域内のデバイスを含む NDG と Help Desk ロールを関連付けることができます。

はじめる前に

NDG 機能をアクティブにして、NDG を作成します。「Security Manager で使用するネットワーク デバ

イス グループの設定」（P.8-18）を参照してください。

関連トピック

• 「ACS 統合要件」（P.8-13）

• 「初期 Cisco Secure ACS セットアップ手順の概要」（P.8-14）

ステップ 1 ナビゲーション バーの [Group Setup] をクリックします。

ステップ 2 [Group] リストからユーザ グループを選択してから、[Edit Settings] をクリックします。
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ヒント グループ名を意味のある名前に変更して、正しいグループを特定しやすいようにすることがで

きます。グループを選択して、[Rename Group] をクリックし、名前を変更します。

ステップ 3 CiscoWorks 内で使用する NDG とロールをマップします。

a. [Group Setup] ページで、[TACACS+ Settings] の下の [CiscoWorks] エリアまでスクロール ダウン

します。

b. [Assign a Ciscoworks on a per Network Device Group Basis] を選択します。

c. [Device Group] リストから NDG を選択します。

d. この NDG を関連付けるべきロールを 2 つめのリストから選択します。

e. [Add Association] をクリックします。関連付けが [Device Group] ボックスに表示されます。

f. このプロセスを繰り返して、新しい関連付けを作成します。

g. 関連付けを削除するには、[Device Group] からそれを選択して、[Remove Association] をクリッ

クします。

ステップ 4 Cisco Security Manager 内で使用する NDG とロールをマップします。以前のステップで定義した関連

付けにできるだけ近い関連付けを作成する必要があります。

a. [Group Setup] ページで、[TACACS+ Settings] の下の [Cisco Security Manager] エリアまでスク

ロール ダウンします。

b. [Assign a Cisco Security Manager on a per Network Device Group Basis] を選択します。

c. [Device Group] リストから NDG を選択します。

d. この NDG を関連付けるべきロールを 2 つめのリストから選択します。

e. [Add Association] をクリックします。関連付けが [Device Group] ボックスに表示されます。

f. このプロセスを繰り返して、新しい関連付けを作成します。

（注） Cisco Secure ACS で [Security Approver] ロールまたは [Security Administrator] ロールを選択

するときは、最も近い CiscoWorks ロールとして [Network Administrator] を選択することを推

奨します。

（注） CiscoWorks Common Services には「Network Administrator」というデフォルトのロールがあ

ります。Cisco Secure ACS には「Network Admin」というデフォルトのロールがあります。こ

れらのロールは同一ではありません。Cisco Security Manager 内での権限のいくつかについて、

ロールが異なっています。

ステップ 5 [Submit] をクリックして設定値を保存します。

ステップ 6 このプロセスを繰り返して、残りのユーザ グループ用の NDG を定義します。

ステップ 7 作成した関連付けを保存するには、[Submit + Restart] をクリックします。

ACS 内のデフォルト ロールのカスタマイズ方法については、「Cisco Secure ACS ロールのカスタマイ

ズ」（P.8-11）を参照してください。
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Security Manager と ACS の相互作用のトラブルシュー
ティング

次のトピックで、Security Manager と Cisco Secure ACS の相互作用のやり方が原因で発生する可能性

のある一般的な問題の解決方法について説明します。

• 「複数のバージョンの Security Manager と 1 つの ACS の使用」（P.8-29）

• 「ACS モードで認証に失敗する」（P.8-29）

• 「読み取り専用アクセスが付与されたシステム管理者」（P.8-30）

• 「ACS の変更が Security Manager に表示されない」（P.8-30）

• 「ACS で設定されたデバイスが Security Manager に表示されない」（P.8-31）

• 「Cisco Secure ACS が到達不能になった後の Security Manager での作業」（P.8-31）

• 「Cisco Secure ACS へのアクセスの復元」（P.8-31）

• 「マルチホーム デバイスに伴う認証の問題」（P.8-32）

• 「NAT 境界の背後に設置されたデバイスに伴う認証の問題」（P.8-32）

複数のバージョンの Security Manager と 1 つの ACS の使用

1 つの Cisco Secure ACS と 2 つの異なるバージョンの Security Manager を一緒には使用できません。

たとえば、Security Manager 3.3.1 と Cisco Secure ACS を統合してから、別の部署で既存のインス

トールをアップグレードせずに Security Manager 4.0.1 の使用を計画している場合は、Security 
Manager 4.0.1 と、Security Manager 3.3.1 用に使用されているものとは別の ACS を統合する必要があ

ります。

既存の Security Manager インストールをアップグレードすれば、同じ Cisco Secure ACS を使用し続け

ることができます。必要に応じて、権限設定が更新されます。

ACS モードで認証に失敗する

Security Manager または CiscoWorks Common Services にログインしようとして続けて認証が失敗す

る場合は、Common Services を使用して Cisco Secure ACS を認証用の AAA サーバとして設定してい

たとしても、次の手順を実行します。

• ACS サーバと、Common Services と Security Manager を実行しているサーバ間の接続が確立され

ていることを確認します。

• 使用しているユーザ資格情報（ユーザ名とパスワード）が ACS 内で定義されており、適切なユー

ザ グループに割り当てられていることを確認します。

• ACS の [Network Configuration] ページで、Common Services サーバが AAA クライアントとして

定義されていることを確認します。Common Services（[AAA Mode Setup] ページ）と ACS
（[Network Configuration]）で定義された共有秘密キーが一致することを確認します。

• Common Services の [AAA Mode Setup] ページで、各 ACS サーバの IP アドレスが正しく定義さ

れていることを確認します。

• ACS の [Administration Control] ページで、正しいアカウントが定義されていることを確認しま

す。
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• Common Services の [AAA Mode Setup] ページにアクセスして、Common Services と Security 
Manager（および AUS などの他のインストール済みアプリケーション）が Cisco Secure ACS に登

録されていることを確認します。

• ACS で [Administration Control] > [Access Setup] に移動して、ACS が HTTPS 通信用に設定され

ていることを確認します。

• ACS ログに「key mismatch」エラーが書き込まれている場合は、Security Manager サーバがネッ

トワーク デバイス グループ（NDG）のメンバーとして定義されているかどうかを確認します。そ

の場合は、NDG 用のキーが事前に定義されていれば、そのキーが Security Manager サーバを含む 
NDG 内の個々のデバイスに対して定義されたキーよりも優先されることに注意してください。

NDG 用に定義されたキーが、Security Manager サーバの秘密キーと一致することを確認します。

読み取り専用アクセスが付与されたシステム管理者

フル権限を持つ System Administrator としてログインしたにもかかわらず、Security Manager のすべ

てのポリシー ページに読み取り専用アクセスしかできない場合は、Cisco Secure ACS で次の手順を実

行します。

• （NDG を使用している場合）Cisco Secure ACS のナビゲーション バーの [Group Setup] をクリッ

クしてから、System Administrator ユーザ ロールが CiscoWorks と Cisco Security Manager の両方
の必要なすべての NDG（特に、Common Services/Security Manager サーバを含む NDG）に関連

付けられていることを確認します。

• ナビゲーション バーの [Network Configuration] をクリックしてから、次の手順を実行します。

– Common Services/Security Manager サーバが Not Assigned（デフォルト）グループに割り当

てられていないことを確認します。

– Common Services/Security Manager サーバが RADIUS ではなく TACACS+ を使用するように

設定されていることを確認します。TACACS+ は、2 台のサーバ間でサポートされている唯一

のセキュリティ プロトコルです。

（注） TACACS+ または RADIUS 用に Security Manager で管理するネットワーク デバイス

（ルータ、スイッチ、ファイアウォールなど）を設定できます。

ACS の変更が Security Manager に表示されない

Security Manager と Cisco Secure ACS 4.x を使用している場合は、Security Manager サーバ上の 
Security Manager または CiscoWorks Common Services にログインしたときに ACS からの情報が

キャッシュされます。Security Manager にログイン中に Cisco Secure ACS の [Network Configuration] 
と [Group Setup] で変更を加えた場合は、Security Manager で、その変更が、すぐに表示されない、ま

たは、すぐに有効にならない可能性があります。Security Manager と Common Services をログアウト

してそれらのウィンドウを閉じてから、再度ログインして、ACS からの情報をリフレッシュする必要

があります。

ACS で変更を加える必要がある場合は、ログアウトして Security Manager ウィンドウを閉じてから、

製品に再ログインする方法がベスト プラクティスです。

（注） Cisco Secure ACS 3.3 はサポートされていませんが、このバージョンの ACS を使用している場合は、

Windows サービスを開いて Cisco Security Manager Daemon Manager サービスを再起動し、ACS の変

更を Security Manager に表示させる必要があります。
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ACS で設定されたデバイスが Security Manager に表示されない

Cisco Secure ACS 上で設定したデバイスが Security Manager に表示されない場合は、デバイスの表示

名に伴う問題だと思われます。

Security Manager で定義するデバイスの表示名は、そのデバイスを AAA クライアントとして追加した

ときに ACS で設定した名前と一致する必要があります。このことは、特に、ドメイン名を使用する場

合に重要です。Security Manager でドメイン名をデバイス名に付加する場合は、ACS 内の AAA クラ

イアントのホスト名を <device_name>.<domain_name> にする必要があります（例：

pixfirewall.cisco.com）。

Cisco Secure ACS が到達不能になった後の Security Manager での作業

Cisco Secure ACS が到達不能な場合は、Security Manager セッションが影響を受けます。そのため、

複数の Cisco Secure ACS サーバを使用するフォールトトレラントなインフラストラクチャの構築を検

討する必要があります。複数のサーバを使用することによって、いずれかの ACS サーバの通信機能が

失われても、Security Manager 内の作業を継続できます。

セットアップに Cisco Secure ACS が 1 つしか含まれておらず、ACS が到達不能になった場合でも 
Security Manager での作業を継続する場合は、Security Manager サーバ上でのローカル AAA 認証に切

り替えることができます。

手順

AAA モードに変更するには、次の手順を実行します。

ステップ 1 admin CiscoWorks ローカル アカウントを使用して Common Services にログインします。

ステップ 2 [Server] > [Security] > [AAA Mode Setup] を選択してから、AAA モードを Non-ACS/CiscoWorks 
Local に変更します。これによって、ローカル Common Services データベースとその組み込みロール

を使用して認証と認可を実行できます。ローカル認証を利用するには、AAA データベース内にローカ

ル ユーザを作成する必要があります。

ステップ 3 [Change] をクリックします。

Cisco Secure ACS へのアクセスの復元

Cisco Secure ACS がダウンしたために Security Manager にアクセスできなくなった場合は、次の手順

を実行します。

• ACS サーバ上で Windows サービスを起動して、CSTacacs サービスと CSRadius サービスが稼働

しているかどうかを確認します。必要に応じて、これらのサービスを再起動します。

• CiscoWorks Common Services で次の手順を実行します。

ステップ 1 admin ユーザとして Common Services にログインします。

ステップ 2 DOS ウィンドウを開いて、NMSROOT\bin\perl ResetLoginModule.pl を実行します。

ステップ 3 Common Services を終了してから、admin ユーザとして再度ログインします。

ステップ 4 [Server] > [Security] > [AAA Mode Setup] に移動してから、AAA モードを [Non-ACS] > [CW Local] 
モードに変更します。
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ステップ 5 Windows サービスを開いて、Cisco Security Manager Daemon Manager サービスを再起動します。

マルチホーム デバイスに伴う認証の問題

Cisco Secure ACS に追加されたマルチホーム デバイス（複数の Network Interface Card（NIC; ネット

ワーク インターフェイス カード）が実装されたデバイス）が設定できない場合は、ユーザ ロールにデ

バイスの変更権限が含まれていたとしても、そのデバイスの IP アドレスの入力方法に伴う問題が発生

する可能性があります。

マルチホーム デバイスを Cisco Secure ACS の AAA クライアントとして定義する場合は、NIC ごとの 
IP アドレスを定義してください。入力するたびに Enter を押します。詳細については、「NDG を使用

しないデバイスの AAA クライアントとしての追加」（P.8-17）を参照してください。

NAT 境界の背後に設置されたデバイスに伴う認証の問題

Cisco Secure ACS に追加された NAT 前または NAT 後の IP アドレスを持つデバイスを設定できない場

合は、ユーザ ロールにデバイスの変更権限が含まれていたとしても、設定した IP アドレスに伴う問題

が発生する可能性があります。

デバイスが NAT 境界の背後に設置されている場合は、Cisco Secure ACS の AAA クライアント設定で

デバイスのすべての IP アドレス（NAT 前と NAT 後を含む）を定義してください。ACS への AAA ク
ライアント設定の追加方法については、『User Guide for Cisco Secure Access Control Server』を参照し

てください。

Common Services 4.0 を使用するローカル RBAC 
Security Manager 4.3 および 4.4 よりも前の、Cisco Secure ACS を使用する重要なメリットは、（1）特

殊な権限セット（特定のポリシー タイプの設定だけをユーザに許可する場合など）を使用して非常に

粒度の高いユーザ ロールを作成できることと、（2）ネットワーク デバイス グループ（NDG）を設定

することによって特定のデバイスにユーザを制限できることでした。このような粒度の高い特権（効率

的な「ロールベース アクセス コントロール」（RBAC））は、Cisco Secure ACS を使用していない限

り、Security Manager 4.2 以前のバージョンでは利用できませんでした。Security Manager 4.3 および 
4.4 では、ACS を使用せずにローカル RBAC を利用できる Common Services 4.0 を使用するため、こ

のような粒度の高い特権（RBAC）を利用できます。

Security Manager 4.3 と 4.4 は ACS 4.2 との互換性を維持します。「Security Manager と Cisco Secure 
ACS の統合」（P.8-12）を参照してください。

（注） RBAC 機能を ACS から Common Services に移行したいユーザは、手動で行う必要があります。移行

スクリプトも、他の移行サポートもありません。

Common Services 4.0 には、ユーザのカスタム ロールを定義し、ユーザの既存のロールをカスタマイ

ズするためのデバイスレベルの RBAC があります。次の機能を使用できます。

• ユーザの管理（追加、削除、編集）

• デバイスレベルの RBAC を提供するためのネットワーク デバイス グループ（NDG）の管理

• カスタム ロールの管理
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• デバイス グループへのロールのマッピング

• 「ネットワーク オブジェクトの表示」、「サービス オブジェクトの変更」、および「アクセス ルール

の変更」などのポリシー オブジェクト タイプとポリシー タイプに対する粒度の高い特権。

次のエリアのタスクを完了することで、Common Services 4.0 を使用してローカル RBAC を実装でき

ます。

• 「認証モードの設定」（P.8-33）

• 「ユーザ管理」（P.8-33）

• 「グループ管理」（P.8-34）

• 「ロール管理」（P.8-34） 

認証モードの設定

次の手順を実行して、非 ACS アカウントを設定します。「非 ACS アカウント」（P.8-2）を参照してく

ださい。

次に、[CiscoWorks Local] ログイン モジュールを選択します。

ヒント [CiscoWorks Local] は Security Manager のクリーン インストールのデフォルト値です。

ユーザ管理

Common Services の [Local User Setup] ページに移動します。

Security Manager がインストールされているサーバ > 

Cisco Security Manager アプリケーションのデスクトップ アイコン > 

ユーザ アカウント ログイン > 

[Server Administration] > 

[Home] > 

[System Tasks] > 

[Local User Setup] 

[Local User Setup] ページで、ユーザを選択し、次のアクションのいずれかを選択できます。

• Import Users 

• Export Users 

• Edit 

• Delete 

• Add 

• Modify My Profile 

複数のユーザを選択する場合、[Edit] は選択できません。

ユーザを選択しない場合は、次のアクションのいずれかを選択できます。

• Import Users 

• Add 
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• Modify My Profile 

[Edit] または [Add] を選択する場合は、次の 3 つの認可タイプのいずれかを選択できます。

• Full Authorization

• Enable Task Authorization

• Enable Device Authorization

グループ管理 
Security Manager の [Device Groups] ページに移動します。

Security Manager がインストールされているサーバ > 

Configuration Manager アプリケーションのデスクトップ アイコン > 

ユーザ アカウント ログイン > 

[Tools] > 

[Security Manager Administration] > 

[Device Groups]

Common Services インターフェイス（Security Manager がインストールされているサーバ > Cisco 
Security Manager アプリケーションのデスクトップ アイコン）を使用してデバイス グループを管理す

ることはできません。

ロール管理

[Role Management Setup] ページに移動します。

Security Manager がインストールされているサーバ > 

Cisco Security Manager アプリケーションのデスクトップ アイコン > 

ユーザ アカウント ログイン > 

[Server Administration] > 

[Server] >（メニュー セレクタ記号）>

[Security] > 

[Single-Server Management] > 

[Role Management Setup]

[Role Management Setup] ページにはデフォルトのロール（Approver、Help Desk、Network 
Administrator、Network Operator、Security Administrator、Security Approver、Super Admin、およ

び System Administrator）が表示されます。[Role Management Setup] ページには、追加したカスタム 
ロール（ある場合）も表示されます。

[Role Management] ページでは、Add、Edit、Delete、Copy、Export、Import、Set as default、および 
Clear default の各操作を実行できます。
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P P E N D I X A

トラブルシューティング

CiscoWorks Common Services は、Security Manager に、サーバ上でのインストール、アンインストー

ル、および再インストール用のフレームワークを提供します。Security Manager サーバ ソフトウェア

のインストールまたはアンインストールでエラーが発生した場合は、Common Services のオンライン 
ヘルプの「Troubleshooting and FAQs」を参照してください。

次のトピックは、スタンドアロン バージョンの Cisco Security Agent を含む、クライアント システム

またはサーバ上に Security Manager 関連ソフトウェア アプリケーションをインストール、アンインス

トール、または再インストールしたときに発生する可能性のある問題の解決に役立ちます。

• 「Cisco Security Manager サービスの起動要件」（P.A-1）

• 「必要な TCP ポートと UDP ポートの包括的リスト」（P.A-2）

• 「Security Manager サーバのトラブルシューティング」（P.A-4）

• 「Security Manager クライアントのトラブルシューティング」（P.A-10）

• 「サーバ セルフテストの実行」（P.A-16）

• 「サーバ トラブルシューティング情報の収集」（P.A-17）

• 「サーバ プロセス ステータスの表示と変更」（P.A-18）

• 「サーバ インストール ログ ファイルの確認」（P.A-18）

• 「Symantec の共存問題」（P.A-19）

• 「Windows アップデートのインストール後の問題」（P.A-19）

• 「高度な暗号化による ASA デバイスへの接続の問題」（P.A-20）

• 「インストール時に使用する Activation.jar のポップアップ表示」（P.A-20）

Cisco Security Manager サービスの起動要件
Cisco Security Manager サービスは、特定の順序で起動しなければ、Security Manager が正しく機能し

ません。これらのサービスの初期化は、Cisco Security Manager Daemon Manager サービスによって制

御されます。Cisco Security Manager サービスの起動タイプは変更しないでください。また、Cisco 
Security Manager サービスは手動で停止または開始しないでください。特定のサービスを再起動しな

ければならない場合は、Cisco Security Manager Daemon Manager を再起動して、すべての関連サービ

スが正しい順序で停止および開始する必要があります。
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必要な TCP ポートと UDP ポートの包括的リスト
Cisco Security Management Suite アプリケーションは、クライアントや他のアプリケーションと通信

する必要があります。その他のサーバ アプリケーションは別のコンピュータ上にインストールできま

す。通信を成功させるためには、特定の TCP ポートと UDP ポートを開いて、トラフィック送信に使

用できるようにする必要があります。通常は、「必要なサービスとポート」（P.3-1）に記載されている

ポートを開くだけで十分です。ただし、アプリケーションが通信不能なことを検出した場合は、次の表

内のポートも開く必要もあります。リストはポート番号順に並んでいます。

表 A-1 必要なサービスとポート

サービス

対象または使用アプリケー

ション

ポート番号 /
ポートの範囲 プ

ロ
ト

コ
ル

着
信

発
信

FTP Security Manager と TMS サー

バ間の通信

21 TCP — X

SSH Common Services 22 TCP — X

Security Manager 22 TCP — X

Telnet Security Manager 23 TCP — X

SMTP Common Services 25 TCP — X

TACACS+（ACS の場合） Common Services 49 TCP — X

TFTP Common Services 69 UDP X X

HTTP Common Services 80 TCP — X

Security Manager TCP — X

SNMP（ポーリング） Common Services 161 UDP — X

Performance Monitor 161 UDP — X

SNMP（トラップ） Common Services 162 UDP — X

Performance Monitor 162 UDP X —

HTTPS（SSL） Common Services 4431 TCP X —

Security Manager TCP X X

AUS TCP X —

Performance Monitor TCP X —

syslog2 Security Manager 514 UDP X —

Common Services（Security 
Manager がインストールされ

ていない場合）

514 または 49514（こ

の行の脚注を参照）

UDP X —

Performance Monitor
（Security Manager がインス

トールされていない場合）

514 UDP X —

リモート コピー プロトコル Common Services 514 TCP X X
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HTTP Common Services 1741 TCP X —

Security Manager TCP X —

AUS TCP X —

Performance Monitor TCP X —

RADIUS

LDAP

Kerberos

Security Manager（外部 AAA 
サーバへ）

1645、1646、1812
（新規）、389、636
（SSL）、88

TCP — X

Access Control Server HTTP/HTTPS Security Manager 2002 TCP — X

CiscoWorks ゲートキーパー用の HIPO 
ポート

Common Services 8088 TCP X X

Tomcat シャットダウン Common Services 9007 TCP X —

Tomcat Ajp13 コネクタ Common Services 9009 TCP X —

データベース Security Manager 10033 TCP X —

License Server Common Services 40401 TCP X —

Daemon Manager Common Services 42340 TCP X X

Osagent Common Services 42342 UDP X X

データベース Common Services 43441 TCP X —

Sybase Auto Update Server 43451 TCP X X

Performance Monitor 43453 TCP X X

DCR と OGS Common Services 40050  ～ 40070 TCP X —

Event Services Software Service 42350/
44350

UDP X X

Software Listening 42351/
44351

TCP X X

Software HTTP 42352/
44352

TCP X X

Software Routing 42353/
44353

TCP X X

転送メカニズム（CSTM） Common Services 50000  ～ 50020 TCP X —

1. Cisco Security Monitoring, Analysis, and Response System（Cisco Security MARS）アプライアンスと情報を共有または交換するため

に、Security Manager はデフォルトでポート 443 上の HTTPS を使用します。この目的で別のポートを使用するかどうかを選択できま

す。

2. Security Manager のインストールまたはアップグレード時に、Common Services syslog サービス ポートが 514 から 49514 に変更され

ます。あとで Security Manager がアンインストールされた場合、ポートは 514 に戻されません。

表 A-1 必要なサービスとポート （続き）

サービス

対象または使用アプリケー

ション

ポート番号 /
ポートの範囲 プ

ロ
ト

コ
ル

着
信

発
信
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Security Manager サーバのトラブルシューティング
この項では、次の疑問にお答えします。

• 「インストール中のサーバ障害」（P.A-4）

• 「インストール後のサーバ障害」（P.A-5）

• 「アンインストール中のサーバ障害」（P.A-8）

インストール中のサーバ障害

Q. サーバ ソフトウェアのインストール時に表示されたこのインストール エラー メッセージはどうい

う意味ですか。

A. サーバ ソフトウェアのインストール エラー メッセージと説明を表 A-2（P.A-4） に示します。この

表は先頭の文字のアルファベット順に並べられています。

表 A-2 インストール エラー メッセージ（サーバ）

メッセージ メッセージの理由 ユーザ アクション

License file failed.ERROR: 
The file with the name 
c:\progra~1\CSCOpx\setup 
does not exist

先に Common Services 依存ア

プリケーションをアンインス

トールしようとして失敗しまし

た。

1. サーバをシャットダウンしてから、再起動します。

2. レジストリ エディタを使用して次のエントリを削

除します。
$HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Ci

sco\Resource Manager\CurrentVersion 

3. Security Manager をインストールしたディレクト

リで、setup という名前のサブディレクトリを作成

します。

4. CMFLOCK.TXT を削除します（存在する場合）。

5. Security Manager を再インストールします。

Corrupt License file. Please 
enter a valid License file.

ライセンス ファイルが破損して

いるか、ライセンス ファイルの

内容が無効です。

「ライセンスに関する支援」（P.2-9）を参照してくださ

い。

Corrupt License file entered 
for 5 tries. Install will 
proceed in EVAL mode. Press 
OK to proceed.

5 回連続で無効なライセンス 
ファイルへのパス名を入力した

可能性があります。試行が 5 回
失敗したら、インストールが評

価モードに変わります。

[OK] をクリックして、ライセンス エラー ダイアログ

ボックスを閉じて、ウィザードの次の画面に進みます。

One instance of CiscoWorks 
Installation is already 
running.If you are sure that 
no other instances are 
running, remove the file 
C:\CMFLOCK.TXT.This 
installation will now abort.

先に Common Services 依存ア

プリケーションをインストール

しようとして失敗した可能性が

あります。

C:\CMFLOCK.TXT ファイルを削除してから、もう一

度試してみてください。

Severe

Failed on call to 
FileInsertLine.

サーバがハード ドライブ ス
ペースに関する要件を満たして

いません。

「サーバの要件および推奨事項」（P.3-3）を参照してく

ださい。
A-4
Cisco Security Manager 4.4 インストレーション ガイド

OL-28767-01-J



 

付録 A      トラブルシューティング

    Security Manager サーバのトラブルシューティング
Q. サーバ インストーラが処理を中断（ハングアップ）した場合はどうしたらいいですか。

A. リブートしてもう一度試してみてください。

Q. Cisco Security Manager と Cisco Secure Access Control Server の両方を 1 つのシステム上にイン

ストールできますか。

A. インストールしないことを推奨します。同じサーバ上での Security Manager と Cisco Secure ACS 
for Windows の共存はサポートされていません。

Q. Security Manager データベースのバックアップが失敗するのはなぜですか。

A. Tivoli などのネットワーク管理アプリケーションを使用して、Security Manager がインストールさ

れたシステム上に Cygwin をインストールした場合は、Security Manager データベースのバック

アップに失敗します。Cygwin をアンインストールしてください。

インストール後のサーバ障害

Q. Security Manager インターフェイスが表示されない、または、正しく表示されない、あるいは、特

定のインターフェイス要素が欠けています。原因は何でしょうか。

Temporary directory used by 
installation has reached 
_istmp9x. If _istmp99 is 
reached, no more setups can 
be run on this computer, 
they fail with error -112.

サーバ上で、ソフトウェア イン

ストール中に自動的に削除され

る予定の一時ファイルが残って

います。

サーバ上の一時ディレクトリで名前に「_istmp」文字

列が含まれるサブディレクトリを探します。このよう

なサブディレクトリをすべて削除します。

Windows cannot find 
'C:\Documents and 
Settings\Administrator\WINDO
WS\System32\cmd.exe'. Make 
sure you typed the name 
correctly, and then try 
again. To search for a file, 
click the Start button, and 
then click Search.

サポートされていないにもかか

わらず、Terminal Services をイ

ンストール中にイネーブルにし

た可能性があります。「インス

トール準備状況チェックリス

ト」（P.4-3）を参照してくださ

い。

1. Terminal Services をディセーブルにします。

この手順については、次の URL にある

『Installing and Getting Started With CiscoWorks 
LAN Management Solution 3.1』の「Terminal 
Server Support for Windows 2000 and 
Windows 2003 Server」トピックを参照してくださ

い。

http://www.cisco.com/en/US/docs/net_mgmt/cisco
works_lan_management_solution/3.1/install/guide/
IGSG31.html

2. Security Manager をもう一度インストールしてみ

てください。

Setup has detected that 
unInstallShield is in use. 
Close unInstallShield and 
restart setup. Error 432.

インストール中に Windows ア
カウント権限がチェックされま

す。CiscoWorks Common 
Services をインストールしてい

る Windows アカウントがロー

カル管理者特権を持っていない

場合は、InstallShield にこのエ

ラー メッセージが表示されま

す。

1. %WINDIR% に書き込むための適切な権限が付与

されていることを確認します。インストールまた

はアンインストールは、ローカル管理者グループ

のメンバーが実施する必要があります。

2. [OK] をクリックしてエラー メッセージを閉じ、

Windows からログアウトして、ローカル管理者特

権を持つアカウントを使用して Windows に再ログ

インします。

表 A-2 インストール エラー メッセージ（サーバ） （続き）

メッセージ メッセージの理由 ユーザ アクション
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A. いくつかの可能性が考えられます。このリスト内のシナリオを参照して、インターフェイスに影響

を与える可能性のある単純な問題を特定し、対処してください。

• 必要なサービスのいくつかがサーバ上で動作していません。サーバのデーモン マネージャを

再起動して、すべてのサービスの起動が完了するのを待ってから、Security Manager クライア

ントを再起動して接続し直してみてください。

• サーバに十分な空きディスク スペースがありません。サーバ上の Security Manager パーティ

ションの空き容量が 500 MB 以上あることを確認してください。

• 基本ライセンス ファイルが破損しています。「ライセンスに関する支援」（P.2-9）を参照して

ください。

• サーバで使用されている Windows 言語が間違っています。米国英語バージョンの Windows 上
の英語と、日本語バージョンの Windows 上の日本語しかサポートされていません （「サーバ

の要件および推奨事項」（P.3-3）を参照）。他の言語はインストールされたバージョンの 
Security Manager に悪影響を与える可能性があります。また、GUI 要素の欠落は可能性のあ

る症状の 1 つです。サポートされていない言語を使用している場合は、サポートされている言

語を選択してから、Security Manager をアンインストールして再インストールしてください。

「サーバ アプリケーションのアンインストール」（P.5-15）を参照してください。

• ネットワーク接続上で Security Manager インストール ユーティリティを実行しましたが、こ

の使用方法はサポートされていません（「Security Manager サーバ、Common Services、およ

び AUS のインストール」（P.5-2）を参照）。サーバ ソフトウェアをアンインストールして再イ

ンストールする必要があります。「サーバ アプリケーションのアンインストール」（P.5-15）を

参照してください。

• クライアント システムが最小限の要件を満たしていません。「クライアントの要件」（P.3-8）
を参照してください。

• HTTP を使用しようとしましたが、必要なプロトコルは HTTPS です。

• ボタンだけが表示されません。Security Manager クライアントを使用している最中に、クライ

アント システム上で [Display Properties] コントロール パネルを開いて、[Appearance] タブで

いくつかの設定を変更した可能性があります。この問題に対処するには、Security Manager ク
ライアントを終了してから、再起動してください。

• 間違ったグラフィックス カードのドライバ ソフトウェアがクライアント システム上にインス

トールされています。「クライアントの要件」（P.3-8）を参照してください。

問題 Web ブラウザを使用して Security Manager への Web インターフェイスを開こうとしたときに、

Security Manager サーバ上の /cwhp/LiaisonServlet にアクセスするための権限がないことを伝えるメッ

セージが表示されました。これはどういう意味ですか。

ソリューション 下の表に、この問題の一般的原因と提案されている対処法を示します。

表 A-3 LiaisonServlet エラーの原因と対処法

原因 回避策

サーバ上にアンチウイ

ルス アプリケーション

がインストールされて

いる

アンチウイルス アプリケーションをアンインストールします。

サーバ上に IIS がイン

ストールされている

IIS は Security Manager と互換性がないため、アンインストールする必要

があります。
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Q. Security Manager を使用してサーバ上のディレクトリを参照したときに、ローカル ボリュームだ

けが表示され、マップされたドライブは表示されません。どうしてですか。

A. Microsoft はサーバ セキュリティを強化するために Windows の設計にこの機能を組み込みました。

Security Manager で選択する必要のあるすべてのファイル（ライセンス ファイルなど）をサーバ

上に配置する必要があります。

Q. 日本語バージョンの Windows の [Start] メニューに Security Manager が表示されないのはなぜで

すか。

A. サーバ上の地域と言語のオプションを、英語を使用するように設定した可能性があります。日本語

バージョンの Windows 内の言語として英語はサポートされていません（「サーバの要件および推奨

事項」（P.3-3）を参照）。コントロール パネルを使用して、言語を日本語にリセットしてください。

Q. サーバの SSL 証明書が無効になっています。また、DCRServer プロセスが開始しません。原因は

何でしょうか。

A. サーバの日付または時刻が SSL 証明書の有効範囲外にリセットされています。「インストール準備

状況チェックリスト」（P.4-3）を参照してください。この問題に対処するには、サーバの日付 /時
刻の設定をリセットしてください。

Q. サーバとクライアント間の通信に使用されるプロトコルの入力が要求されませんでした。デフォル

トで使用されるプロトコルは何ですか。他のモードを使用してこの設定を手動で変更する必要があ

りますか。

A. サーバのインストール中にクライアントをインストールした場合は、デフォルトで、サーバとクラ

イアント間の通信プロトコルとして HTTPS が使用されます。通信はデフォルト プロトコルを使用

して保証されているため、この設定を手動で変更する必要はありません。

Security Manager に必

要なサービスが正しい

順序で開始されていな

い

自動に設定する必要があるサービスは Cisco Security Manager Daemon 
Manager だけです。他の CiscoWorks サービスは手動に設定する必要があ

ります。Daemon Manager が他の Ciscoworks サービスを起動するまでに数

分かかる場合があることに注意してください。これらのサービスは、正し

い順序で起動する必要があります。手動でサービスを起動した場合はエ

ラーを引き起こす可能性があります。

casuser パスワード casuser ログインは、Windows 管理者と同じで、すべての Common 
Services タスクと Security Manager タスクにアクセスできます。次のよう

に casuser パスワードをリセットします。

1. サーバ上でコマンド プロンプトを開きます。

（注） Windows Server 2008 を使用している場合は、コマンド プロンプト

を開くときに [Run as administrator] オプションを使用する必要があ

ります。

2. C:\Program Files\CSCOpx\setup\support\resetCasuser.exe と入力

して、Enter を押します。

3. オプション 1（casuser パスワードのランダム生成）を選択します。

表 A-3 LiaisonServlet エラーの原因と対処法 （続き）

原因 回避策
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プロトコルとして HTTP を選択するオプションは、サーバ インストーラとは別に、クライアント 
インストーラを実行して Security Manager クライアントをインストールした場合にのみ使用でき

ます。ただし、サーバとクライアント間の通信プロトコルとして HTTP を使用しないことを推奨

します。クライアントは、サーバが使用するように設定されたプロトコルを使用する必要がありま

す。

Q. VMware セットアップを使用しているとシステムのパフォーマンスが受け入れられないほど低下し

ます。たとえば、システムのバックアップに 2 時間もかかります。

A. Security Manager を実行している VM に複数の CPU が割り当てられていることを確認してくださ

い。1 つの CPU しか割り当てられていないシステムでは、一部のシステム アクティビティに対し

て受け入れられないほどのパフォーマンスを示すことがわかっています。

Q. 検証などのいくつかの操作が、SQL クエリー例外をログに出力して失敗します。原因は何でしょ

うか。

A. Sybase の一時ディレクトリのディスク領域が足りなくなり、一時ファイルの作成に失敗した可能

性があります。デフォルトでは、Windows の一時ディレクトリの下に Sybase の一時ファイルが作

成されます。システム変数 SA_TMP が定義されている場合は、SA_TMP に指定されたディレクト

リに一時ファイルが作成されます。Sybase の一時ファイルが配置されるディスク領域をクリアし

てから、Security Manager を再起動します。

アンインストール中のサーバ障害

Q. このアンインストール エラー メッセージはどういう意味ですか。

A. アンインストール エラー メッセージと説明を表 A-4（P.A-9） に示します。この表は先頭の文字の

アルファベット順に並べられています。アンインストール エラー メッセージの詳細については、

Cisco.com 上で Common Services 3.2 のマニュアルを参照してください。
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表 A-4 アンインストール エラー メッセージ

メッセージ メッセージの理由 ユーザ アクション

C:\NMSROOT\MDC\msfc-backend 
refers to a location that is 
unavailable. It could be on a 
hard drive on this computer, 
or on a network. Check to 
make sure that the disk is 
properly inserted, or that 
you are connected to the 
Internet or your network, and 
then try again. If it still 
cannot be located, the 
information might have been 
moved to a different 
location.

このメッセージは害がない可

能性があります。[OK] をク

リックしてメッセージを消去

する以外は何もする必要があ

りません。そうしなかった場

合は、次の条件の一方または

両方が適用されるサーバ上で

メッセージが表示される可能

性があります。

- 簡易ファイル共有が 
Windows 上でイネーブルに

なっている。

- オフライン ファイル同期が 
Windows 上でイネーブルに

なっている。

メッセージを消去してアンインストールが失敗した場

合は、次の可能性のある対処法の一方または両方を試

して、もう一度アンインストールを行ってみてくださ

い。

簡易ファイル共有

1. [Start] > [Settings] > [Control Panel] > [Folder 
Options] を選択します。

2. [View] タブをクリックします。

3. [Advanced Settings] ペインの一番下までスクロー

ルします。

4. [Use simple file sharing (Recommended)] チェック

ボックスをオフにしてから、[OK] をクリックしま

す。

オフライン ファイル同期

1. [Start] > [Settings] > [Control Panel] > [Folder 
Options] を選択します。

2. [Offline Files] タブをクリックします。

3. [Enable Offline Files] チェックボックスをオフに

してから、[OK] をクリックします。

C:\temp\<subdirectory>\
setup.exe - Access is denied.

The process cannot access the 
file because it is being used 
by another process.

0 file(s) copied.
1 file(s) copied.

アンインストールが失敗しま

した。

サーバをリブートしてから、「サーバ アプリケーショ

ンのアンインストール」（P.5-15）に記載されている手

順を実行してください。

Windows Management 
Instrumentation (WMI) is 
running.

The setup program has 
detected Windows Management 
Instrumentation (WMI) 
services running. This will 
lock some Cisco Security 
Manager processes and may 
abort uninstallation 
abruptly. To avoid this, 
uninstallation will stop and 
start the WMI services.

Do you want to proceed?

Click Yes to proceed with 
this uninstallation. Click No 
to exit uninstallation.

組織で WMI が使用されている

か、誰かが誤ってサーバ上の 
WMI サービスをイネーブルに

した可能性があります。

[Yes] をクリックします。
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Q. アンインストーラがハングアップした場合はどうしたらいいですか。

A. リブートしてからもう一度試してみてください。

Q. アンインストーラに crmdmgtd サービスが応答していないという内容のメッセージが表示され、

「Do you want to keep waiting?」と尋ねられた場合はどうしたらいいですか。

A. アンインストール スクリプトには、スクリプトがタイムアウトする前に命令に応答しなかった 
crmdmgtd サービスを停止する命令が含まれています。[Yes] をクリックします。ほとんどの場合、

crmdmgtd サービスは、その後、予想どおりに停止します。

Security Manager クライアントのトラブルシューティング
この項では、次の疑問にお答えします。

• 「インストール中のクライアント障害」（P.A-10）

• 「インストール後のクライアント障害」（P.A-13）

インストール中のクライアント障害

Q. クライアント ソフトウェアのインストール時に表示されたこのインストール エラー メッセージは

どういう意味ですか。

A. クライアント ソフトウェアのインストール エラー メッセージと説明を表 A-5 に示します。この表

は先頭の文字のアルファベット順に並べられています。

表 A-5 インストール エラー メッセージ（クライアント）

メッセージ メッセージの理由 ユーザ アクション

Could not install engine jar 以前のソフトウェア インストー

ルとアンインストールが原因で 
InstallShield が正しく動作してい

ません。

1. 次のとおりに移動します。
C:\Program Files\
Common Files\
InstallShield\Universal\
common\Gen1.

2. Gen1 フォルダの名前を変更してから、もう一

度 Security Manager クライアントのインス

トールを試してみてください。

Gen1 が存在しない場合は、代わりに 
common の名前を変更します。
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Error - Cannot Connect to 
Server

The client cannot connect to 
the server. This can be 
caused by one of the 
following reasons:
The server name is incorrect. 
The protocol (http, https) is 
incorrect. 
The server is not running. 
Network access issues. Please 
confirm that the server name 
and protocol are correct. 
The server is running and you 
are not experiencing network 
connectivity issues by 
loading the CS Manager home 
page in your browser. 

サーバが誤って HTTPS トラ

フィック用に設定されている可能

性があります。

1. ブラウザから、
https://<server>/CSCOnm/servlet/login/logi
n.jsp にある Cisco Security Management Suite 
デスクトップにログインします。

2. [Server Administration] をクリックします。

3. [Admin] ウィンドウで、[Server] > [Security] 
を選択します。

4. TOC で、[Single Server Management] > 
[Browser-Server Security Mode Setup] を選択

してから、[Enable] オプション ボタンが選択

されていることを確認します。

オプション ボタンが選択されていなかった場

合は、それを選択してから、[Apply] をクリッ

クします。

5. プロンプトが表示されたら、Cisco 
Security Manager Daemon Manager を再起動

します。

6. 5 分待ってから、もう一度 Security Manager 
クライアントを使用してみてください。

それでも接続できない場合は、エラー メッ

セージが示している他の可能性のある問題を

検討してください。

Error - Cisco Security Agent 
Running 

Installation cannot proceed 
while the Cisco Security 
Agent is running 

Do you want to disable the 
Cisco Security Agent and 
continue with the 
installation?

クライアントのインストール中

は、Cisco Security Agent を停止

する必要があります。

• Cisco Security Agent をディセーブルにする場

合は、[Yes] をクリックします。

• 操作をキャンセルして、Cisco Security Agent 
を手動で停止する場合は、[No] をクリックし

ます。

• Security Manager クライアントのオンライン 
ヘルプにアクセスする場合は、[Help] をク

リックします。

Error - Cisco Security Agent 
not Stopped

The installation will be 
aborted because the Cisco 
Security Agent could not be 
stopped.

Please attempt to disable 
Cisco Security Agent before 
repeating the installation 
process.

Security Manager クライアントか

ら Cisco Security Agent を停止で

きませんでした。

[OK] をクリックして、このエラー メッセージを

閉じ、インストールを中断します。もう一度イン

ストールを試す前に、Cisco Security Agent を手動

でディセーブルにします。

表 A-5 インストール エラー メッセージ（クライアント） （続き）

メッセージ メッセージの理由 ユーザ アクション
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Q. クライアント インストーラが処理を中断（ハングアップ）した場合はどうしたらいいですか。

A. 次の手順を試してみてください。いずれかの手順で問題が解決される可能性があります。

• クライアント システム上にアンチウイルス ソフトウェアがインストールされている場合は、

それをディセーブルにしてから、もう一度インストーラを実行してみてください。

• クライアント システムをリブートしてから、もう一度インストーラを実行してみてください。

• クライアント システム上でブラウザを使用して、http://<server_name>:1741 にある 
Security Manager サーバにログインします。「Forbidden」または「Internal Server Error」と

いうエラー メッセージが表示された場合は、必要な Tomcat サービスが実行していません。最

Error occurred during the 
installation: null.

以前のソフトウェア インストー

ルとアンインストールが原因で 
InstallShield が正しく動作してい

ません。

1. C:\Program Files\Common 
Files\InstallShield\Universal\common\Gen1 に
移動します。

2. Gen1 フォルダの名前を変更してから、もう一

度 Security Manager クライアントのインス

トールを試してみてください。

Gen1 が存在しない場合は、代わりに 
common の名前を変更します。

Errors occurred during the 
installation.
• null

ログイン アカウントに管理特権

が付与されている Windows ユー

ザだけが、Security Manager 
Client をインストールできます。

Windows 管理者としてログインしてから、もう一

度 Security Manager クライアントのインストール

を試してみてください。

Internet Explorer cannot 
download CSMClientSetup.exe 
from <server>. Internet 
Explorer was not able to open 
this Internet site. The 
requested site is either 
unavailable or cannot be 
found. Please try again 
later.

クライアント システム上の OS が 
Windows 2008 の場合は、

Internet Explorer セキュリティ強

化のデフォルト設定が原因で、

サーバからクライアント ソフト

ウェア インストール ユーティリ

ティをダウンロードできない可能

性があります。

1. [Start] > [Control Panel] > [Add or Remove 
Programs] を選択します。

2. [Add/Remove Windows Components] をク

リックします。

3. Windows コンポーネント ウィザード ウィンド

ウが開いたら、[Internet Explorer Enhanced 
Security Configuration] チェックボックスをオ

フにして、[Next] をクリックし、[Finish] を
クリックします。

Please read the information 
below. 

The following errors were 
generated:

• WARNING: The <drive> 
partition has 

insufficient space to 

install the items 

selected.

空きスペースが不十分なドライブ

またはパーティション上に 
Security Manager クライアント

をインストールしようとした可能

性があります。

[Back] をクリックしてから、Security Manager ク
ライアントをインストールする別の場所を選択し

てください。

Unable to Get Data

A database failure prevented 
successful completion of this 
operation. 

サーバ データベースが完全に稼

働する前に、クライアントを使用

してサーバに接続しようとした可

能性があります。

数分待ってから、もう一度ログインしてみてくだ

さい。問題が解決されない場合は、必要なすべて

のサービスが実行していることを確認してくださ

い。

表 A-5 インストール エラー メッセージ（クライアント） （続き）

メッセージ メッセージの理由 ユーザ アクション
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近サーバをリブートして、Tomcat の稼働までに十分な時間がなかったことがない場合は、

サーバ ログを確認するか、その他のステップを実行して、Tomcat が動作していない理由を調

査する必要があります。

Q. インストーラに、以前のバージョンのクライアントがインストールされているためアンインストー

ルされるという内容のメッセージが表示されます。しかし、以前のバージョンのクライアントはイ

ンストールされていません。これは障害ですか。

A. クライアントのインストールまたは再インストール中に、インストーラがインストールされていな

いクライアントを検出して、そのクライアントがアンインストールされるという内容の誤ったメッ

セージを表示することがあります。このメッセージは、システム内に特定の古いレジストリ エン

トリが残っていることが原因で表示されます。このメッセージが表示されてもクライアントのイン

ストールは正常に進行しますが、レジストリ エディタを使用して次のキーを削除し、今後のイン

ストールでこのメッセージが表示されないようにします。
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\Un
install\Cisco Security Manager Client （レジストリ エディタを開くには、[Start] > [Run] を選択し

て regedit と入力します）。また、C:\Program Files\Zero G Registry\.com.zerog.registry.xml ファ

イルの名前を変更します（どんな名前でも可）。

インストール後のクライアント障害

Q. インターフェイスが正しく表示されないのはなぜですか。

A. 古いビデオ（グラフィックス）カードは、ドライバ ソフトウェアをアップグレードしなければ、

Security Manager GUI を正しく表示しない可能性があります。この問題がクライアント システム

に影響するかどうかをテストするには、[My Computer] を右クリックして、[Properties] を選択し、

[Hardware] を選択して、[Device Manager] をクリックしてから、[Display adapters] エントリを展

開します。アダプタのエントリをダブルクリックして、使用されているドライバのバージョンを確

認します。その後で、次のいずれかを実行できます。

– クライアント システムで ATI MOBILITY FireGL ビデオ カードが使用されている場合は、

カードに付属していたビデオ ドライバ以外のドライバを入手しなければならない場合があり

ます。使用するドライバは、手動で Direct 3D が設定できる必要があります。このような機能

のないドライバは、Security Manager GUI 内の要素をクライアント システムに表示できない

可能性があります。

– ビデオ カードの場合は、PC メーカとカード メーカの Web サイトにアクセスして、最新の 
Java2 グラフィックス ライブラリの表示との非互換性をチェックしてください。既知の非互換

性が残っているほとんどのケースで、半分以上のメーカが互換性のあるドライバを入手してイ

ンストールするための手段を提供しています。

Q. 日本語バージョンの Windows の [Start] メニューに Security Manager クライアントが表示されな

いのはなぜですか。

A. クライアント システム上で英語を使用するように、地域と言語のオプションを設定している可能

性があります。日本語バージョンの Windows 内の言語として英語はサポートされていません。コ

ントロール パネルを使用して、言語を日本語にリセットしてください。

Q. Security Manager クライアントがインストールされたワークステーション上で一部または全部の

ユーザの [Start] メニューに Security Manager クライアントが表示されないのはなぜですか。

A. クライアントをインストールするときに、製品をインストールしているユーザ専用のショートカッ

トを作成するのか、すべてのユーザ用のショートカットを作成するのか、どのユーザ用のショート

カットも作成しないのかを選択します。インストール後にこの選択を変更する場合は、Cisco 
Security Manager Client フォルダを Documents and Settings\<user>\Start Menu\Programs\Cisco 
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Security Manager から Documents and Settings\All Users\Start Menu\Programs\Cisco 
Security Manager にコピーすることによって、手動で変更できます。ショートカットを作成しない

ことにした場合は、指定された All Users フォルダ内にショートカットを手動で作成する必要があ

ります。

Q. クライアント システムとサーバ間の接続が異常に遅いと感じる場合、または、ログイン時に DNS 
エラーが表示される場合はどうしたらいいですか。

A. クライアント システム上の hosts ファイル内に Security Manager サーバ用のエントリを作成しな

ければならない場合があります。このようなエントリは、ネットワーク用の DNS サーバに登録さ

れていない場合にサーバへの接続の確立に役立つ可能性があります。クライアント システム上で

この有効なエントリを作成するには、メモ帳またはその他のプレーン テキスト エディタを使用し

て、C:\WINDOWS\system32\drivers\etc\hosts を開きます（ホスト ファイル自体にエントリの追

加方法に関する詳細な手順が保存されています）。

Q. Security Manager クライアントを使用してログインしようとしたときにエラー メッセージが表示

されることなくログイン資格情報が受け入れられましたが、Security Manager デスクトップが空の

状態で使用できません。認証セットアップの何が間違っているのでしょうか （また、

Security Manager サーバ上の Common Services でログイン資格情報が受け入れられましたが、

Web ブラウザ上で Cisco Security Management Suite デスクトップのロードに失敗します。これも

同じ原因でしょうか）。

A. Security Manager と Common Services に対してログイン認証サービスを提供するための Cisco 
Secure ACS に必要なステップが完了していない可能性があります。ACS でログイン資格情報を入

力しましたが、Security Manager サーバを AAA クライアントとして定義していません。この定義

を行わなければ、ログインできません。詳しい手順については、ACS のマニュアルを参照してく

ださい。

Q. Security Manager クライアントを使用してサーバにログインできず、次のようなメッセージが表示

されます。どうしたらいいですか。

... repeatedly that the 
server is checking its 
license.

サーバが最小限のハードウェア要件とソフトウェア要件を満たしている

ことを確認してください。「サーバの要件および推奨事項」（P.3-3）を参

照してください。

Synchronizing with 
DCR.

2 通りの可能性が考えられます。

• サーバの再起動直後に Security Manager クライアントを起動した可

能性があります。その場合は、サーバが完全に使用可能になるまで

数分待ってから、Security Manager クライアントを使用してみてく

ださい。

• CiscoWorks 管理パスワードにアンパサンド（&）などの特殊文字が

含まれている可能性があります。その結果、Security Manager のイ

ンストール時にサーバ上の NMSROOT\lib\classpath サブディレクト

リで comUser.dat ファイルを作成できませんでした。ここで、

NMSROOT は Common Services をインストールしたディレクトリ

です（デフォルトは C:\Program Files\CSCOpx です）。

a. Cisco TAC に連絡して、comUser.dat の交換または 
Security Manager の再インストールに関する支援を要請してく

ださい。

b. または、特殊文字を含まない Common Services パスワードを作

成します。
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Q. デフォルト ブラウザとして Internet Explorer を使用しているときにアクティビティ レポートが表

示されないのはなぜですか。

A. この問題は、無効なレジストリ キー値、または Internet Explorer に関連付けられた DLL ファイル

の場所に関する間違いが原因で発生します。この問題の対処法については、

http://support.microsoft.com/kb/281679/EN-US から入手可能な Microsoft サポート技術情報の記

事 281679 を参照してください。

Q. どうすれば、ログイン ウィンドウの [Server Name] フィールドからサーバ リストを消去できます

か。

A. csmserver.txt を編集して必要のないエントリを削除します。このファイルは、Security Manager 
クライアントをインストールしたディレクトリ内にあります。デフォルトの場所は、C:\Program 
Files\Cisco Systems\Cisco Security Manager Client です。

Q. バージョン ミスマッチが原因で Security Manager クライアントがロードされなかった可能性があ

ります。これはどういう意味ですか。

A. Security Manager サーバのバージョンとクライアントのバージョンが一致していません。これを修

正するには、最新のクライアント インストーラをサーバからダウンロードしてインストールしま

す。

Q. クライアント ログ ファイルはどの場所にありますか。 

A. クライアント ログ ファイルは、C:\Program Files\Cisco Systems\Cisco Security Manager 
Client\logs に配置されています。GUI セッションごとに専用のログ ファイルが作成されます。

Q. Security Manager が HTTPS モードで動作中かどうかはどうすれば確認できますか。

A. 次のいずれかを実行します。

• ブラウザを使用してサーバにログインしたら、アドレス フィールド内の URL を調査します。

URL が https で始まっていれば、Security Manager が HTTPS モードで動作しています。

• [Common Services] > [Server] > [Security] > [Single Server Management] > [Browser-Server 
Security Mode Setup] に移動します。[Current Setting] が [Enabled] になっていれば、Security 
Manager が HTTPS モードで動作しています。この設定が [Disabled] の場合は、HTTP を使用

します。

Error - Unable to 
Check License on 
Server.

An attempt to check 
the license file on 
the Security Manager 
server has failed.

Please confirm that 
the server is running. 
If the server is 
running, please 
contact the Cisco 
Technical Assistance 
Center.

次のサービスのいずれかが正しく起動していない可能性があります。

サーバ上で、[Start] > [Programs] > [Administrative Tools] > [Services] 
を選択して、次のような名前のサービスを右クリックし、ショートカッ

ト メニューから [Restart] を選択します。

• Cisco Security Manager Daemon Manager

• Cisco Security Manager database engine

• Cisco Security Manager Tomcat Servlet Engine

• Cisco Security Manager VisiBroker Smart Agent

• Cisco Security Manager Web Engine

5 分待ってから、もう一度 Security Manager クライアントを起動してみ

てください。
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• クライアントを使用してログインするときに、まず、HTTPS モードを試してみてください

（[HTTPS] チェックボックスをオンにします）。「Login URL access is forbidden; Please make 
sure your protocol (HTTP, HTTPS) is correct」というメッセージが表示されたら、サーバは 
HTTP モードで動作している可能性があります。[HTTPS] チェックボックスをオフにして、

もう一度試してみてください。

Q. どうすれば、クライアント デバッグ ログ レベルをイネーブルにできますか。

A. デフォルトで C:\Program Files\Cisco Systems\Cisco Security Manager Client\jars に配置されてい

る client.info ファイル内で、DEBUG_LEVEL パラメータに DEBUG_LEVEL=ALL を追加してか

ら、Security Manager クライアントを再起動します。

Q. 2 画面構成で作業している場合は、Security Manager クライアントが第 2 画面上で動作していて

も、必ず、特定のウィンドウとポップアップ メッセージが第 1 画面に表示されます。たとえば、

クライアントが第 2 画面上で動作しているときに、必ず、Policy Object Manager などのウィンド

ウが第 1 画面に表示されます。これを修正できますか。

A. これは、特定のオペレーティング システムにおける 2 画面サポートの実装方法に伴う既知の問題

です。Security Manager クライアントを第 1 画面上で動作させることを推奨します。クライアント

は、2 画面構成の設定後に起動する必要があります。

他の画面でウィンドウが開いた場合は、Alt + スペースバーを押した後に M を押すことによってそ

のウィンドウを移動できます。その後で、矢印キーを使用してウィンドウを移動します。

Q. クライアント システム上でソフトウェアをインストールまたはアンインストールできません。ど

うしてですか。

A. クライアント システム上でインストールとアンインストールを同時に実行した場合は、それらが

別々のアプリケーションに対するものであっても、クライアント システムの InstallShield データ

ベース エンジンに悪影響を与え、ソフトウェアのインストールまたはアンインストールができな

くなります。詳細については、Cisco.com アカウントにログインしてから、Bug Toolkit を使用し

て CSCsd21722 と CSCsc91430 を確認してください。

サーバ セルフテストの実行
Security Manager サーバが正しく動作していることを確認するセルフテストを実行するには、次の手

順を実行します。

ステップ 1 Security Manager クライアントが Security Manager サーバに接続されているシステムから、[Tools] > 
[Security Manager Administration] を選択します。

ステップ 2 [Administration] ウィンドウで、[Server Security] をクリックしてから、任意のボタンをクリックしま

す。新しいブラウザが開いて、クリックしたボタンに対応する Common Services GUI のセキュリティ

設定ページが表示されます。

ステップ 3 [Common Services] ページの [Server] タブで、[Admin] を選択します。

ステップ 4 [Admin] ページの TOC で、[Selftest] をクリックします。

ステップ 5 [Create] をクリックします。

ステップ 6 [SelfTest Information at <MM-DD-YYYY HH:MM:SS>] リンクをクリックします。ここで、

• MM-DD-YYYY は、現在の月、日、年です。

• HH:MM:SS は、[Selftest] をクリックした時、分、秒を表すタイムスタンプです。
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ステップ 7 [Server Info] ページでエントリを読み取ります。

サーバ トラブルシューティング情報の収集
Security Manager で問題が発生しており、エラー メッセージ内の推奨事項のすべてを試し、このマ

ニュアル内の可能性のある解決策を確認したにもかかわらず、問題が解決されない場合は、Security 
Manager Diagnostics ユーティリティを使用してサーバ情報を収集します。

Security Manager Diagnostics ユーティリティは、ZIP ファイルの CSMDiagnostics.zip からサーバ診断

情報を収集します。このファイル名を変更しなかった場合は、Security Manager Diagnostics を実行す

るたびに新しい情報でファイルが上書きされます。CSMDiagnostics.zip ファイル内の情報は、サーバ

上の Security Manager または関連アプリケーションで発生した問題のシスコ テクニカルサポート エン

ジニアによる解決を支援します。

ヒント Security Manager には、アプリケーションによって実施された設定変更に関する情報を収集する高度

なデバッギング オプションも用意されています。このオプションをアクティブにするには、[Tools] > 
[Security Manager Administration] > [Debug Options] を選択してから、[Capture 
Discovery/Deployment Debugging Snapshots to File] チェックボックスをオンにします。診断ファイル

に保存されたその他の情報はトラブルシューティングの試みに役立つ可能性がありますが、ファイルに

はパスワードなどの機密情報が書き込まれている場合があることに注意してください。デバッグ レベ

ルは、Cisco Technical Assistance Center（TAC）から変更を指示された場合にだけ変更してください。

Security Manager Diagnostics は次のいずれかの方法で実行できます。

Security Manager クライアント システムから Security Manager サーバから

1. サーバへの Security Manager クライアント セッ

ションを確立したら、[Tools] > [Security Manager 
Diagnostics] をクリックして [OK] をクリックしま

す。

CSMDiagnostics.zip ファイルは、サーバ上の 
NMSROOT\MDC\etc\ ディレクトリに保存されま

す。ここで、NMSROOT は、Common Services を
インストールしたディレクトリです（C:\Program 
Files\CSCOpx など）。

2. [Close] をクリックします。

（注） このユーティリティを実行するたびに上書きさ

れないようにこのファイルの名前を変更するこ

とを推奨します。

1. Windows のコマンド ウィンドウを開きます。それには、たと

えば [Start] > [Run] を選択し、command と入力します。

2. 次のように入力します。C:\Program Files\CSCOpx\MDC\
bin\CSMDiagnostics。または、この ZIP ファイルを 
NMSROOT\MDC\etc\ とは別の場所に保存するには、

CSMDiagnostics drive:\path と入力します。たとえば、

CSMDiagnostics D:\temp と入力します。
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サーバ プロセス ステータスの表示と変更
Security Manager のサーバ プロセスが正しく動作していることを確認するには、次の手順を実行しま

す。

ステップ 1 CiscoWorks のホームページで、[Common Services] > [Server] > [Admin] を選択します。

ステップ 2 [Admin] ページの TOC で、[Processes] をクリックします。

[Process Management] テーブルにすべてのサーバ プロセスが表示されます。[ProcessState] カラム内

のエントリが、プロセスが正常に動作しているかどうかを示します。

ステップ 3 必要なプロセスが動作していない場合は、それを再起動します。「サーバ上の全プロセスの再起動」

（P.A-18）を参照してください。

（注） ローカル管理者特権を持つユーザのみがサーバ プロセスを起動または停止できます。

サーバ上の全プロセスの再起動

（注） すべてのプロセスを停止してから、それらを再起動しなければ、この方法は機能しません。

ステップ 1 コマンド プロンプトで、net stop crmdmgtd と入力してすべてのプロセスを停止します。

ステップ 2 net start crmdmgtd と入力してすべてのプロセスを再起動します。

ヒント または、[Start] > [Settings] > [Control Panel] > [Administrative Tools] > [Services] を選択して

から、Cisco Security Manager Daemon Manager を再起動できます。

サーバ インストール ログ ファイルの確認
サーバからの応答が期待していたものと違っていた場合は、サーバ インストール ログ ファイルでエ

ラー メッセージと警告メッセージを確認できます。

テキスト エディタを使用して C:\Ciscoworks_install_NNN.log を開きます。ここで、NNN は 
YYYYMMDD_HHMMSS 形式のタイムスタンプです。

ほとんどの場合、確認すべきログ ファイルは、ファイル名に最大の番号が付けられたファイルか、作

成日が最新のファイルです。

たとえば、ログ ファイルでは、次のようなエラー エントリと警告エントリが確認できます。

ERROR: Cannot Open C:\PROGRA~1\CSCOpx/lib/classpath/ssl.properties at 
C:\PROGRA~1\CSCOpx\MDC\Apache\ConfigSSL.pl line 259.
INFO: Enabling SSL....
WARNING: Unable to enable SSL. Please try later....
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（注） 重大な問題が発生した場合は、ログ ファイルを Cisco TAC に送信できます。「マニュアルの入手方法

およびテクニカル サポート」（P.xiii）を参照してください。

Symantec の共存問題
Symantec Antivirus Corporate Edition 10.1.5.5000 と Security Manager を同じシステムで使用し、

Security Manager 起動中に問題が発生した場合は、次の手順に従ってください。

手順 
1. Symantec Antivirus を完全にディセーブルにします。

2. Security Manager サービスを再起動します。（「サーバ上の全プロセスの再起動」（P.A-18）を参照）。

3. Symantec Event Manager を最後に起動したような方法で、Symantec サービスのセット（Symantec 
Antivirus、Symantec Antivirus Definition Watcher、Symantec Settings Manager、および Symantec 
Event Manager）を再起動します。

Windows アップデートのインストール後の問題
Microsoft Windows アップデートをインストールした後に、Security Manager Daemon Manager に関

する問題が発生する可能性があります。原因は、Windows アップデートのインストールにより、*.dll 
ファイルが更新される場合があり、これに依存する Common Services などのアプリケーションの機能

に影響する可能性があることです。

この問題は、次の症状で認識できます。Windows アップデートの後、Security Manager によってすべ

てのプロセスを開始しますが、Security Manager に HTTPS を介して到達できません。このため、

Security Manager クライアントから HTTPS を使用します。

この問題が生じるのは、Common Services が Windows 内のファイルおよび関連付けに依存するためで

す。これらのファイルは、脆弱性を修正し、不正利用から Windows を保護するために変更できます。

ただし、意図しない副作用として再起動した場合はこれらの変更により、Security Manager サーバの

異常動作が起きる可能性があります。

この問題は、Windows アップデート、またはその他のアプリケーションが、*.dll ファイル、実行可能

ファイル、起動プロセス、Windows コンポーネント、またはパーティション サイズに影響する 
Windows に変更を加えると、いつでも発生する可能性があります。

Windows で変更が行われ、その再起動で Security Manager が異常動作した場合に、この問題を解決す

るには、Security Manager を再インストールする必要があります。

シスコは Security Manager サーバを定期的にバック アップすることを推奨します。特に、定期的な

バック アップが行われていない場合、または Security Manager インストールに対して多数の変更を行

う場合は、Windows アップデートまたはその他のインストーラ パッケージを実行する前に Security 
Manager サーバをバックアップする必要があります。
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高度な暗号化による ASA デバイスへの接続の問題
このトラブルシューティングの項目は、高度な暗号化を使用して ASA デバイスを追加および検出でき

ない場合に役立ちます。特に AES-256 を使用する場合は、Java Cryptography Extension（JCE）
Unlimited Strength Jurisdiction Policy File をダウンロードしてインストールする必要があります。

Security Manager はこの拡張を含みませんが、これをサポートします。

問題 証明書に含まれるキーが 1024 ビットを超える場合に問題が発生します。Java ランタイム環境

（JRE）に含まれているデフォルト ポリシー ファイルによって設定される暗号化強度の制限は、すべて

の国へのインポートが可能な、最高強度暗号化アルゴリズムとキー長を提供します。

ソリューション 当該国で暗号化のインポートに制限が定められていなければ、無制限強度ポリシー 
ファイルをダウンロードできます。

ステップ 1 http://java.sun.com/javase/downloads/index.jsp に移動します。

ステップ 2 「Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files 6」をダウンロードし

ます。

ステップ 3 ダウンロードしたパッケージの README.txt ファイルの説明に従ってください。

インストール時に使用する Activation.jar のポップアップ表
示 

このトラブルシューティング項目は、インストール中に「Activation.jar being used by some other 
service.」というメッセージがポップアップ ウィンドウで表示される場合に役立ちます。

ヒント この問題はきわめてまれにしか起こりません。

はじめる前に

サーバのすべてのアンチウイルスまたはモニタリング エージェント プロセスは、インストール前に

シャット ダウンする必要があります。詳細については、「インストール準備状況チェックリスト」

（P.4-3）を参照してください。

問題

「Activation.jar being used by some other service.」というメッセージがポップアップ ウィンドウで表示

されます。

ソリューション

次の手順を使用してください。

ステップ 1 ポップアップで [OK] をクリックして、インストールを完了します。

ステップ 2 Security Manager をアンインストールし、サーバを再起動します。

ステップ 3 Security Manager を再インストールします。

ステップ 4 インストールを開始した直後に、「services.msc」をコマンド プロンプトに入力し、Enter キーを押しま

す。
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ステップ 5 [Services] メニューを開くと、「Cisco Security Manager Daemon Manager」が表示されるまで更新が続

きます。

ステップ 6 [CSM Daemon Manager] を右クリックして、[Properties] > [Startup type] > [Disabled] の順にクリック

します。

ステップ 7 [CWCS syslog service] を右クリックして、[Properties] > [Startup type] > [Disabled] の順にクリックし

ます。

ステップ 8 インストールの完了後、サーバの再起動時に、「Disabled」から「Automatic」モードに上記のサービ

スの両方の起動タイプを変更します。
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P P E N D I X B

Cisco Security Manager に関するオープン 
ソース ライセンス通知

通告
本ソフトウェア ライセンスに関連する通知内容を次に示します。

• 「OpenSSL/Open SSL Project」（P.B-3） 

• 「Axis」（P.B-4） 

• 「Castor」（P.B-7） 

• 「cglib」（P.B-10） 

• 「Velocity」（P.B-13） 

• 「Apache Commons」（P.B-16） 

• 「ODMG」（P.B-19） 

• 「log4j」（P.B-20） 

• 「jdt-compiler-3.1.1.jar」（P.B-22） 

• 「jta-1.1.jar」（P.B-26） 

• 「slf4j-api-1.5.2.jar」（P.B-28） 

• 「Quartz 1.8.0」（P.B-29） 

• 「Java(TM) Platform, Standard Edition Runtime Environment Version 6 (Java SE 6 Update 35 or JRE 
1.6u35)」（P.B-32） 

• 「Lucene」（P.B-38） 

• 「Google Protocol Buffers」（P.B-41） 

• 「Innovation HTTPClient」（P.B-42） 

• 「Jakarta-ORO」（P.B-42） 

• 「java-diff」（P.B-45） 

• 「javabi-sizeof」（P.B-46） 

• 「JGoodies Forms」（P.B-46） 
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• 「JiBX」（P.B-47） 

• 「jNetStream」（P.B-48） 

• 「Restlet」（P.B-48） 

• 「Spring」（P.B-48） 
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OpenSSL/Open SSL Project

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit 
(http://www.openssl.org/).

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).

This product includes software written by Tim Hudson (tjh@cryptsoft.com).

License Issues

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the 
original SSLeay license apply to the toolkit.See below for the actual license texts.Actually both licenses 
are BSD-style Open Source licenses.In case of any license issues related to OpenSSL please contact 
openssl-core@openssl.org.

OpenSSL License:
Copyright © 1998-2007 The OpenSSL Project.All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the 
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following 
acknowledgment: "This product includes software developed by the OpenSSL Project for use in the 
OpenSSL Toolkit (http://www.openssl.org/)".

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote 
products derived from this software without prior written permission.For written permission, please 
contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in 
their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit 
(http://www.openssl.org/)".

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.IN NO 
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).This product 
includes software written by Tim Hudson (tjh@cryptsoft.com).
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Original SSLeay License:
Copyright © 1995-1998 Eric Young (eay@cryptsoft.com).All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are 
adhered to.The following conditions apply to all code found in this distribution, be it the RC4, RSA, 
lhash, DES, etc., code; not just the SSL code.The SSL documentation included with this distribution is 
covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed.If 
this package is used in a product, Eric Young should be given attribution as the author of the parts of the 
library used.This can be in the form of a textual message at program startup or in documentation (online 
or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the 
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following 
acknowledgement:

"This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)".

The word ‘cryptographic' can be left out if the routines from the library being used are not 
cryptography-related.

4. If you include any Windows specific code (or a derivative thereof) from the apps directory 
(application code) you must include an acknowledgement: "This product includes software written 
by Tim Hudson (tjh@cryptsoft.com)".

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.IN NO 
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The license and distribution terms for any publicly available version or derivative of this code cannot be 
changed.i.e. this code cannot simply be copied and put under another distribution license [including the 
GNU Public License].

Axis

Apache Axis is an implementation of the SOAP ("Simple Object Access Protocol") submission to W3C.

From the draft W3C specification:
B-4
Cisco Security Manager 4.4 インストレーション ガイド

OL-28767-01-J



 

付録 B      Cisco Security Manager に関するオープン ソース ライセンス通知

    通告
"SOAP is a lightweight protocol for exchanging structured information in a decentralized, distributed 
environment.It is an XML-based protocol that consists of three parts: an envelope that defines a 
framework for describing what is in a message and how to process it, a set of encoding rules for 
expressing instances of application-defined datatypes, and a convention for representing remote 
procedure calls and responses."

[http://ws.apache.org/axis/]

License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity.For the purposes of this definition, "control" means (i) 
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship.For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized 
to submit on behalf of the copyright owner.For the purposes of this definition, "submitted" means any 
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution."
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"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, 
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as 
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise 
transfer the Work, where such license applies only to those patent claims licensable by such Contributor 
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted.If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation is 
filed.

4. Redistribution.You may reproduce and distribute copies of the Work or Derivative Works thereof in 
any medium, with or without modifications, and in Source or Object form, provided that You meet the 
following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the 
following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear.The 
contents of the NOTICE file are for informational purposes only and do not modify the License.You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License.

5. Submission of Contributions.Unless You explicitly state otherwise, any Contribution intentionally 
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of 
this License, without any additional terms or conditions.Notwithstanding the above, nothing herein shall 
supersede or modify the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions.

6. Trademarks.This License does not grant permission to use the trade names, trademarks, service marks, 
or product names of the Licensor, except as required for reasonable and customary use in describing the 
origin of the Work and reproducing the content of the NOTICE file.
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7. Disclaimer of Warranty.Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without 
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 
FITNESS FOR A PARTICULAR PURPOSE.You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise 
of permissions under this License.

8. Limitation of Liability.In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) 
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, 
special, incidental, or consequential damages of any character arising as a result of this License or out of 
the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if 
such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability.While redistributing the Work or Derivative Works 
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License.However, in accepting such 
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any 
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any 
such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information.(Don't include the brackets!)  
The text should be enclosed in the appropriate comment syntax for the file format.We also recommend 
that a file or class name and description of purpose be included on the same "printed page" as the 
copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in 
compliance with the License.You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied.See the License for the specific language governing permissions and limitations under 
the License.

[http://www.apache.org/licenses/LICENSE-2.0]

Castor

Castor is an Open Source data binding framework for Java[tm].It's the shortest path between Java objects, 
XML documents and relational tables.Castor provides Java-to-XML binding, Java-to-SQL persistence, 
and more.

[http://castor.codehaus.org/]
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License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity.For the purposes of this definition, "control" means (i) 
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship.For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized 
to submit on behalf of the copyright owner.For the purposes of this definition, "submitted" means any 
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, 
sublicense, and distribute the Work and such Derivative Works in Source or Object form.
B-8
Cisco Security Manager 4.4 インストレーション ガイド

OL-28767-01-J



 

付録 B      Cisco Security Manager に関するオープン ソース ライセンス通知

    通告
3. Grant of Patent License.Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as 
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise 
transfer the Work, where such license applies only to those patent claims licensable by such Contributor 
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted.If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation is 
filed.

4. Redistribution.You may reproduce and distribute copies of the Work or Derivative Works thereof in 
any medium, with or without modifications, and in Source or Object form, provided that You meet the 
following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the 
following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear.The 
contents of the NOTICE file are for informational purposes only and do not modify the License.You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License.

5. Submission of Contributions.Unless You explicitly state otherwise, any Contribution intentionally 
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of 
this License, without any additional terms or conditions.Notwithstanding the above, nothing herein shall 
supersede or modify the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions.

6. Trademarks.This License does not grant permission to use the trade names, trademarks, service marks, 
or product names of the Licensor, except as required for reasonable and customary use in describing the 
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty.Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without 
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 
FITNESS FOR A PARTICULAR PURPOSE.You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise 
of permissions under this License.
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8. Limitation of Liability.In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) 
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, 
special, incidental, or consequential damages of any character arising as a result of this License or out of 
the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if 
such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability.While redistributing the Work or Derivative Works 
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License.However, in accepting such 
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any 
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any 
such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information.(Don't include the brackets!)  
The text should be enclosed in the appropriate comment syntax for the file format.We also recommend 
that a file or class name and description of purpose be included on the same "printed page" as the 
copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in 
compliance with the License.You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied.See the License for the specific language governing permissions and limitations under 
the License.

[http://www.apache.org/licenses/LICENSE-2.0]

cglib

cglib is a powerful, high performance and quality Code Generation Library, It is used to extend JAVA 
classes and implements interfaces at runtime.

[http://cglib.sourceforge.net/]

License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.
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"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity.For the purposes of this definition, "control" means (i) 
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship.For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized 
to submit on behalf of the copyright owner.For the purposes of this definition, "submitted" means any 
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, 
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as 
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise 
transfer the Work, where such license applies only to those patent claims licensable by such Contributor 
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted.If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
B-11
Cisco Security Manager 4.4 インストレーション ガイド

OL-28767-01-J



 

付録 B      Cisco Security Manager に関するオープン ソース ライセンス通知

    通告
incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation is 
filed.

4. Redistribution.You may reproduce and distribute copies of the Work or Derivative Works thereof in 
any medium, with or without modifications, and in Source or Object form, provided that You meet the 
following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the 
following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear.The 
contents of the NOTICE file are for informational purposes only and do not modify the License.You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License.

5. Submission of Contributions.Unless You explicitly state otherwise, any Contribution intentionally 
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of 
this License, without any additional terms or conditions.Notwithstanding the above, nothing herein shall 
supersede or modify the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions.

6. Trademarks.This License does not grant permission to use the trade names, trademarks, service marks, 
or product names of the Licensor, except as required for reasonable and customary use in describing the 
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty.Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without 
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 
FITNESS FOR A PARTICULAR PURPOSE.You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise 
of permissions under this License.

8. Limitation of Liability.In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) 
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, 
special, incidental, or consequential damages of any character arising as a result of this License or out of 
the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if 
such Contributor has been advised of the possibility of such damages.
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9. Accepting Warranty or Additional Liability.While redistributing the Work or Derivative Works 
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License.However, in accepting such 
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any 
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any 
such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information.(Don't include the brackets!)  
The text should be enclosed in the appropriate comment syntax for the file format.We also recommend 
that a file or class name and description of purpose be included on the same "printed page" as the 
copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in 
compliance with the License.You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied.See the License for the specific language governing permissions and limitations under 
the License.

[http://www.apache.org/licenses/LICENSE-2.0]

Velocity

Velocity is a project of the Apache Software Foundation, charged with the creation and maintenance of 
open-source software related to the Apache Velocity Engine.

[http://velocity.apache.org/]

Velocity is a Java-based template engine.It permits anyone to use a simple yet powerful template 
language to reference objects defined in Java code.

When Velocity is used for web development, web designers can work in parallel with Java programmers 
to develop websites according to the Model-View-Controller (MVC) model, meaning that web page 
designers can focus solely on creating a site that looks good, and programmers can focus solely on 
writing top-notch code.

[http://velocity.apache.org/engine/releases/velocity-1.6.2/]

License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.
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"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity.For the purposes of this definition, "control" means (i) 
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship.For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized 
to submit on behalf of the copyright owner.For the purposes of this definition, "submitted" means any 
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, 
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as 
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise 
transfer the Work, where such license applies only to those patent claims licensable by such Contributor 
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted.If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
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incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation is 
filed.

4. Redistribution.You may reproduce and distribute copies of the Work or Derivative Works thereof in 
any medium, with or without modifications, and in Source or Object form, provided that You meet the 
following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the 
following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear.The 
contents of the NOTICE file are for informational purposes only and do not modify the License.You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License.

5. Submission of Contributions.Unless You explicitly state otherwise, any Contribution intentionally 
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of 
this License, without any additional terms or conditions.Notwithstanding the above, nothing herein shall 
supersede or modify the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions.

6. Trademarks.This License does not grant permission to use the trade names, trademarks, service marks, 
or product names of the Licensor, except as required for reasonable and customary use in describing the 
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty.Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without 
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 
FITNESS FOR A PARTICULAR PURPOSE.You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise 
of permissions under this License.

8. Limitation of Liability.In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) 
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, 
special, incidental, or consequential damages of any character arising as a result of this License or out of 
the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if 
such Contributor has been advised of the possibility of such damages.
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9. Accepting Warranty or Additional Liability.While redistributing the Work or Derivative Works 
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License.However, in accepting such 
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any 
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any 
such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information.(Don't include the brackets!)  
The text should be enclosed in the appropriate comment syntax for the file format.We also recommend 
that a file or class name and description of purpose be included on the same "printed page" as the 
copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in 
compliance with the License.You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied.See the License for the specific language governing permissions and limitations under 
the License.

[http://www.apache.org/licenses/LICENSE-2.0]

Apache Commons

The Commons is an Apache project focused on all aspects of reusable Java components.

[http://commons.apache.org/]

Components

The following components of Apache Commons pertain to this software license:

• Beanutils

• CLI

• Codec

• Collections

• DbUtils

• Digester

• Lang

• Logging

License

Apache License
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Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity.For the purposes of this definition, "control" means (i) 
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship.For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized 
to submit on behalf of the copyright owner.For the purposes of this definition, "submitted" means any 
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, 
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as 
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise 
transfer the Work, where such license applies only to those patent claims licensable by such Contributor 
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that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted.If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation is 
filed.

4. Redistribution.You may reproduce and distribute copies of the Work or Derivative Works thereof in 
any medium, with or without modifications, and in Source or Object form, provided that You meet the 
following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the 
following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear.The 
contents of the NOTICE file are for informational purposes only and do not modify the License.You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License.

5. Submission of Contributions.Unless You explicitly state otherwise, any Contribution intentionally 
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of 
this License, without any additional terms or conditions.Notwithstanding the above, nothing herein shall 
supersede or modify the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions.

6. Trademarks.This License does not grant permission to use the trade names, trademarks, service marks, 
or product names of the Licensor, except as required for reasonable and customary use in describing the 
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty.Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without 
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 
FITNESS FOR A PARTICULAR PURPOSE.You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise 
of permissions under this License.

8. Limitation of Liability.In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) 
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, 
special, incidental, or consequential damages of any character arising as a result of this License or out of 
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the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if 
such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability.While redistributing the Work or Derivative Works 
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License.However, in accepting such 
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any 
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any 
such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information.(Don't include the brackets!)  
The text should be enclosed in the appropriate comment syntax for the file format.We also recommend 
that a file or class name and description of purpose be included on the same "printed page" as the 
copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in 
compliance with the License.You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied.See the License for the specific language governing permissions and limitations under 
the License.

[http://www.apache.org/licenses/LICENSE-2.0]

ODMG

ODMG is a standard API for Object Persistence specified by the ODMG consortium (www.odmg.org).

[http://db.apache.org/ojb/docu/faq.html#relatedTo]

Availability

odmg-3.0.jar is available from http://www.ibiblio.org/maven/odmg/jars.

License

License Agreement

Redistribution of this software is permitted provided that the following conditions are met:

1. Redistributions of source or binary code formats must retain the above copyright notice.

2. Redistribution in any product and all advertising materials mentioning features or use of this software 
must display the following acknowledgment: "This product includes copyrighted software developed by 
E.Wray Johnson for use and distribution by the Object Data Management Group 
(http://www.odmg.org/)."
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[http://www.odbms.org/ODMG/OG/wrayjohnson.aspx]

log4j

log4j is open-source logging software for java related to the logging of application behavior.

[http://logging.apache.org/]

License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity.For the purposes of this definition, "control" means (i) 
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship.For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized 
to submit on behalf of the copyright owner.For the purposes of this definition, "submitted" means any 
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue 
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tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, 
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as 
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise 
transfer the Work, where such license applies only to those patent claims licensable by such Contributor 
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted.If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation is 
filed.

4. Redistribution.You may reproduce and distribute copies of the Work or Derivative Works thereof in 
any medium, with or without modifications, and in Source or Object form, provided that You meet the 
following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the 
following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear.The 
contents of the NOTICE file are for informational purposes only and do not modify the License.You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License.

5. Submission of Contributions.Unless You explicitly state otherwise, any Contribution intentionally 
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of 
this License, without any additional terms or conditions.Notwithstanding the above, nothing herein shall 
supersede or modify the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions.
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6. Trademarks.This License does not grant permission to use the trade names, trademarks, service marks, 
or product names of the Licensor, except as required for reasonable and customary use in describing the 
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty.Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without 
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 
FITNESS FOR A PARTICULAR PURPOSE.You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise 
of permissions under this License.

8. Limitation of Liability.In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) 
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, 
special, incidental, or consequential damages of any character arising as a result of this License or out of 
the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if 
such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability.While redistributing the Work or Derivative Works 
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License.However, in accepting such 
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any 
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any 
such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information.(Don't include the brackets!)  
The text should be enclosed in the appropriate comment syntax for the file format.We also recommend 
that a file or class name and description of purpose be included on the same "printed page" as the 
copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in 
compliance with the License.You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied.See the License for the specific language governing permissions and limitations under 
the License.

jdt-compiler-3.1.1.jar

jdt-compiler-3.1.1.jar is included in JDT Core, which is the Java infrastructure of the Java IDE.

[http://www.eclipse.org/jdt/core/index.php] 

Core is in turn a component of the Eclipse Java development tools (JDT) project.The JDT project 
provides the tool plug-ins that implement a Java IDE supporting the development of any Java application, 
including Eclipse plug-ins.
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[http://www.eclipse.org/jdt/index.php] 

License

Eclipse Public License - v 1.0

THE ACCOMPANYING PROGRAM IS PROVIDED UNDER THE TERMS OF THIS ECLIPSE 
PUBLIC LICENSE ("AGREEMENT").ANY USE, REPRODUCTION OR DISTRIBUTION OF THE 
PROGRAM CONSTITUTES RECIPIENT'S ACCEPTANCE OF THIS AGREEMENT.

1. DEFINITIONS

"Contribution" means:

a) in the case of the initial Contributor, the initial code and documentation distributed under this 
Agreement, and

b) in the case of each subsequent Contributor:

i) changes to the Program, and

ii) additions to the Program; where such changes and/or additions to the Program originate from and are 
distributed by that particular Contributor.A Contribution 'originates' from a Contributor if it was added 
to the Program by such Contributor itself or anyone acting on such Contributor's behalf.Contributions do 
not include additions to the Program which: (i) are separate modules of software distributed in 
conjunction with the Program under their own license agreement, and (ii) are not derivative works of the 
Program.

"Contributor" means any person or entity that distributes the Program.

"Licensed Patents" mean patent claims licensable by a Contributor which are necessarily infringed by the 
use or sale of its Contribution alone or when combined with the Program.

"Program" means the Contributions distributed in accordance with this Agreement.

"Recipient" means anyone who receives the Program under this Agreement, including all Contributors.

2. GRANT OF RIGHTS

a) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-exclusive, 
worldwide, royalty-free copyright license to reproduce, prepare derivative works of, publicly display, 
publicly perform, distribute and sublicense the Contribution of such Contributor, if any, and such 
derivative works, in source code and object code form.

b) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-exclusive, 
worldwide, royalty-free patent license under Licensed Patents to make, use, sell, offer to sell, import and 
otherwise transfer the Contribution of such Contributor, if any, in source code and object code form.This 
patent license shall apply to the combination of the Contribution and the Program if, at the time the 
Contribution is added by the Contributor, such addition of the Contribution causes such combination to 
be covered by the Licensed Patents.The patent license shall not apply to any other combinations which 
include the Contribution.No hardware per se is licensed hereunder.

c) Recipient understands that although each Contributor grants the licenses to its Contributions set forth 
herein, no assurances are provided by any Contributor that the Program does not infringe the patent or 
other intellectual property rights of any other entity.Each Contributor disclaims any liability to Recipient 
for claims brought by any other entity based on infringement of intellectual property rights or 
otherwise.As a condition to exercising the rights and licenses granted hereunder, each Recipient hereby 
assumes sole responsibility to secure any other intellectual property rights needed, if any.For example, if 
a third party patent license is required to allow Recipient to distribute the Program, it is Recipient's 
responsibility to acquire that license before distributing the Program.
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d) Each Contributor represents that to its knowledge it has sufficient copyright rights in its Contribution, 
if any, to grant the copyright license set forth in this Agreement.

3. REQUIREMENTS

A Contributor may choose to distribute the Program in object code form under its own license agreement, 
provided that:

a) it complies with the terms and conditions of this Agreement; and

b) its license agreement:

i) effectively disclaims on behalf of all Contributors all warranties and conditions, express and implied, 
including warranties or conditions of title and non-infringement, and implied warranties or conditions of 
merchantability and fitness for a particular purpose;

ii) effectively excludes on behalf of all Contributors all liability for damages, including direct, indirect, 
special, incidental and consequential damages, such as lost profits;

iii) states that any provisions which differ from this Agreement are offered by that Contributor alone and 
not by any other party; and

iv) states that source code for the Program is available from such Contributor, and informs licensees how 
to obtain it in a reasonable manner on or through a medium customarily used for software exchange.

When the Program is made available in source code form:

a) it must be made available under this Agreement; and

b) a copy of this Agreement must be included with each copy of the Program.Contributors may not 
remove or alter any copyright notices contained within the Program.

Each Contributor must identify itself as the originator of its Contribution, if any, in a manner that 
reasonably allows subsequent Recipients to identify the originator of the Contribution.

4. COMMERCIAL DISTRIBUTION

Commercial distributors of software may accept certain responsibilities with respect to end users, 
business partners and the like.While this license is intended to facilitate the commercial use of the 
Program, the Contributor who includes the Program in a commercial product offering should do so in a 
manner which does not create potential liability for other Contributors.Therefore, if a Contributor 
includes the Program in a commercial product offering, such Contributor ("Commercial Contributor") 
hereby agrees to defend and indemnify every other Contributor ("Indemnified Contributor") against any 
losses, damages and costs (collectively "Losses") arising from claims, lawsuits and other legal actions 
brought by a third party against the Indemnified Contributor to the extent caused by the acts or omissions 
of such Commercial Contributor in connection with its distribution of the Program in a commercial 
product offering.The obligations in this section do not apply to any claims or Losses relating to any actual 
or alleged intellectual property infringement.In order to qualify, an Indemnified Contributor must: a) 
promptly notify the Commercial Contributor in writing of such claim, and b) allow the Commercial 
Contributor to control, and cooperate with the Commercial Contributor in, the defense and any related 
settlement negotiations.The Indemnified Contributor may participate in any such claim at its own 
expense.

For example, a Contributor might include the Program in a commercial product offering, Product X.That 
Contributor is then a Commercial Contributor.If that Commercial Contributor then makes performance 
claims, or offers warranties related to Product X, those performance claims and warranties are such 
Commercial Contributor's responsibility alone.Under this section, the Commercial Contributor would 
have to defend claims against the other Contributors related to those performance claims and warranties, 
and if a court requires any other Contributor to pay any damages as a result, the Commercial Contributor 
must pay those damages.

5. NO WARRANTY
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EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, THE PROGRAM IS PROVIDED ON 
AN "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, EITHER 
EXPRESS OR IMPLIED INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OR 
CONDITIONS OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.Each Recipient is solely responsible for determining the appropriateness of 
using and distributing the Program and assumes all risks associated with its exercise of rights under this 
Agreement , including but not limited to the risks and costs of program errors, compliance with 
applicable laws, damage to or loss of data, programs or equipment, and unavailability or interruption of 
operations.

6. DISCLAIMER OF LIABILITY

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NEITHER RECIPIENT NOR ANY 
CONTRIBUTORS SHALL HAVE ANY LIABILITY FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT 
LIMITATION LOST PROFITS), HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OR DISTRIBUTION OF THE PROGRAM 
OR THE EXERCISE OF ANY RIGHTS GRANTED HEREUNDER, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.

7. GENERAL

If any provision of this Agreement is invalid or unenforceable under applicable law, it shall not affect the 
validity or enforceability of the remainder of the terms of this Agreement, and without further action by 
the parties hereto, such provision shall be reformed to the minimum extent necessary to make such 
provision valid and enforceable.

If Recipient institutes patent litigation against any entity (including a cross-claim or counterclaim in a 
lawsuit) alleging that the Program itself (excluding combinations of the Program with other software or 
hardware) infringes such Recipient's patent(s), then such Recipient's rights granted under Section 2(b) 
shall terminate as of the date such litigation is filed.All Recipient's rights under this Agreement shall 
terminate if it fails to comply with any of the material terms or conditions of this Agreement and does 
not cure such failure in a reasonable period of time after becoming aware of such noncompliance.If all 
Recipient's rights under this Agreement terminate, Recipient agrees to cease use and distribution of the 
Program as soon as reasonably practicable.However, Recipient's obligations under this Agreement and 
any licenses granted by Recipient relating to the Program shall continue and survive.

Everyone is permitted to copy and distribute copies of this Agreement, but in order to avoid inconsistency 
the Agreement is copyrighted and may only be modified in the following manner.The Agreement Steward 
reserves the right to publish new versions (including revisions) of this Agreement from time to time.No 
one other than the Agreement Steward has the right to modify this Agreement.The Eclipse Foundation is 
the initial Agreement Steward.The Eclipse Foundation may assign the responsibility to serve as the 
Agreement Steward to a suitable separate entity.Each new version of the Agreement will be given a 
distinguishing version number.The Program (including Contributions) may always be distributed subject 
to the version of the Agreement under which it was received.In addition, after a new version of the 
Agreement is published, Contributor may elect to distribute the Program (including its Contributions) 
under the new version.Except as expressly stated in Sections 2(a) and 2(b) above, Recipient receives no 
rights or licenses to the intellectual property of any Contributor under this Agreement, whether expressly, 
by implication, estoppel or otherwise.All rights in the Program not expressly granted under this 
Agreement are reserved.

This Agreement is governed by the laws of the State of New York and the intellectual property laws of 
the United States of America.No party to this Agreement will bring a legal action under this Agreement 
more than one year after the cause of action arose.Each party waives its rights to a jury trial in any 
resulting litigation.

[http://www.eclipse.org/org/documents/epl-v10.php]
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jta-1.1.jar

jta-1.1.jar is included in Java Transaction API (JTA), which specifies standard Java interfaces between a 
transaction manager and the parties involved in a distributed transaction system: the resource manager, 
the application server, and the transactional applications.

[http://java.sun.com/javaee/technologies/jta/index.jsp]

License

SUN MICROSYSTEMS, INC. ("SUN") IS WILLING TO LICENSE THIS SPECIFICATION TO YOU 
ONLY UPON THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS 
AGREEMENT.PLEASE READ THE TERMS AND CONDITIONS OF THIS AGREEMENT 
CAREFULLY.BY DOWNLOADING THIS SPECIFICATION, YOU ACCEPT THE TERMS AND 
CONDITIONS OF THE AGREEMENT.IF YOU ARE NOT WILLING TO BE BOUND BY IT, SELECT 
THE "DECLINE" BUTTON AT THE BOTTOM OF THIS PAGE.

Specification:  JSR-000907 Java(tm) Transaction API 

(JTA) Specification ("Specification")

Version:  1.1

Status:  Maintenance Release

Release:  14 February 2007

Copyright 2007   SUN MICROSYSTEMS, INC.

4150 Network Circle, Santa Clara, California 95054, 

U.S.A

All rights reserved.

LIMITED LICENSE GRANTS

1. License for Evaluation Purposes.Sun hereby grants you a fully-paid, non-exclusive, non-transferable, 
worldwide, limited license (without the right to sublicense), under Sun's  applicable intellectual property 
rights to view, download, use and reproduce the Specification only for the purpose of internal 
evaluation.This includes (i) developing applications intended to run on an implementation of the 
Specification, provided that such applications do not themselves implement any portion(s) of the 
Specification, and (ii) discussing the Specification with any third party; and (iii) excerpting brief portions 
of the Specification in oral or written communications which discuss the Specification provided that such 
excerpts do not in the aggregate constitute a significant portion of the Specification.

2. License for the Distribution of Compliant Implementations.Sun  also grants you a perpetual, 
non-exclusive, non-transferable, worldwide, fully paid-up, royalty free, limited license (without the right 
to sublicense) under any applicable copyrights or, subject to the provisions of subsection 4 below, patent 
rights it may have covering the Specification to create and/or distribute an Independent Implementation 
of the Specification that: (a) fully implements the Specification including all its required interfaces and 
functionality; (b) does not modify, subset, superset or otherwise extend the Licensor Name Space, or 
include any public or protected packages, classes, Java interfaces, fields or methods within the Licensor 
Name Space other than those required/authorized by the Specification or Specifications being 
implemented; and (c) passes the Technology Compatibility Kit (including satisfying the requirements of 
the applicable TCK Users Guide) for such Specification ("Compliant Implementation").In addition, the 
foregoing license is expressly conditioned on your not acting outside its scope.No license is granted 
hereunder for any other purpose (including, for example, modifying the Specification, other than to the 
extent of your fair use rights, or distributing the Specification to third parties).Also, no right, title, or 
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interest in or to any trademarks, service marks, or trade names of Sun or Sun's licensors is granted 
hereunder.Java, and Java-related logos, marks and names are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S.and other countries.

3. Pass-through Conditions.You need not include imitations (a)-(c) from the previous paragraph or any 
other particular "pass through" requirements in any license You grant concerning the use of your 
Independent Implementation or products derived from it.However, except with respect to Independent 
Implementations (and products derived from them) that satisfy limitations (a)-(c) from the previous 
paragraph, You may neither:  (a) grant or otherwise pass through to your licensees any licenses under 
Sun's  applicable intellectual property rights; nor (b) authorize your licensees to make any claims 
concerning their implementation's compliance with the Specification in question.

4. Reciprocity Concerning Patent Licenses.

a.With respect to any patent claims covered by the license granted under subparagraph 2 above that would 
be infringed by all technically feasible implementations of the Specification, such license is conditioned 
upon your offering on fair, reasonable and non-discriminatory terms, to any party seeking it from You, a 
perpetual, non-exclusive, non-transferable, worldwide license under Your patent rights which are or 
would be infringed by all technically feasible implementations of the Specification to develop, distribute 
and use a Compliant Implementation.

b  With respect to any patent claims owned by Sun and covered by the license granted under subparagraph 
2, whether or not their infringement can be avoided in a technically feasible manner when implementing 
the Specification, such license shall terminate with respect to such claims if You initiate a claim against 
Sun that it has, in the course of performing its responsibilities as the Specification Lead, induced any 
other entity to infringe Your patent rights.

c  Also with respect to any patent claims owned by Sun and covered by the license granted under 
subparagraph 2 above, where the infringement of such claims can be avoided in a technically feasible 
manner when implementing the Specification such license, with respect to such claims, shall terminate 
if You initiate a claim against Sun  that its making, having made, using, offering to sell, selling or 
importing a Compliant Implementation infringes Your patent rights.5.Definitions.For the purposes of this 
Agreement: "Independent Implementation" shall mean an implementation of the Specification that 
neither derives from any of Sun's  source code or binary code materials nor, except with an appropriate 
and separate license from Sun, includes any of Sun's  source code or binary code materials; "Licensor 
Name Space" shall mean the public class or interface declarations whose names begin with "java", 
"javax", "com.sun"  or their equivalents in any subsequent naming convention adopted by Sun  through 
the Java Community Process, or any recognized successors or replacements thereof; and "Technology 
Compatibility Kit" or "TCK" shall mean the test suite and accompanying TCK User's Guide provided by 
Sun  which corresponds to the Specification and that was available either (i) from Sun's 120 days before 
the first release of Your Independent Implementation that allows its use for commercial purposes, or (ii) 
more recently than 120 days from such release but against which You elect to test Your implementation 
of the Specification.

This Agreement will terminate immediately without notice from Sun if you breach the Agreement or act 
outside the scope of the licenses granted above.

DISCLAIMER OF WARRANTIES 

THE SPECIFICATION IS PROVIDED "AS IS".SUN MAKES NO REPRESENTATIONS OR 
WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
NON-INFRINGEMENT (INCLUDING AS A CONSEQUENCE OF ANY PRACTICE OR 
IMPLEMENTATION OF THE SPECIFICATION), OR THAT THE CONTENTS OF THE 
SPECIFICATION ARE SUITABLE FOR ANY PURPOSE.This document does not represent any 
commitment to release or implement any portion of the Specification in any product.In addition, the 
Specification could include technical inaccuracies or typographical errors.
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LIMITATION OF LIABILITY 

TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT WILL SUN OR ITS LICENSORS BE 
LIABLE FOR ANY DAMAGES, INCLUDING WITHOUT LIMITATION, LOST REVENUE, 
PROFITS OR DATA, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL OR 
PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF 
LIABILITY, ARISING OUT OF OR RELATED IN ANY WAY TO YOUR HAVING, 
IMPELEMENTING OR OTHERWISE USING USING  THE SPECIFICATION, EVEN IF SUN 
AND/OR ITS LICENSORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.You will indemnify, hold harmless, and defend Sun and its licensors from any claims arising 
or resulting from: (i) your use of the Specification; (ii) the use or distribution of your Java application, 
applet and/or implementation; and/or (iii) any claims that later versions or releases of any Specification 
furnished to you are incompatible with the Specification provided to you under this license.

RESTRICTED RIGHTS LEGEND 

U.S.Government: If this Specification is being acquired by or on behalf of the U.S.Government or by a 
U.S.Government prime contractor or subcontractor (at any tier), then the Government's rights in the 
Software and accompanying documentation shall be only as set forth in this license; this is in accordance 
with 48 C.F.R.227.7201 through 227.7202-4 (for Department of Defense (DoD) acquisitions) and with 
48 C.F.R.2.101 and 12.212 (for non-DoD acquisitions).

REPORT

If you provide Sun with any comments or suggestions concerning the Specification ("Feedback"), you 
hereby: (i) agree that such Feedback is provided on a non-proprietary and non-confidential basis, and (ii) 
grant Sun a perpetual, non-exclusive, worldwide, fully paid-up, irrevocable license, with the right to 
sublicense through multiple levels of sublicensees, to incorporate, disclose, and use without limitation 
the Feedback for any purpose.

GENERAL TERMS

Any action related to this Agreement will be governed by California law and controlling U.S.federal 
law.The U.N.Convention for the International Sale of Goods and the choice of law rules of any 
jurisdiction will not apply.

The Specification is subject to U.S.export control laws and may be subject to export or import regulations 
in other countries.Licensee agrees to comply strictly with all such laws and regulations and 
acknowledges that it has the responsibility to obtain such licenses to export, re-export or import as may 
be required after delivery to Licensee.This Agreement is the parties' entire agreement relating to its 
subject matter.It supersedes all prior or contemporaneous oral or written communications, proposals, 
conditions, representations and warranties and prevails over any conflicting or additional terms of any 
quote, order,  acknowledgment, or other communication between the parties relating to its subject matter 
during the term of this Agreement.No modification to this Agreement will be binding, unless in writing 
and signed by an authorized representative of each party.

Rev.April, 2006

[https://cds.sun.com/is-bin/INTERSHOP.enfinity/WFS/CDS-CDS_Developer-Site/en_US/-/USD/View
License-Start]

slf4j-api-1.5.2.jar

slf4j-api-1.5.2.jar is included in the Simple Logging Facade for Java (SLF4J), which serves as a simple 
facade or abstraction for various logging frameworks, e.g., java.util.logging, log4j, and logback.

[http://www.slf4j.org/]
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License

Licensing terms for SLF4J

SLF4J source code and binaries are distributed under the MIT license.

Copyright (c) 2004-2008 QOS.ch

All rights reserved.

Permission is hereby granted, free  of charge, to any person obtaining a  copy  of this  software  and  
associated  documentation files  (the "Software"), to  deal in  the Software without  restriction, 
including without limitation  the rights to  use, copy, modify,  merge, publish, distribute,  sublicense, 
and/or sell  copies of  the Software,  and to permit persons to whom the Software  is furnished to do 
so, subject to the following conditions:

The  above  copyright  notice  and  this permission  notice  shall  be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS  IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS 
OR IMPLIED, INCLUDING  BUT NOT LIMITED  TO THE  WARRANTIES OF 
MERCHANTABILITY,    FITNESS    FOR    A   PARTICULAR    PURPOSE    AND 
NONINFRINGEMENT.IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION 
OF CONTRACT, TORT OR OTHERWISE,  ARISING FROM, OUT OF OR IN CONNECTION 
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

These terms are identical to those of the MIT License, also called the X License or the X11 License, 
which is a simple, permissive non-copyleft free software license.It is deemed compatible with virtually 
all types of licenses, commercial or otherwise.In particular, the Free Software Foundation has declared 
it compatible with GNU GPL.It is also known to be approved by the Apache Software Foundation as 
compatible with Apache Software License.

[http://www.slf4j.org/license.html]

Quartz 1.8.0

Quartz is a full-featured, open source job scheduling service that can be integrated with, or used along 
side virtually any Java EE or Java SE application—from the smallest stand-alone application to the 
largest e-commerce system.Quartz can be used to create simple or complex schedules for executing tens, 
hundreds, or even tens-of-thousands of jobs; jobs whose tasks are defined as standard Java components 
that may executed virtually anything you may program them to do.The Quartz Scheduler includes many 
enterprise-class features, such as JTA transactions and clustering.

[http://www.quartz-scheduler.org/]

License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
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1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity.For the purposes of this definition, "control" means (i) 
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship.For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized 
to submit on behalf of the copyright owner.For the purposes of this definition, "submitted" means any 
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, 
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as 
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise 
transfer the Work, where such license applies only to those patent claims licensable by such Contributor 
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted.If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
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incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation is 
filed.

4. Redistribution.You may reproduce and distribute copies of the Work or Derivative Works thereof in 
any medium, with or without modifications, and in Source or Object form, provided that You meet the 
following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the 
following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear.The 
contents of the NOTICE file are for informational purposes only and do not modify the License.You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License.

5. Submission of Contributions.Unless You explicitly state otherwise, any Contribution intentionally 
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of 
this License, without any additional terms or conditions.Notwithstanding the above, nothing herein shall 
supersede or modify the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions.

6. Trademarks.This License does not grant permission to use the trade names, trademarks, service marks, 
or product names of the Licensor, except as required for reasonable and customary use in describing the 
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty.Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without 
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 
FITNESS FOR A PARTICULAR PURPOSE.You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise 
of permissions under this License.

8. Limitation of Liability.In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) 
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, 
special, incidental, or consequential damages of any character arising as a result of this License or out of 
the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if 
such Contributor has been advised of the possibility of such damages.
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9. Accepting Warranty or Additional Liability.While redistributing the Work or Derivative Works 
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License.However, in accepting such 
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any 
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any 
such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information.(Don't include the brackets!)  
The text should be enclosed in the appropriate comment syntax for the file format.We also recommend 
that a file or class name and description of purpose be included on the same "printed page" as the 
copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in 
compliance with the License.You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied.See the License for the specific language governing permissions and limitations under 
the License.

[http://www.apache.org/licenses/LICENSE-2.0]

Java(TM) Platform, Standard Edition Runtime Environment Version 
6 (Java SE 6 Update 35 or JRE 1.6u35) 

Oracle Corporation Binary Code License Agreement

for the JAVA SE RUNTIME ENVIRONMENT (JRE) VERSION 6 and JAVAFX RUNTIME

ORACLE  CORPORATION  ("ORACLE")  IS WILLING TO  LICENSE  THE  SOFTWARE

IDENTIFIED BELOW TO YOU ONLY UPON THE CONDITION THAT YOU ACCEPT ALL OF

THE  TERMS  CONTAINED  IN  THIS  BINARY  CODE  LICENSE  AGREEMENT  AND

SUPPLEMENTAL  LICENSE TERMS  (COLLECTIVELY  "AGREEMENT").PLEASE READ

THE AGREEMENT  CAREFULLY.BY USING THE SOFTWARE YOU ACKNOWLEDGE  THAT

YOU HAVE READ THE TERMS  AND  AGREE TO THEM.IF YOU ARE  AGREEING  TO

THESE  TERMS ON  BEHALF  OF A  COMPANY  OR  OTHER  LEGAL  ENTITY,  YOU

REPRESENT  THAT YOU HAVE THE LEGAL  AUTHORITY TO BIND THE LEGAL ENTITY

TO THESE TERMS.IF YOU DO NOT HAVE SUCH  AUTHORITY,  OR IF YOU DO NOT

WISH TO BE BOUND BY THE TERMS, THEN YOU MUST NOT USE THE  SOFTWARE  ON

THIS SITE OR ANY OTHER MEDIA ON WHICH THE SOFTWARE IS CONTAINED.
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1.  DEFINITIONS."Software"  means  the  identified  above in  binary

form, any other machine readable materials (including, but not limited

to,  libraries,  source  files,  header  files, and data  files),  any

updates or error corrections provided by Oracle, and any user manuals,

programming guides and other  documentation  provided to you by Oracle

under this Agreement."General Purpose Desktop Computers and Servers"

means computers,  including  desktop and laptop computers, or servers,

used for general  computing  functions under end user control (such as

but not  specifically  limited  to  email,  general  purpose  Internet

browsing, and office suite  productivity  tools).The use of Software

in systems and solutions that provide dedicated  functionality  (other

than  as  mentioned   above)  or  designed  for  use  in  embedded  or

function-specific  software  applications, for example but not limited

to:  Software embedded in or bundled with industrial  control systems,

wireless  mobile  telephones,  wireless  handheld  devices,  netbooks,

kiosks, TV/STB, Blu-ray Disc devices,  telematics and network  control

switching  equipment,  printers  and storage  management  systems, and

other  related  systems  are  excluded  from this  definition  and not

licensed under this  Agreement."Programs"  means (a) Java technology

applets and applications intended to run on the Java Platform Standard

Edition (Java SE) platform on  Java-enabled  General  Purpose  Desktop

Computers and Servers, and (b) JavaFX technology applications intended

to run on the JavaFX Runtime on JavaFX-enabled General Purpose Desktop

Computers and Servers.

2.  LICENSE  TO USE.Subject  to the  terms  and  conditions  of this

Agreement,   including,  but  not  limited  to  the  Java   Technology

Restrictions  of the  Supplemental  License Terms, Oracle grants you a

non-exclusive,  non-transferable, limited license without license fees

to reproduce and use internally  Software  complete and unmodified for

the  sole  purpose  of  running  Programs.Additional   licenses  for

developers  and/or publishers are granted in the Supplemental  License

Terms.

3.  RESTRICTIONS.Software is confidential and copyrighted.Title to

Software and all associated  intellectual  property rights is retained

by Oracle and/or its licensors.Unless  enforcement  is prohibited by
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applicable  law, you may not modify,  decompile,  or reverse  engineer

Software.You acknowledge  that Licensed  Software is not designed or

intended for use in the design, construction, operation or maintenance

of any nuclear facility.Oracle Corporation  disclaims any express or

implied  warranty  of  fitness  for such  uses.No  right,  title  or

interest in or to any  trademark,  service mark, logo or trade name of

Oracle or its  licensors is granted under this  Agreement.Additional

restrictions for developers and/or  publishers  licenses are set forth

in the Supplemental License Terms.

4.  LIMITED  WARRANTY.Oracle  warrants  to you that for a period  of

ninety (90) days from the date of  purchase, as evidenced by a copy of

the receipt, the media on which Software is furnished (if any) will be

free of defects in materials and workmanship under normal use.Except

for the  foregoing,  Software  is  provided  "AS IS".Your  exclusive

remedy and Oracle's entire  liability under this limited warranty will

be at Oracle's option to replace Software media or refund the fee paid

for Software.Any implied  warranties  on the Software are limited to

90 days.Some  states do not  allow  limitations  on  duration  of an

implied  warranty,  so the  above may not apply to you.This  limited

warranty gives you specific  legal rights.You may have others, which

vary from state to state.

5.  DISCLAIMER OF WARRANTY.UNLESS  SPECIFIED IN THIS  AGREEMENT, ALL

EXPRESS  OR  IMPLIED  CONDITIONS,   REPRESENTATIONS   AND  WARRANTIES,

INCLUDING  ANY  IMPLIED  WARRANTY OF  MERCHANTABILITY,  FITNESS  FOR A

PARTICULAR PURPOSE OR  NON-INFRINGEMENT  ARE DISCLAIMED, EXCEPT TO THE

EXTENT THAT THESE DISCLAIMERS ARE HELD TO BE LEGALLY INVALID.

6.  LIMITATION OF LIABILITY.TO THE EXTENT NOT  PROHIBITED BY LAW, IN

NO EVENT WILL ORACLE OR ITS LICENSORS BE LIABLE FOR ANY LOST  REVENUE,

PROFIT OR DATA, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL OR

PUNITIVE   DAMAGES,  HOWEVER  CAUSED   REGARDLESS  OF  THE  THEORY  OF

LIABILITY, ARISING OUT OF OR RELATED TO THE USE OF OR INABILITY TO USE

SOFTWARE,  EVEN IF ORACLE HAS BEEN ADVISED OF THE  POSSIBILITY OF SUCH

DAMAGES.In no event  will  Oracle's  liability  to you,  whether  in

contract, tort (including negligence), or otherwise, exceed the amount

paid  by  you  for  Software  under  this   Agreement.The  foregoing
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limitations  will apply even if the above stated warranty fails of its

essential   purpose.Some  states  do  not  allow  the  exclusion  of

incidental  or  consequential  damages, so some of the terms above may

not be applicable to you.

7.  TERMINATION.This Agreement is effective  until  terminated.You

may terminate  this  Agreement at any time by destroying all copies of

Software.This  Agreement will terminate  immediately  without notice

from  Oracle  if you  fail  to  comply  with  any  provision  of  this

Agreement.Either  party may  terminate  this  Agreement  immediately

should any Software  become, or in either party's opinion be likely to

become,  the subject of a claim of  infringement  of any  intellectual

property  right.Upon  Termination,  you must  destroy  all copies of

Software.

8.  EXPORT  REGULATIONS.All Software and  technical  data  delivered

under this  Agreement are subject to US export control laws and may be

subject to export or import regulations in other countries.You agree

to comply strictly with all such laws and regulations and  acknowledge

that you have the  responsibility  to obtain such  licenses to export,

re-export, or import as may be required after delivery to you.

9.  TRADEMARKS  AND LOGOS.You  acknowledge  and agree as between you

and Oracle that Oracle owns the  ORACLE,  SUN,  SOLARIS,  JAVA,  JINI,

FORTE, and iPLANET  trademarks  and all ORACLE,  SOLARIS,  JAVA, JINI,

FORTE, and iPLANET-related  trademarks, service marks, logos and other

brand designations  ("Oracle Marks"), and you agree to comply with the

Third    Party    Usage     Guidelines     currently     located    at

http://www.oracle.com/html/3party.html  Any use you make of the Oracle

Marks inures to Oracle's benefit.

10.  U.S.GOVERNMENT   RESTRICTED   RIGHTS.If   Software  is  being

acquired  by or  on  behalf  of  the  U.S.Government  or  by a  U.S.

Government prime contractor or  subcontractor  (at any tier), then the

Government's rights in Software and accompanying documentation will be

only as set forth in this Agreement; this is in accordance with 48 CFR

227.7201   through   227.7202-4  (for   Department  of  Defense  (DOD)

acquisitions)   and  with  48  CFR  2.101  and  12.212  (for   non-DOD
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acquisitions).

11.  GOVERNING  LAW.Any action  related  to this  Agreement  will be

governed by  California  law and  controlling  U.S.federal  law.No

choice of law rules of any jurisdiction will apply.

12.  SEVERABILITY.If any  provision of this  Agreement is held to be

unenforceable, this Agreement will remain in effect with the provision

omitted, unless omission would frustrate the intent of the parties, in

which case this Agreement will immediately terminate.

13.  INTEGRATION.This Agreement is the entire agreement  between you

and Oracle relating to its subject matter.It supersedes all prior or

contemporaneous   oral   or   written    communications,    proposals,

representations  and warranties and prevails over any  conflicting  or

additional  terms  of  any  quote,  order,  acknowledgment,  or  other

communication  between  the parties  relating  to its  subject  matter

during the term of this  Agreement.No modification of this Agreement

will be  binding,  unless  in  writing  and  signed  by an  authorized

representative of each party.

SUPPLEMENTAL LICENSE TERMS

These  Supplemental  License  Terms add to or modify  the terms of the

Binary Code License Agreement.Capitalized terms not defined in these

Supplemental  Terms shall have the same  meanings  ascribed to them in

the Binary Code License  Agreement .These  Supplemental  Terms shall

supersede any  inconsistent  or  conflicting  terms in the Binary Code

License Agreement, or in any license contained within the Software.

A.Software  Internal Use and Development  License Grant.Subject to

the terms  and  conditions  of this  Agreement  and  restrictions  and

exceptions set forth in the Software "README" file incorporated herein

by  reference,  including,  but not  limited  to the  Java  Technology

Restrictions  of  these  Supplemental   Terms,  Oracle  grants  you  a

non-exclusive,  non-transferable,  limited  license  without  fees  to

reproduce  internally  and use  internally  the Software  complete and

unmodified for the purpose of designing,  developing, and testing your
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Programs.

B.License  to   Distribute   Software.Subject  to  the  terms  and

conditions of this Agreement and restrictions and exceptions set forth

in the Software  README file,  including,  but not limited to the Java

Technology Restrictions of these Supplemental Terms, Oracle grants you

a  non-exclusive,  non-transferable,  limited license  without fees to

reproduce and distribute the Software (except for the JavaFX Runtime),

provided that (i) you distribute the Software  complete and unmodified

and only bundled as part of, and for the sole purpose of running, your

Programs, (ii) the Programs add significant and primary  functionality

to the  Software,  (iii)  you do not  distribute  additional  software

intended to replace any  component(s) of the Software, (iv) you do not

remove or alter any  proprietary  legends or notices  contained in the

Software, (v) you only  distribute  the Software  subject to a license

agreement that protects Oracle's  interests  consistent with the terms

contained  in this  Agreement,  and  (vi)  you  agree  to  defend  and

indemnify  Oracle and its  licensors  from and  against  any  damages,

costs,  liabilities,  settlement  amounts and/or  expenses  (including

attorneys'  fees)  incurred in connection  with any claim,  lawsuit or

action by any third  party  that  arises  or  results  from the use or

distribution of any and all Programs and/or Software.

C.Java  Technology  Restrictions.You may not  create,  modify,  or

change the behavior of, or authorize your licensees to create, modify,

or change the behavior of, classes,  interfaces, or  subpackages  that

are in any  way  identified  as  "java",  "javax",  "sun"  or  similar

convention   as   specified   by  Oracle  in  any  naming   convention

designation.

D.Source  Code.Software  may  contain  source  code  that,  unless

expressly   licensed  for  other  purposes,  is  provided  solely  for

reference  purposes  pursuant to the terms of this  Agreement.Source

code may not be redistributed  unless  expressly  provided for in this

Agreement.

E.Third Party Code.Additional  copyright notices and license terms

applicable   to  portions  of  the  Software  are  set  forth  in  the
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THIRDPARTYLICENSEREADME.txt   file.In  addition  to  any  terms  and

conditions of any third party  opensource/freeware  license identified

in the  THIRDPARTYLICENSEREADME.txt  file, the  disclaimer of warranty

and  limitation of liability  provisions in  paragraphs 5 and 6 of the

Binary Code  License  Agreement  shall apply to all  Software  in this

distribution.

F.Termination  for  Infringement.Either party may  terminate  this

Agreement immediately should any Software become, or in either party's

opinion be likely to become, the subject of a claim of infringement of

any intellectual property right.

G.Installation  and  Auto-Update.The Software's  installation  and

auto-update  processes transmit a limited amount of data to Oracle (or

its service  provider)  about those specific  processes to help Oracle

understand and optimize them.Oracle does not associate the data with

personally  identifiable  information.You can find more  information

about the data Oracle collects at http://java.com/data/.

For inquiries please contact:  Oracle Corporation, 500 Oracle Parkway,

Redwood Shores, California 94065, USA.

Lucene

Apache Lucene (TM) is a high-performance, full-featured text search engine library written entirely in 
Java.It is a technology suitable for nearly any application that requires full-text search, especially 
cross-platform.

[http://lucene.apache.org/java/docs/index.html]

License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License.
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"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity.For the purposes of this definition, "control" means (i) 
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship.For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized 
to submit on behalf of the copyright owner.For the purposes of this definition, "submitted" means any 
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, 
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as 
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise 
transfer the Work, where such license applies only to those patent claims licensable by such Contributor 
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted.If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation is 
filed.

4. Redistribution.You may reproduce and distribute copies of the Work or Derivative Works thereof in 
any medium, with or without modifications, and in Source or Object form, provided that You meet the 
following conditions:
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(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the 
following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear.The 
contents of the NOTICE file are for informational purposes only and do not modify the License.You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License.

5. Submission of Contributions.Unless You explicitly state otherwise, any Contribution intentionally 
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of 
this License, without any additional terms or conditions.Notwithstanding the above, nothing herein shall 
supersede or modify the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions.

6. Trademarks.This License does not grant permission to use the trade names, trademarks, service marks, 
or product names of the Licensor, except as required for reasonable and customary use in describing the 
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty.Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without 
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 
FITNESS FOR A PARTICULAR PURPOSE.You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise 
of permissions under this License.

8. Limitation of Liability.In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) 
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, 
special, incidental, or consequential damages of any character arising as a result of this License or out of 
the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if 
such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability.While redistributing the Work or Derivative Works 
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License.However, in accepting such 
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any 
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any 
such warranty or additional liability.

END OF TERMS AND CONDITIONS
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APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information.(Don't include the brackets!)  
The text should be enclosed in the appropriate comment syntax for the file format.We also recommend 
that a file or class name and description of purpose be included on the same "printed page" as the 
copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in 
compliance with the License.You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied.See the License for the specific language governing permissions and limitations under 
the License.

[http://www.apache.org/licenses/LICENSE-2.0]

Google Protocol Buffers

Protocol Buffers is a Google, Inc. data interchange format.Protocol Buffers are a way of encoding 
structured data in an efficient yet extensible format.Google uses Protocol Buffers for almost all of its 
internal RPC protocols and file formats.

[http://code.google.com/p/protobuf/]

License

Copyright 2008, Google Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

• Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED.IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Code generated by the Protocol Buffer compiler is owned by the owner of the input file used when 
generating it.This code is not standalone and requires a support library to be linked with it.This support 
library is itself covered by the above license.

[http://code.google.com/p/protobuf/downloads/detail?name=protobuf-2.4.1.zip&can=2&q=]

Innovation HTTPClient

This package provides a complete http client library.It currently implements most of the relevant parts of 
the HTTP/1.0 and HTTP/1.1 protocols, including the request methods HEAD, GET, POST and PUT, and 
automatic handling of authorization, redirection requests, and cookies.Furthermore the included Codecs 
class contains coders and decoders for the base64, quoted-printable, URL-encoding, chunked and the 
multipart/form-data encodings.

[http://www.innovation.ch/java/HTTPClient/]

License

HTTPClient is licensed under the GNU Lesser General Public License (LGPL) (note that this is not the 
same as the GPL).

The GNU Lesser General Public License (LGPL), Version 2.1, February 1999, is available at the 
following URL: http://www.innovation.ch/java/HTTPClient/LICENSE.

Jakarta-ORO

Jakarta-OROA is a set of text-processing Java classes that provide Perl5 compatible regular expressions, 
AWK-like regular expressions, glob expressions, and utility classes for performing substitutions, splits, 
filtering filenames, etc.

[http://projects.apache.org/projects/oro.html]

License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity.For the purposes of this definition, "control" means (i) 
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity.
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"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship.For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized 
to submit on behalf of the copyright owner.For the purposes of this definition, "submitted" means any 
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, 
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as 
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise 
transfer the Work, where such license applies only to those patent claims licensable by such Contributor 
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted.If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation is 
filed.

4. Redistribution.You may reproduce and distribute copies of the Work or Derivative Works thereof in 
any medium, with or without modifications, and in Source or Object form, provided that You meet the 
following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and
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(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the 
following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear.The 
contents of the NOTICE file are for informational purposes only and do not modify the License.You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License.

5. Submission of Contributions.Unless You explicitly state otherwise, any Contribution intentionally 
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of 
this License, without any additional terms or conditions.Notwithstanding the above, nothing herein shall 
supersede or modify the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions.

6. Trademarks.This License does not grant permission to use the trade names, trademarks, service marks, 
or product names of the Licensor, except as required for reasonable and customary use in describing the 
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty.Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without 
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 
FITNESS FOR A PARTICULAR PURPOSE.You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise 
of permissions under this License.

8. Limitation of Liability.In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) 
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, 
special, incidental, or consequential damages of any character arising as a result of this License or out of 
the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if 
such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability.While redistributing the Work or Derivative Works 
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License.However, in accepting such 
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any 
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any 
such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.
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To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information.(Don't include the brackets!)  
The text should be enclosed in the appropriate comment syntax for the file format.We also recommend 
that a file or class name and description of purpose be included on the same "printed page" as the 
copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in 
compliance with the License.You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied.See the License for the specific language governing permissions and limitations under 
the License.

[http://www.apache.org/licenses/LICENSE-2.0]

java-diff

java-diff is an implementation of the longest common subsequences algorithm for Java, as two classes, 
its main method (Diff:diff()) returning a list of Difference objects, each of which describes an addition, 
deletion, or change between the two collections.

[http://www.incava.org/]

License

Copyright (c) 2009, incava.org 

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

• Neither the name of incava.org nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED.IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

[http://www.incava.org/releases/1041874499]
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javabi-sizeof 

javabi-sizeof is a small high performance utility for measuring object memory usage in Java.

[http://code.google.com/p/javabi-sizeof/]

License

For javabi-sizeof, the code license is the New BSD License, which is available at the following URL: 
http://www.opensource.org/licenses/bsd-license.php 

[http://code.google.com/p/javabi-sizeof/] 

JFreeChart

JFreeChart is a free 100% Java chart library that makes it easy for developers to display professional 
quality charts in their applications.

[http://www.jfree.org/jfreechart/] 

License

JFreeChart is distributed under the terms of the GNU Lesser General Public License (LGPL).The GNU 
Lesser General Public License, Version 3, 29 June 2007, is available at the following URL: 
http://www.gnu.org/licenses/lgpl.html.

[http://www.jfree.org/jfreechart/]

JGoodies Forms

The JGoodies Forms framework helps you lay out and implement elegant Swing panels quickly and 
consistently.

[http://www.jgoodies.com/freeware/forms/index.html]

License

The BSD License for the JGoodies Forms 

============================== 

Copyright (c) 2002-2012 JGoodies Karsten Lentzsch.All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

• Neither the name of JGoodies Karsten Lentzsch nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED.IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

[http://www.jgoodies.com/downloads/libraries.html]

JiBX

JiBX is a tool for binding XML data to Java objects.

[http://jibx.sourceforge.net/] 

License

[This license (BSD form) covers the actual JiBX code itself.] 

Copyright (c) 2003-2010, Dennis M.Sosnoski.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

• Neither the name of JiBX nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED.IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

[http://jibx.sourceforge.net/jibx-license.html] 
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jNetStream 

jNetStream is a java development library, commonly referred to as SDK (Standard Development Kit), for 
building applications that need access to network packets.

[http://www.jnetstream.com/node/10] 

License

Copyright (C) 2008 Sly Technologies, Inc.

This program is free software; you can redistribute it and/or modify it under the terms of the GNU 
General Public License as published by the Free Software Foundation; either version 2 of the License, or 
(at your option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without 
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.See 
the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not, 
write to the Free Software Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA  02111-1307, USA.

[http://sourceforge.net/projects/jnetstream/files/] 

Restlet

Restlet Framework is the leading REST framework in Java.Restlet Framework is developed in the 
context of the open source Restlet project.

[http://www.restlet.com/products/restlet-framework] 

License

Restlet is an Open Source project that is distributed under several licenses at the same time.Complete 
license informationis available at the following URL: http://www.restlet.org/about/legal.

Spring

Spring is an application development framework for enterprise Java.

[http://www.springsource.org/] 

License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.
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"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity.For the purposes of this definition, "control" means (i) 
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship.For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized 
to submit on behalf of the copyright owner.For the purposes of this definition, "submitted" means any 
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, 
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as 
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise 
transfer the Work, where such license applies only to those patent claims licensable by such Contributor 
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted.If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
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incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation is 
filed.

4. Redistribution.You may reproduce and distribute copies of the Work or Derivative Works thereof in 
any medium, with or without modifications, and in Source or Object form, provided that You meet the 
following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the 
following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear.The 
contents of the NOTICE file are for informational purposes only and do not modify the License.You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License.

5. Submission of Contributions.Unless You explicitly state otherwise, any Contribution intentionally 
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of 
this License, without any additional terms or conditions.Notwithstanding the above, nothing herein shall 
supersede or modify the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions.

6. Trademarks.This License does not grant permission to use the trade names, trademarks, service marks, 
or product names of the Licensor, except as required for reasonable and customary use in describing the 
origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty.Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without 
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 
FITNESS FOR A PARTICULAR PURPOSE.You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise 
of permissions under this License.

8. Limitation of Liability.In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) 
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, 
special, incidental, or consequential damages of any character arising as a result of this License or out of 
the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if 
such Contributor has been advised of the possibility of such damages.
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9. Accepting Warranty or Additional Liability.While redistributing the Work or Derivative Works 
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License.However, in accepting such 
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any 
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any 
such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information.(Don't include the brackets!)  
The text should be enclosed in the appropriate comment syntax for the file format.We also recommend 
that a file or class name and description of purpose be included on the same "printed page" as the 
copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in 
compliance with the License.You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied.See the License for the specific language governing permissions and limitations under 
the License.

[http://www.apache.org/licenses/LICENSE-2.0]
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P P E N D I X C

Image Manager の権限マトリクス

次の一連の表には、Image Manager の RBAC（ロールベース アクセス コントロール）権限マトリクス

が示されています。

• 表 C-1、「その他のアクション」 

• 表 C-2、「イメージ ビュー」 

• 表 C-3、「バンドル ビュー」 

• 表 C-4、「デバイス ビュー」 

• 表 C-5、「ジョブ ビュー」 

これらの表に示されている、Image Manager とビュー、アクション、および権限の詳細については、

次の URL にある『User Guide for Cisco Security Manager 4.4』を参照してください。

http://www.cisco.com/en/US/products/ps6498/products_user_guide_list.html
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表 C-1 その他のアクション

その他のアクション

IM の起動 管理設定の表示 管理設定の変更

設定アーカイブの

表示

設定アーカイブの

変更

Image Manager の
表示

YES NO NO NO NO

管理設定の表示 NO YES NO NO NO

デバイスの表示 NO NO NO NO NO

設定アーカイブの

表示

NO NO NO YES NO

デバイスの変更 NO NO NO NO NO

Image Manager リ
ポジトリの変更

NO NO NO NO NO

管理設定の変更 NO NO YES NO NO

展開 NO NO NO NO NO

送信（WF） NO NO NO NO NO

承認（WF） NO NO NO NO NO
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表 C-2 イメージ ビュー

イメージ ビュー

リポジト

リに移動

イメージのダウンロー

ド

ファイル 
システム CCO

インス

トール 
ウィザー

ドの起動

リリース 
ノートの

チェック

アップ

デートの

チェック

リポジト

リからの

削除

バンドル

への追加

ダウン

ロード進

行状況の

表示

Image 
Manager 
の表示

YES NO NO NO YES NO NO NO YES

管理設定

の表示

NO NO NO NO NO NO NO NO NO

デバイス

の表示

NO NO NO NO NO NO NO NO NO

設定アー

カイブの

表示

NO NO NO NO NO NO NO NO NO

デバイス

の変更

NO NO NO YES NO NO NO NO NO

Image 
Manager 
リポジト

リの変更

YES YES YES NO NO YES YES YES YES

管理設定

の変更

NO NO NO NO NO NO NO NO NO

展開 NO NO NO NO NO NO NO NO NO

送信

（WF）
NO NO NO NO NO NO NO NO NO

承認

（WF）
NO NO NO NO NO NO NO NO NO
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表 C-3 バンドル ビュー

バンドル 
View

バンドル名の表示

バンドル コンテンツの

チェック

バンドル コンテンツの

変更

バンドルのインストー

ル

Image Manager の表示 YES YES NO NO

管理設定の表示 NO NO NO NO

デバイスの表示 NO NO NO NO

設定アーカイブの表示 NO NO NO NO

デバイスの変更 NO NO NO NO

Image Manager リポジ

トリの変更

YES YES YES YES

管理設定の変更 NO NO NO NO

展開 NO NO NO NO

送信（WF） NO NO NO NO

承認（WF） NO NO NO NO
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表 C-4 デバイス ビュー

デバイス ビュー

デバイス

とデバイ

ス グルー

プの表示

デバイス 
インベン

トリの表

示

[Device 
Detail] タ
ブの表示：

全部で 4 
つ

フラッ

シュから

のイメー

ジの削除

フラッ

シュから

のイメー

ジのダウ

ンロード

イメージ 
インス

トール 
ウィザー

ドの起動

イメージ 
アップグ

レードの

実行

バンドル

への追加

ダウン

ロードの

表示

Image 
Manager 
の表示

YES YES YES NO NO NO NO NO YES

管理設定

の表示

NO NO NO NO NO NO NO NO NO

デバイス

の表示

NO NO NO NO NO NO NO NO NO

設定アー

カイブの

表示

NO NO NO NO NO NO NO NO NO

デバイス

の変更

NO NO NO YES YES YES YES NO NO

Image 
Manager 
リポジト

リの変更

NO NO NO NO NO NO NO YES NO

管理設定

の変更

NO NO NO NO NO NO NO NO NO

展開 NO NO NO NO NO NO NO NO NO

送信

（WF）
NO NO NO NO NO NO NO NO NO

承認

（WF）
NO NO NO NO NO NO NO NO NO
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表 C-5 ジョブ ビュー

ジョブ ビュー

ジョブ アクション（NWF モード） 追加のジョブ オプション（WF モード）

ジョブ 
テーブ

ルと

ジョブ

の詳細

の表示

（全部で 
3 タブ） 更新 編集 再試行 Discard

ロール

バック 中断 承認 拒否 送信 展開

Image 
Manager 
の表示

YES YES NO NO NO NO NO NO NO NO NO

管理設

定の表

示

NO NO NO NO NO NO NO NO NO NO NO

デバイ

スの表

示

NO NO NO NO NO NO NO NO NO NO NO

設定

アーカ

イブの

表示

NO NO NO NO NO NO NO NO NO NO NO

デバイ

スの変

更

NO NO NO NO NO NO NO NO NO NO NO

Image 
Manager 
リポジ

トリの

変更

NO NO NO NO NO NO NO NO NO NO NO

管理設

定の変

更

NO NO NO NO NO NO NO NO NO NO NO

展開 NO NO YES YES YES YES YES NO NO NO YES

送信

（WF）
NO YES NO NO NO NO NO NO NO YES NO

承認

（WF）
NO YES NO NO NO NO NO YES YES NO NO
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